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Method: Use of the Polilight PL500 Alternate Light Source 
 
Date: 3/31/00 Revision Date:01/01/2007 Approved by:  SAM 
 
 
MATERIALS: 
 
1. Polilight PL500 Alternate Light Source 
  
2. Orange and yellow goggles or filters 
 
PROCEDURES: 
 
Note: The Polilight PL500 is a high intensity light source, which if used inappropriately has the potential 
to be a hazard to the eyes and skin.  Users should use the Polilight PL500 with the awareness that both their 
own eyes and skin, and those in close proximity should be protected at all times.  Even with protective 
goggles exposure time needs to be considered. 

 
1) Make sure the light guide with black focusing lens is connected to the Polilight unit. 

 
2) Place the Polilight PL500 on a solid surface and turn the power switch on back panel to the up (ON) 

position.  Ensure the air flow around the unit is not obstructed. 
 

3) Conduct a quality control check of the Polilight PL500 using known biological fluid stains prior to 
examining evidence: 
a) The known biological stains should be checked with all wavelengths desired in the examination (the 

450 and 490 nm wavelengths are recommended for most evidence items) and the results of the 
quality control check will be recorded in the case notes. 

 
4) Filter tuning is achieved by using the wavelength specific numerical buttons located on the front control 

panel or on the hand held remote control box. (See the figures below) 
 
5) Once a filter has been selected it can be fine-tuned.  Fine tuning will decrease the wavelength and is 

used to optimize illumination conditions for specific materials.  The fine tuning has a range from t0 - 
t40. 

                          ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 3 of 185 

 
 

Figure 1                                    
 

 
 
   

Figure 2 
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6) Once a filter has been selected the intensity can be tuned by changing the power setting.  The power 
setting has a range from P1 (lowest power) - P8 (highest power). 

 
7) Systematically pass the light over the entire item to be examined. A fluorescent area may indicate the 

presence of a body fluid stain.  Note the area for further testing. 
 
8) Once the examination is complete, turn the power switch on back panel to the down (OFF) position. 
 
9) Secure the Polilight PL500 by either placing it on a stable surface or removing the power cable, remote 

control, and liquid light guide from the main unit and placing them in the carrying case. 
 
REFERENCES: 
1. Auvdel MJ. Comparison of Laser and High-Intensity Quartz Arc Tubes in the Detection of Body 

Secretions.  J Forensic Sci. 1988 Jul;33(4):929-45. 
2. Rofin Australia Pty. Ltd. POLILIGHT PL500 (Version 2) Multi-Waveband Tunable Light Source 

Instruction Manual 
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Method: Use of the Crime-lite 80S Alternate Light Source 
 
Date: 1/12/05 Revision Date:01/01/2007 Approved by: SAM     
 

 
MATERIALS: 
 
1. Crime-liteTM 80S Blue (450nm) or Crime-liteTM 80S Blue/Green (485nm) 
2. Battery Adaptor with Makita® Rechargeable battery 
3. Mains Adaptor 
4. Orange goggles or filters 
 
PROCEDURES: 
 
Note: The Crime-liteTM 80S is a portable high intensity light source, which if used inappropriately has the 
potential to be a hazard to the eyes and skin.  Users should use the Crime-liteTM 80S with the awareness that 
both their own eyes and skin, and those in close proximity should be protected at all times.  Even with 
protective goggles exposure time needs to be considered. 
 
1. Connect the output plug holding the Makita® Rechargeable battery with battery adaptor to the Crime-

liteTM 80S for portable use. 

 
If the battery has a low charge or unavailable, attach the Mains Adaptor to the Crime-liteTM 80S and the 
nearest outlet. 
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1. Turn on the power switch on the Crime-liteTM 80S. 

 
 
 
2. Conduct a quality control check of the Crime-LiteTM  on known biological stains prior to examining 

evidence and record the results in the case notes: 
  
4. Systematically pass the light over the entire item to be examined.  A fluorescent area may indicate the 

presence of a body fluid stain.  Note the area for further testing. 
 

5. Once the examination is complete, turn off the power switch located on the handle.  Caution: the light 
output head will become warm during use. 

 

6. Secure the Crime-liteTM 80S by either placing it on a stable surface or in its carrying case (for long term 
storage) and removing the Mains Adaptor or Battery Adaptor. 

 
Charging the Makita® rechargeable battery: 
 
The Makita® Rechargeable battery is a nickel-metal hydride 24V, DC that supplies a Crime-liteTM 80S 
sufficient power for up to 50 minutes at a fully charged capacity. 
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down before charging it. 
 
REFERENCES: 
1. Auvdel MJ. Comparison of Laser and High-Intensity Quartz Arc Tubes in the Detection of Body 

Secretions.  J Forensic Sci. 1988 Jul;33(4):929-45. 
2. Foster and Freeman- Crime-liteTM Information sheet QCL/80S-B-BG-G.  Issue 01 (September 2004) 
3. Foster and Freeman- Crime-liteTM Information sheet QCL/83.  Issue 01 (September 2004) 
4. Foster and Freeman- Crime-liteTM Information sheet QCL/80.  Issue 01 (September 2004) 
5. Makita®- High Capacity Battery Charger Model DC24SA Instruction Manual. 
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Method:  Screening Evidence for the Presence of Semen 

Date: 4/2/98   Revision Date:01/01/2007 Approved by: SAM 
 

 
Note: This procedure has been specifically written for Analysts involved in screening evidence for the 
presence of semen but not involved in DNA testing. 
 
1. Remove a very small portion of the putative semen stain and perform a test for the presence of acid 

phosphatase activity. 
 
2. Remove approximately 1/4 of a swab or a suitable portion of the substrate and place in 1.5mL tube.  

Add 1mL of nanopure water and incubate for 30 minutes at room temperature.  Vortex several times 
during that 30 minutes.  A reagent blank tube should be created at this point which will undergo all of 
the following manipulations and will be used as a control to monitor potential contamination, if the 
extracts prepared will be used for DNA testing. 

 
3. Using a pipette tip (or wooden stick) remove as much liquid from the substrate as possible, transfer it 

to a second microcentrifuge tube, and retain.   
 
4. Microcentrifuge the sample extract at maximum speed for 3-5 minutes. 
 
5. The supernatant may be used for serological tests for blood, semen, saliva, and/or feces.  [Consult the 

specific procedure for details].  Remove an appropriate amount of the supernatant for any desired 
assays. 

 
6. Carefully pipette off all but 50-100uL of the supernatant being careful not to disturb the pellet.  The 

supernatant can be discarded.  At least 50uL of supernatant should be left behind to ensure the cell 
pellet is not disturbed. 

 
7. Resuspend the cell pellet in the remaining supernatant.  Pipette 5-10uL of the sample on to the well of 

a slide (different amounts may be used).  Place the slide in the incubator or on a heat block to dry. 
 
8. Stain the slide with Xmas Tree Stain (refer to the Identification of Cellular Material using Xmas Tree 

Staining procedure).  
 
9. If only screening is being performed and sperm are present in a sample, no further work on that sample 

may be necessary and that sample can be referred for DNA testing.   If no sperm are observed in a 
sample then proceed with the following steps. 

 
10. Add back the substrate to what remains of the water extract and add 750uL of digest buffer and 25uL of 

proteinase K to the tube.  Incubate the sample for at least one hour at 56oC. 
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11. Retain as much liquid from the substrate as possible and discard the substrate. 
 
12. Microcentrifuge the sample at maximum speed for 3-5 minutes. 
 
13. Carefully pipette off all but 50-100uL of the supernatant being careful not to disturb the pellet.  The 

supernatant can be discarded.  At least 50uL of supernatant should be left behind to ensure the cell 
pellet is not disturbed. 

 
14. Add 1mL of water to the cell pellet and resuspend by lightly vortexing. 
 
15. Microcentrifuge the sample at maximum speed for 3-5 minutes. 
 
16. Carefully pipette off all but 50-100uL of the supernatant being careful not to disturb the pellet.   The 

supernatant can be discarded.  At least 50uL of the supernatant should be left behind to ensure the cell 
pellet is not disturbed. 

 
17. Resuspend the cell pellet in the remaining supernatant.  Pipette the remainder (or portion) of the 

sample on to the well of the slide.  Place the slide in the incubator or on a heat block to dry. 
 
18. Stain the slide with Xmas Tree Stain (refer to the Identification of Cellular Material using Xmas Tree 

Staining procedure).  
  
19. If sufficient sperm are present in a sample, no further work on that sample may be necessary and that 

sample can be referred for DNA testing.  If no sperm were present for a sample even after the second 
round of microscopy, it may be necessary to prepare an extract of a second sample from the evidence. 

 
20. If warranted, a small portion can be extracted for p30 analysis. Refer to the Detection of Seminal 

Protein p30 Using the Abacus p30 Diagnostic Card procedure. 
 

REMARKS: 
 
The systematic approach to the analysis of semen provides the analyst with the opportunity to assay for body 
fluids, to perform microscopy on cells, and to perform DNA testing from a single extract of a potentially 
limited sized evidence sample.  It represents a superior approach for creating individual extracts for each 
class of testing.  
 
The systematic approach to the analysis of semen is carried out by creating a single water extract from a 
substrate that may contain semen and other body fluids.  Following centrifugation of the water extract, the 
supernatant can be used to test for the presence of blood, semen, saliva, urine and feces.  The cellular 
portion of the extract, after it has been resuspended in the remaining supernatant, can be analyzed 
microscopically for the presence of sperm and other cells.  Depending on the results of these initial tests, 
the remaining sample can be used for DNA testing. 
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The reagent blank will be subjected to all reagents used in the extraction process and all manipulations 
carried out on the evidence samples.  The reagent blank is necessary to ensure that any contaminant 
introduced during the extraction process is detected.  The use of a reagent blank is mandatory if the samples 
are to be tested using the extremely sensitive polymerase chain reaction (PCR) DNA tests.  If the extracted 
materials are to be used for DNA analysis, the distilled water and microcentrifuge tubes used in the 
"Systematic Approach to the Analysis of Semen" must have been autoclaved.     
 
REFERENCE: 
Blake, Sensabaugh, Bashinski, "A Systematic Approach to the Analysis of Semen 
Evidence."  CAC Meeting, November, 1980 
  

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 12 of 185 

 
 

Method:   Two-Step Acid Phosphatase Screening Test for Semen 
    
Date: 09/13/2001   Revision Date: 02/06/2009  Approved by: SAM  
____________________________________________________________________________ 
  
REAGENTS: 
 
1. SODIUM ALPHA-NAPHTHYL PHOSPHATE SOLUTION (saturated) 
 

Sodium alpha-naphthyl phosphate (a calcium form can also be used) is prepared as a saturated solution 
in acetate buffer.  Prepare fresh or freeze into one use aliquots. 

 
2. Ortho-DIANISIDINE  WORKING SOLUTION 
 

Ortho-Dianisidine (fast blue salt BN) is added to acetate buffer until a yellow brown solution is 
produced.  Prepare fresh or freeze into one-use aliquots. 

 
3. ACETATE BUFFER, pH 5  
 

Add 5mL of glacial acetic acid to 10g of sodium acetate (anhydrous) in a suitable container.  Bring 
volume to 500ml with dH2O.  Adjust pH to 5. Good for nine months (refrigerated).  

 
MATERIALS: 
 
1. Spray apparatus 
2. Disposable pipettes 
 
PROCEDURES: 
 
A quality control check of the reagents against a known semen sample and a negative of reagents only before 
use.  The results of the quality control test must be recorded in the case notes. 
 
CUTTING METHOD 
 
1. Place a small portion of the sample in a small test tube or on filter paper. 
2. Add 1-5 drops of alpha-naphthyl phosphate.   
3. Add 1-5 drops of ortho-dianisidine and observe for any color change. Positive tests show a red-purple 

precipitate. 
 
SWAB METHOD 
 
Wet a cotton swab with dH2O then rub the sample and proceed as above with step 2 on the swab. 
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MAPPING 
 
1. Wet a piece of filter paper with dH2O.  Press against the suspected semen stain sample for a few 

seconds. 
2. Drip or spray alpha-naphthyl phosphate onto the paper. 
3. Drip or spray ortho-dianisidine onto the paper.  Positive tests show a red-purple color on the paper. 
 
INTERPRETATION: 
 
Acid phosphatase is an enzyme found in high concentrations in semen, but is also found in other body fluids 
and is produced by other organisms such as bacteria, yeast, fungi, and plants.  High levels of acid 
phosphatase can be found in concentrated vaginal discharge or secretions. 
 
Appropriate results from the negative and positive control must be obtained with the reagents prior to their 
use on unknowns. 
 
No color change should be observed after adding alpha-naphthyl phosphate.  If a color occurs prior to 
adding ortho-dianisidine, then the results are inconclusive. 
  
The color change observed after adding ortho-dianisidine should occur within 45 seconds to be considered a 
positive reaction.  A strong positive reaction will produce an intense color change within a few seconds.  A 
color change within 10 seconds that lacks intensity will be considered a positive reaction.  Any color change 
that occurs after 10 seconds is considered a weak positive reaction, regardless of color intensity.  Any weak 
reactions should be noted in the case notes.  Color change reactions observed after 45 seconds are 
considered negative. 
 
When mapping an item, it is important to remember that as seminal fluid is deposited onto a fabric, the 
concentration of spermatozoa will usually be highest in the middle of the stain with the greatest 
concentration of acid phosphatase usually along the outer edges. 
 
REFERENCES: 
1. Blake, Sensabaugh, Bashinski. A Systematic Approach to the analysis of Semen Evidence. CAC Meeting, 

6 November 1980 
2. Gaensslen, R.E. Sourcebook in Forensic Serology, Immunology, and Biochemistry, 1983 
3. Saferstein, Baechtel, "The Identification and Individualization of Semen Stains”, Forensic Science 

Handbook, Vol. 2,1988 
4. Metropolitan Lab. Biology Methods Manual, 1978 
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Method: One-Step SERI AP Spot Test  Detection of  Acid Phosphatase  
 
Date: 01/11/2001   Revision Date: 02/06/2008  Approved by: SAM 
 
 
REAGENTS: 
 
1.   .26g SERI AP Spot Test (SERI Catalog #R558) 
2.   10mL Distilled/Deionized water 
 
Different volumes of the reagent may be prepared.  The ratio of reagent to water should not be changed 
 
MATERIALS/EQUIPTMENT: 
 
1.   Whatman Filter Paper and/or cotton swabs 
2.   Disposable pipettes 
 
PROCEDURE: 
 
A quality control check of the reagent against a known semen sample and a negative of reagents only before 
use.  The results of the quality control test must be recorded in the case notes. 
 
1. Dissolve the AP Spot Test reagent in water and test the reagent against known positive and negative 

semen standards before use. 
 
2. Moisten a piece of Whatman filter paper or a cotton swab and vigorously press or rub it against your 

questioned sample.  Alternatively, a small cutting from the questioned sample may be taken and placed 
on a piece of filter paper. 

 
3. Drip the AP reagent onto the filter paper, swab, or cutting on filter paper. 
 
INTERPRETATION: 
 
Acid phosphatase is an enzyme found in high concentrations in semen, but is also found in other body fluids 
and is produced by other organisms such as bacteria and yeast.  High levels of acid phosphatase can be found 
in concentrated vaginal discharge or secretions. 
 
Appropriate results from the negative and positive control must be obtained with the reagents prior to their 
use on unknowns. 
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The color change observed after adding ortho-dianisidine should occur within 45 seconds to be considered a 
positive reaction.  A strong positive reaction will produce an intense color change within a few seconds.  A 
color change within 10 seconds that lacks intensity will be considered a positive reaction.  Any color change 
that occurs after 10 seconds is considered a weak positive reaction, regardless of color intensity.  Any weak 
reactions should be noted in the case notes.  Color change reactions observed after 45 seconds are 
considered negative. 
 
REMARKS: 
 
Acid phosphatase is an enzyme found in high concentrations in semen, but is also found in other body fluids 
and is produced by other organisms such as bacteria, yeast, fungi, and plants.  High levels of acid 
phosphatase can be found in concentrated vaginal discharge or secretions. 
 
In the presence of acid phosphatase the SERI AP Spot Test reagent contains all the components necessary to 
carry out the following reaction: liberation of napthol from sodium alpha-naphthyl phosphate by the 
enzyme and the formation of a purple azo dye by the coupling of napthol with buffered fast blue B.  
 
The reconstituted reagent will remain stable and sensitive for one day’s use at room temperature. 
 
REFERENCE: 
 
Serological Research Institute. Laboratory Protocol, September 29, 1989 
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Method:  Identification of Cellular Material Using Xmas Tree Staining 
 
Date: 01/20/2000   Revision Date: 01/01/2007  Approved by: SAM 
____________________________________________________________________________ 
 
REAGENTS: 
 
1. NUCLEAR FAST RED STAIN 
 

Dissolve 5.0g of aluminum sulfate in 100mL of hot distilled water and add 0.1g of Nuclear Fast Red 
(C.I. 60760).  Stir, cool, and then filter. This solution is stable for many months stored at 8o C. 

 
Stain can be ordered pre-made from Seri, catalog #R540. 

 
2. PICROINDIGOCARMINE STAIN 
 

To 100mL of saturated picric acid solution add 0.33g of Indigo Carmine (C.I. 73015) and stir 
overnight.  Filter and store at 8oC.  This solution is stable for many months under these conditions. 

 
Stain can be ordered pre-made from Seri, catalog #R540. 

   
PROCEDURE: 
 
1. Extract the sample according to the procedure for Differential DNA Extraction or Screening for the 

Presence of Semen and fix the sample(s) to the slide. 
 
2. Cover sample well(s) on the slide(s) with a drop of Nuclear Fast Red stain (Seri Stain A) and leave for 

approximately 10 minutes. 
 
3. Wash away Nuclear Fast Red stain with distilled water dispensed from a wash bottle.   
 
4. Add one drop of Picroindigocarmine stain (Seri Stain B) to the sample well(s) without drying the slide.  

Rotate the dye on the slide by hand for 15-30 seconds.  Wash the stain from the slide with EtOH 
dispensed from a wash bottle.  Dry the slide and mount a coverslip with Permount. 

 
5. Examine microscopically.  The slide can be examined by phase contrast before or after staining with 

Xmas Tree stain. 
 
REMARKS: 
 
Nuclear material is stained red by the Nuclear Fast Red dye.  Sperm heads are usually well differentiated 
with the acrosome staining less densely than the distal region of the head.  Epithelial membranes and sperm 
tails are stained green by the Picroindigocarmine.  Nuclei inside epithelial cells appear red to purple.  Yeast 
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cells also stain red, however, the stain is uniform throughout the cells and extends into polyp-like structures 
which are occasionally observed with yeast cells.  Under phase contrast, the sperm heads will appear bright 
white with a dark acrosome. 
 
REFERENCES: 
 
Gaensslen, R., Sourcebook in Forensic Serology, Immunology and Biochemistry. US 
Government Printing Office, 1983. 
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Method:   p30 Detection Using the Abacus p30 Diagnostic Card 
 
Date: 3/31/00  Revision Date: 04/01/2008 Approved by: SAM 
 
 
REAGENT: 
 
Sterile Nanopure Water. 
 
MATERIALS/ EQUIPMENT: 
 
1. Abacus p30 Diagnostic Test Card Kit.  The kit includes the test cards and plastic droppers.  Abacus 

Diagnostics catalog #308322 (25 tests/kit).  
2. Microcentrifuge (capable of 10,000-15,000 x g). 
 
PROCEDURE: 
 
1. Place a cutting of the stain or swab into a sterile 1.5mL tube.  Add 75uL or enough sterile nanopure 

water to just saturate the material leaving a small amount of excess water.  Extracts of positive control 
samples (neat semen and a 1:20 dilution of semen), a concentrated male urine sample, and a negative 
control (reagents only) should also be run with the unknowns. 

 
Note:  The positive control samples can be pre-made stains of neat semen and a 1:20 semen dilution.  
Alternatively, the 1:20 dilution may be made from the extract of the neat semen stain. 
 
2. Incubate the samples for 45 minutes at room temperature.  Vortex or agitate the samples three or four 

times during the incubation. 
 
3. Remove the substrate or swab and place it into a spin basket.  Centrifuge the spin basket for 5 minutes 

at maximum speed. 
 
4. Remove the spin basket containing the substrate and retain if necessary.  The tube will contain a 

supernatant with water-soluble proteins such as the p30 protein and the cell pellet.  The supernatant 
will be used for the Abacus p30 Diagnostic Test and the cell pellet can be microscopically examined for 
the presence of cellular material. 

 
5. Remove 20ul of the supernatant and add it to another sterile 1.5mL tube containing 200ul of water. 
 
6. Load the entire contents of tube created in step 5 onto the sample loading “S” area of the test card.  
 
7. Immediately start timing the reaction.  The test card result should be read at ten minutes.  Record the 

results as positive or negative on the Abacus p30 Test Worksheet.  The test results can be documented 
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by using a document scanner or digital camera.  Once a hard copy of the test cards is obtained there is 
no need to keep a permanent data file of the image. 

 
Note: Under no circumstances should results obtained after 10 minutes be recorded.  
 
8. If a positive result for the p30 protein is obtained for a given sample it may be appropriate to also test a 

substrate control for that sample.  For positive results from a questioned stain it could prove useful to 
test additional serial dilutions of the sample to provide information on how concentrated the stain is. 

 
INTERPRETATION: 
 
A positive test result for the presence of the protein p30 is indicated by the presence of pink bands at both 
the control line “C" and the test line “T“ on the test card.  The presence of a pink band at the control line 
but the absence of a pink band at the test line indicates a negative result. A pink band will always appear at 
the control “C” area.  The band in the “C” area is an internal control of the test strip.  If a pink band does 
not appear at the control “C” line of the test card the test is invalid.   
 
For a test series to be interpreted the positive and negative controls must yield the expected results. 
 
Legend: “S” = Sample loading area “T” = Test line “C” = Control  line     
 
 
 
 
 
 
 
 
 
 
 
 
   
 POSITIVE NEGATIVE INVALID 
 
REMARKS: 
 
The principle behind the Abacus p30 Diagnostic Test Card is that p30 protein present in a sample will react 
with a mobile monoclonal antihuman p30 antibody creating a mobile antigen-antibody complex.  This 
mobile antigen-antibody complex migrates through the absorbent test device towards the test area.  In the 
test area “T”, a polyclonal antihuman p30 antibody is immobilized.  This immobilized antibody captures the 
above complex creating an antibody-antigen-antibody sandwich.  The conjugated pink dye particles 
concentrate in a narrow zone on the membrane.  When the p30 concentration in the samples exceeds 
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4ng/mL the pink dye particles will form a pink colored band in the test area “T” indicating a positive result.  
An internal positive control in area (C) consists of an immobilized anti-immunoglobulin antibody that binds 
all p30 antibody-dye conjugates that are unable to bind to the antibody in the test area (T).  The captured 
dye particles will form a pink band at test area “C” indicating that the test has worked properly. 
  
Validation work on the Abacus p30 Test Card performed at the San Diego Police Department indicates that 
concentrated male urine can yield a positive test result with the test card.  However, the small amount of 
p30 protein present in male urine was not detected in dried urine stains prepared from urine that had been 
diluted with water (1:5).  Three controls will be prepared for use with Abacus p30 Test card and they 
consist of an extract prepared from a swatch with undiluted semen, a 1:20 dilution of the semen extract, 
and an extract prepared from a swatch with undiluted male urine.  These controls should be prepared 
alongside extracts from the questioned samples.  The concentrated semen and 1:20 dilution of semen 
should yield a positive result with the test card and the extract from the male urine should yield a negative 
result.  A reagent blank (negative control) should also be run with the test card. 

 
Analysts should be aware that the p30 protein is used as a diagnostic marker for prostate cancer where it is 
significantly overexpressed.  In males with prostate cancer the p30 protein can be found in very high levels 
in both urine and in blood. 
 
REFERENCES: 
 
1. Abacus Diagnostics p30 Test Card Product Insert “One step ABAcard p30 Test for  the Forensic 

Identification of Semen”. 
2. Armbruster, D.A. P30: biochemistry, analytical methods, and clinical application.  Clinical Chemistry. 

v39(2), p 181-95, 1993. 
3. Benton, K.A., Donahue, J.A., and Valdez, Jr., Manuel.  Analysis of the  ABAcard OneStep p30 Test 

for use in the forensic laboratory.  Presented at the Spring Meeting of SWAFS. 1998.  
4. Engelmann UH, Schramek, P., Tomamichel, G., Deindl, F., Senge, T.H. 

Vasectomy reversal in central Europe: results of a questionnaire of urologists in Austria, Germany, and 
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Method:  Leucomalachite Green (LMG) Presumptive Test for Blood 
 
Date: 4/1/99  Revision Date: 08/14/2009   Approved by: SAM  
 
 
REAGENTS: 
 
1. LEUCOMALACHITE GREEN (LMG) SOLUTION 
 

0.1g LMG (p,p-benzylidene-bis-N,N-dimethylaniline)   
66mL glacial acetic acid 
33mL distilled H2O 

 
Store refrigerated over excess zinc.  Caution: the reagent will evolve hydrogen gas continuously.  Do 
not cap tightly!! 

 
Expiration: The reagent is usable as long as the LMG is in the clear (reduced) form.  The color of the 
reagent should be evaluated before each use.  A reagent which is lightly tinged green is still usable.  A 
reagent that has become dark-green or opaque should be discarded. 

 
2. HYDROGEN PEROXIDE 3% 
 

Prepare by 1:10 dilution of 30% stock H2O2 or use a commercial 3% solution. 
 
MATERIALS: 
 
Cotton swabs or filter paper (test substrates) 
 
PROCEDURE: 
 
1. Test the reagents against positive and negative blood standards before using.  Record these results in 

your notes. 
 
2. Moisten a cotton swab or filter paper (the test substrate) with distilled water. Gently press or rub the 

stain with the substrate. 
 

Alternatively, a portion of the stained material can be cut and used directly as the test substrate. 
 
3. Add 1 or 2 drops LMG solution to the test substrate.  Observe briefly for any color change. 
 
4. Add 1 or 2 drops of 3% hydrogen peroxide.  Observe for any color change. 
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INTERPRETATION: 
 
A swiftly developing (within 5 seconds) blue-green color after step 4 is a positive test and  presumptively 
indicates the presence of blood.  When evaluating the color change in this reaction, the appearance of the 
stain, the amount of material being tested, and the condition of the stain should all be taken into 
consideration.  Analysts may denote a reaction as weak if they can articulate their interpretation (the 
underlying reason for  calling a reaction weak - color change that lacks intensity or a delayed color change 
not to exceed 30 seconds – should be added to the notes). 
 
Lack of a color change before 30 seconds indicates  a negative reaction and the absence of blood in 
detectable quantities. 
 
Any change to a blue-green color after step 3 may indicate the presence of an oxidizer and should not be 
interpreted as a positive.  A color change at this step should be deemed inconclusive. 
 
The test depends on the oxidation of LMG from a colorless to a colored form.  This reaction is catalyzed in 
the presence of heme and its derivatives.  The reaction can also take place in the presence of other catalysts, 
such as peroxidases, or inorganic oxidizers.  Therefore, the test cannot be considered completely specific 
for blood. 
 
REFERENCES: 
 
1. Burdett, P.E. "Presumptive Tests for Blood - A Comparative Survey", CRE Report No. 201, October 

1976 
2. Cox, M. "A Study of the Sensitivity and Specificity of Four Presumptive Tests for Blood", J Forensic 

Sci. Vol. 36, no. 5 (Sept. 1991), pp. 1503 - 1511 
3. Gaensslen, R.E. Sourcebook in Forensic Serology, Immunology, and Biochemistry, section 6.5 
4. Grodsky et al., "Simplified Preliminary Blood Testing - An Improved Technique and Comparison of 

Methods", J. Criminal Law, Criminology, and Police Science Vol. 42, (1951), pp. 95-104. 
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Method:   Phenolphthalin Presumptive Test for Blood (Kastle-Meyer Test) 
 
Date: 4/1/99 Revision Date:08/14/2009  Approved by: SAM  
  
REAGENTS: 
 
1. PHENOLPHTHALIN STOCK SOLUTION 
   

To a single-neck round-bottom flask, add: 
 

10g phenolphthalein powder 
100g potassium hydroxide 
100g zinc shavings 
500mL distilled H2O 

  
Place the flask in a heating mantle and attach a reflux unit.  Adjust the mantle setting to gently boil the 
solution.  Reflux until clear.  Store refrigerated over excess zinc. 

 
Expiration: Stock solution is usable as long as it is in the clear (reduced) form.  A pinkish solution has 
oxidized and should be re-refluxed or discarded. 

 
2. PHENOLPHTHALIN WORKING SOLUTION 
 

Add 4 parts of ethanol to one part phenolphthalin stock solution.  The reagent will be cloudy 
immediately following preparation; let stand refrigerated overnight to clear.  Store refrigerated over 
excess zinc.    

 
Expiration: The same precautions used for the stock solution should be applied.  A pinkish solution 
should be discarded. 

 
3. HYDROGEN PEROXIDE 3% 
 

Prepare by 1:10 dilution of 30% stock H2O2 or use a commercial 3% solution. 
 

MATERIALS: 
 
Cotton swabs or filter paper (test substrates) 
 
PROCEDURE: 
 
1. Test reagents against positive and negative blood standards before using.  Record these results in your 

notes. 
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2. Moisten a cotton swab or filter paper (the test substrate) with distilled water. 
 

Gently press or rub the stain with the substrate.  Alternatively, a portion of the stained material can be 
cut and used directly as the test substrate. 

 
3. Add 1 or 2 drops phenolphthalin working solution to the test substrate.  Observe briefly (up to 30 

seconds) for any color change. 
 
4. Add 1 or 2 drops of 3% hydrogen peroxide.  Observe for any color change. 
 
INTERPRETATION: 
 
A swiftly developing (within 5 seconds) pink to magenta color after step 4 is a positive test and 
presumptively indicates the presence of blood.  When evaluating the color change in this reaction, the 
appearance of the stain, the amount of material being tested, and the condition of the stain should all be 
taken into consideration.  Analysts may denote a reaction as weak if they can articulate their interpretation 
(the underlying reason for  calling a reaction weak - color change that lacks intensity or a delayed color 
change not to exceed 30 seconds – should be added to the notes). 
 
Lack of a color change before 30 seconds indicates  a negative reaction and the absence of blood in 
detectable quantities. 
 
Bloodstains may change to a greenish color after step 3.  Any change to a pink color at this stage may 
indicate the presence of an oxidizer and should not be interpreted as a positive. 

 
The test depends on the oxidation of clear phenolphthalin to colored phenolphthalein.  This reaction is 
catalyzed in the presence of heme and its derivatives.  The reaction can also take place in the presence of 
other catalysts, such as peroxidases, or inorganic oxidizers.  Therefore, the test cannot be considered 
completely specific for blood. 
 
REFERENCES: 
 
1. Cox, M. "A Study of the Sensitivity and Specificity of Four Presumptive Tests for Blood", J Forensic 

Sci. Vol. 36, no. 5 (Sept. 1991), pp. 1503 - 1511 
2. Gaensslen, R.E. Sourcebook in Forensic Serology, Immunology, and Biochemistry, section 6.3 
3. Grodsky et al., "Simplified Preliminary Blood Testing - An Improved Technique and Comparison of 

Methods", J. Criminal Law, Criminology, and Police Science Vol. 42, (1951), pp. 95-104. 
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Method: Luminol Detection of Latent Bloodstains 
 
Date: 01/02/2001  Revision Date:  01/01/2007 Approved by: SAM  
 
 
PURPOSE: 
 
The Luminol test is a presumptive test for the detection of latent bloodstains not visible to the naked eye.  
The test is based on the peroxidase-like activity of the hemoglobin molecule.  Hemoglobin derivatives 
greatly enhance the chemiluminescence exhibited by luminol when it is oxidized in an alkaline solution.   
 
The luminol test is very well suited for, but not limited to, crime scene applications, especially where there 
is a suspicion of possible clean-up of bloodstained areas.  This test may also be employed to help in the 
visualization of certain bloodstain patterns that may be only partially visible to the naked eye (i.e. drag 
marks, shoe impressions, etc.).   
 
POLICY: 
 
This test is not to be used as a substitute for careful visual examination for blood.  The area of interest 
should be searched in daylight or with the aid of high intensity light prior to the use of luminol. 
 
A Criminalist will be called to the scene to take part in the luminol procedure and to interpret any patterns 
that may develop. 
 
REAGENTS AND MATERIALS: 
 
1. Luminol powder (3-aminophthalhydrazide) 
2. Sodium Perborate 
3. Sodium Carbonate 
4. Distilled water 
5. Plastic hand pump spray bottle 
6. 1L plastic bottle 
 
CONTROLS: 
 
Positive Control: Known blood (or bloodstained area) or a copper penny. 
 
Negative Control: Area void of any suspected bloodstains. 
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PROCEDURE: 
 
1. The following proportions of reagents should be employed for 100mL of luminol spray: 
 

0.1g  luminol powder 
0.7g  sodium perborate 
5.0g  sodium carbonate 
100mL distilled water 

 
2. Weigh out the appropriate amount of the reagents and place them into a plastic 50mL tube.  If the 

reagents are not to be used immediately it is best to store the sodium perborate in a separate 50mL 
tube.  The luminol and the sodium carbonate may be stored together.  Once the reagents are mixed 
together they have a limited shelf life (approximately 24 hours). 

  
3. Measure the appropriate amount of water and place it in a plastic bottle.  Immediately prior to luminol 

application the reagents may be added to the water in the plastic bottle and thoroughly mixed.  Once 
mixed, the luminol reagent should be decanted into the plastic hand pump spray bottle.  Undissolved 
powder may have a tendency to clog the pump mechanism. 

  
4. Prior to the application of the luminol spray, a copper penny should be placed in the general vicinity of 

the area to be tested.  Set up any camera equipment required for documentation of the 
chemiluminescence at this point, if required. 

  
5. Darken the area suspected of containing latent bloodstains to near or total darkness.  It is advisable to 

allow time for eyes to adjust to darkness. 
  
6. The nozzle of the plastic hand pump spray bottle should be set to the finest mist setting.  Lightly spray 

the area of interest, as well as the copper penny.  If applicable lightly spray an area known to contain 
bloodstains, as well as a known negative area. 

 
INTERPRETATION: 
 
A strong bluish chemiluminescence (positive reaction) should be exhibited by the penny when sprayed with 
the luminol mixture.  This glow results from the penny because the luminol mixture is known to react with 
certain metal halides of copper and iron.  The positive reaction from the penny can be used as a quality 
control of the luminol mixture. 

 
A positive reaction in the area of interest is also identified by the presence of a strong chemiluminescent 
“glow”, which lasts several seconds.  Caution must be exercised in interpreting faint, or weak, reactions as 
well as “flashes” which could result from the interaction of luminol with metallic halides.  Generally, 
“flashes” will fade to total darkness immediately after spraying, while a positive bloodstained area will 
exhibit a longer lasting continuous reaction. 
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The chemiluminescence exhibited from the oxidation of luminol by a bloodstained area is bluish-white in 
nature and best visualized under total darkness. 

 
Positive reactions with the luminol reagent should be judged on the color of the reaction, the intensity of 
the reaction, and the duration of that reaction. 

 
It is important to note that luminol will react to produce a false positive with any agent that can oxidize the 
chemical directly.  Some cleaning agents (i.e. Drano and Pine-sol) as well as metallic halides can produce 
false positives with the luminol reagent.  A positive reaction obtained with the luminol reagent, even a 
strong, long lasting chemiluminescence, is not enough to confirm the presence of blood. 

 
It should also be noted that luminol will not interfere with further presumptive testing, human origin 
through testing by HemaTrace, or subsequent DNA testing. 

COLLECTION: 
 
General evidence collection guidelines should be used for the collection of luminol positive areas.  If a 
luminol-positive stain is going to be collected using a swab, use the sponge-tipped swab provided 
specifically for the collection of luminol-positive stains.  The preservation steps are the same although 
drying time is longer. 
 
DOCUMENTATION: 
 
Case notes regarding luminol application should always be taken as with any forensic procedure.  
Documentation through photography is highly recommended (where possible).  Documentation of luminol 
reactions can be accomplished with digital photography as well as film-based photography.  Photographic 
documentation of the luminol reaction is best accomplished in near or total darkness.  It is recommended 
that a control (available light or flash) photograph be taken of the area to be sprayed.  A reliable reference 
scale should be placed in the area to be photographed.  It is important that the camera not be moved 
between the control photograph and the luminol photograph so that proper orientation and reference can 
be inferred. 
 
SAFETY CONCERNS: 
 
May be harmful by inhalation, ingestion, or skin absorption.  Causes skin and eye irritation.  Material is 
irritating to mucous membranes and upper respiratory tract.  Goggles and rubber gloves should be worn.  
Use of a mask is required if being used in an enclosed room.  Do not breathe the chemical dust.  In case of 
contact, immediately flush eyes with water for 15 minutes and wash hands with soap and copious amounts 
of water. 
 
Do not dispose of excess luminol at the scene.  It is to be brought back to the lab for disposal down the 
drain.   
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If used at a crime scene, the Department is required to leave behind a list of companies that are available for 
crimescene clean up. 
 
REFERENCES: 
1. Della Manna A and Montpetit S. A novel approach to obtaining reliable PCR results from Luminol 

treated bloodstains, J. Forensic Sci., 45:886-890, 2000. 
2. RRJ Grispino. The effect of Luminol on the serological analysis of dried human bloodstains, Crime 

Laboratory Digest, Vol. 39(5), pp. 13-23, 1990. 
3. DL Laux. Effects of Luminol on the subsequent analysis of bloodstains, J Forensic Sci., 36(5), pp. 

1512-1520, 1991. 
4. AM Gross, KA Harris, GL Kadlun. The effect of luminol on presumptive tests and DNA analysis using 

the polymerase chain reaction, J Forensic Sci., 44(4), pp. 837-840, 1999.  
5. Sourcebook in Forensic Serology, Immunology and Biochemistry, National institute of Justice (1980). 
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Method:   Abacus HemaTrace Detection of  Blood 
 
Date: 12/08/1999   Revision Date: 01/01/2007  Approved by: SAM 

 
REAGENTS: 
 
Kit supplied extraction buffer. 
 
MATERIALS/ EQUIPMENT: 
 
Abacus HemaTrace Test Card Kit.  The kit includes test cards, plastic droppers, and extraction buffer.  
Abacus Diagnostics catalog #708424 (25 tests/box).  
 
PROCEDURE: 
 
1. Place a cutting of the stain or swab into a sterile 1.5mL tube.  Add 100uL of kit extraction buffer.  A 

solution of 5% ammonia may also be used to extract a stain that is difficult to remove from the 
substrate.  Extracts should also be prepared from a known human blood stain (positive control) and a 
reagent blank (negative control). 

 
Note:  If stains remain in extraction buffer or 5% ammonia in a refrigerator for extraction, they must be 
warmed to room temperature before proceeding with step 2. 
 
2. Remove enough of the supernatant created in step 1 so that when it is added to a second tube 

containing 150uL of extraction buffer the color of the solution is a light straw yellow. 
 
3. Load 150uL of the solution from the microcentrifuge tube created in step 2 onto the test card (area S). 
 
4. Immediately start timing the reaction.  The test card result(s) should be read at ten minutes.  Record 

the results as positive or negative on the Abacus HemaTrace Test Worksheet.  The test results can be 
documented by using a document scanner or digital camera.  Once a hard copy of the test cards is 
obtained there is no need to keep a permanent data file of the image. 

 
Note: Under no circumstances should results obtained after 10 minutes be recorded.  
 
If a positive result for human blood is obtained for a given sample it may be appropriate to also test a 
substrate control for that sample. 
 
INTERPRETATION: 
 
A positive test result for the presence of human blood is indicated by the presence of pink bands at both the 
control line “C“ and the test line “T“ on the test card.  The presence of a pink band at the control line but 
the absence of a pink band at the test line indicates a negative result.  A pink band will always appear at the 
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control “C” area.  The band in the “C” area is an internal control of the test strip.  If a pink band does not 
appear at the control “C” line of the test card the test is invalid.   
 
For a test series to be interpreted the positive and negative controls must yield the expected results. 
 
Legend: “S” = Sample loading area “T” = Test line “C” = Control  line     
 
 
 
 
 
 
 
 
 
 
 
 
 POSITIVE NEGATIVE INVALID 
 
REMARKS: 
 
The principle behind the Abacus HemaTrace Test Card is that the human hemoglobin protein present in a 
sample will react with a mobile monoclonal  
antihuman hemoglobin antibody creating a mobile antigen-antibody complex.  This mobile antigen-
antibody complex migrates through the absorbent test device towards the test area.  In the test area “T”, an 
antihuman hemoglobin antibody is immobilized.  This immobilized antibody captures the above complex 
creating an antibody-antigen-antibody complex.  The conjugated pink dye particles concentrate in a narrow 
zone on the membrane.  When the human hemoglobin concentration in the samples exceeds 0.05ug/mL 
the pink dye particles will form a pink colored band in the test area “T” indicating a positive result.  An 
internal positive control in area “C“ consists of an immobilized anti-immunoglobulin antibody that binds all 
hemoglobin antibody-dye conjugates that are unable to bind to the antibody in the test area “T“.  The 
captured dye particles will form a pink band at test area “C” indicating that the test has worked properly. 

  
Validation work on the Abacus HemaTrace Test Card performed at the San Diego Police Department 
indicates that the HemaTrace card is specific for human blood, only showing some cross-reactivity (positive 
results) with certain higher primates.  In their very concentrated form, other human body fluids can yield a 
positive with the HemaTrace Test Card.  This may result from small amounts of hemoglobin being present 
in these fluids (urine for example).   
 
Due to the positive reaction of the Abacus card with blood of higher primates and published reports of a 
positive reaction with blood from ferrets, it is required that reports detailing positive reactions with the 
Abacus card note these possibilities. 
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Validation of the HemaTrace Test Card by the Abacus Company revealed that treatment with Luminol, 
Coomasie Blue, Ninhydrin, bleach, or detergent did not interfere with obtaining results from human blood.  
Human blood present on soil, plant material, leather, or washed jeans also yielded a positive result. 
 
REFERENCES: 
1. OneStep ABAcard HemaTrace for the Forensic Identification of Human Blood (kit insert),  Abacus 

Diagnostics, 1999. 
2. Swander, C.J., Stites, J.G.  Evaluation of the ABAcard HemaTrace for the Forensic Identification of 

Blood,  MAFS 1998 Annual Meeting. 
3. Kristaly, A., Smith, D.A.S.  Validation of the One-step ABAcard HemaTrace for the Rapid 

Forensic Identification of Blood, 1999. 
4. Culliford, B., The Examination and Typing of Bloodstains in the Crime Laboratory, US Department of 

Justice, Washington D.C., 1964. 
5. Spear, T.F., Binkley, S.A.  The Hemeselect Test; a Simple and Sensitive Forensic Species Test, Journal 

of Forensic Science Society, V34 (1), p 41-46, 1994. 
6. Fernando, S.A., Wilson, G.S.  Studies of the Hook Effect in the One-Step Sandwich Immunoassay.  

Journal of Immunology Methods, V151 (1-2), p 47-66, 1992. 
7. Laux, D.L.  Effects of Luminol on the Subsequent Analysis of Bloodstains, J Forensic Sci, V35 (5), p 

1512-20, 1991. 
8. Gerberth, V.J.  Practical Homicide Investigation, Checklist and Field Guide, p 72-73, 1997. 
9. Cox, M.A.  A Study of the Sensitivity and Specificity of Four Presumptive Tests for Blood, Journal of 

Forensic Science, V36 (5), p 1503-1511, 1991. 
10. Doherty, P.E., Mooney, D.J., Deciphering Bloody Imprints Through Chemical Enhancement, Journal 

of Forensic Science, V35 (2), p 457-465, 1990. 
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Method:   Amylase Radial Diffusion    
 
Date: 01/27/1998   Revision Date:01/01/2007  Approved by: SAM 
 
 
REAGENTS: 
 
1. 0.1M PHOSPHATE BUFFER, PH 6.9 

2.7g NaH2PO4, anhydrous ( 0.045M ) 
 3.9g Na2HPO4, anhydrous ( 0.055M ) 
  0.2g NaCl ( 7mM ) 

500mL deionized H2O 
 

The buffer is good for nine months when refrigerated. 
 
2. 1% AGAROSE / 0.2% SOLUBLE STARCH GEL 
       Dissolve 20mg soluble starch and 100mg agarose ( e.g. Sigma Type I ) in 10mL of 0.1M phosphate 

buffer.  Pour into 100 x 15mm petri dish and allow to cool.  Punch wells into the gel at least 1.5cm 
apart using a glass pipette connected to a vacuum source. 

               
3. IODINE SOLUTION 

1.65g KI 
1.50g I2 

Dissolve in 30mL warm deionized water.  Stir 5 minutes and then filter.  Store in an amber bottle at 
40C.  This iodine solution is available commercially from Seri catalog #R512 or equivalent. 

                            
STANDARDS AND CONTROLS: 
 
1. Saliva stain extract (neat and a 1:10 dilution) 

The dried saliva stain can be stored in a freezer but must be used within 30 days. 
 
2. Liquid saliva (1:100 dilution) 
 
3. Blank (de-ionized H2O) 
 
4. Substrate control (if appropriate) 
 
5. Other body fluid standards may be run as needed. 
 
PROCEDURE: 
1. Extract unknown and controls in de-ionized H2O.  Comparable amounts of unknowns and controls 

should be extracted in comparable amounts of water.    
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2. Individually pipette 1.5uL or 2uL of unknowns and controls into wells created in the gel plate.   
 
3. Cover the gel plate, invert, and place in a 37oC incubator overnight. 
 
4. Flood gel with 10mL of a 1:100 dilution of iodine solution to stain the starch dark blue. 

 
5. Measure the diameter of the clear circles to the nearest millimeter and record the results. 
 
6. The results should be documented in a photograph with scale. 
 
INTERPRETATION: 
 
Positive:   The presence of saliva is indicated if the diameter of the sample is greater than or equal to 

the diameter of the 1:10 extracted saliva standard. 
 
Inconclusive: The test is inconclusive if the diameter of the sample is less than the diameter of the 1:10 

extracted saliva standard. 
 
Negative: The presence of saliva is not indicated if there is no circle around the sample well. 
 
Any amylase activity obtained from substrate controls will be noted in the case notes and report. 
 
REMARKS: 
  
Amylase hydrolyzes starch, first to oligosaccharides, then to maltose and glucose.  As the samples diffuse 
into the gel around each well, starch is hydrolyzed in an area proportional to the concentration of amylase 
present in the sample.  Iodine reacts with starch to produce a deep blue color and clear circles are the result 
in areas where amylase has hydrolyzed the starch. 
 

Starch-------------->Oligosaccharides----------------------->Glucose + Maltose 

(blue) (red) (colorless) 

Amylase is present in saliva at high concentrations, hence the use of amylase as a presumptive test.  
However, amylase is present in most body fluids and tissues including semen, vaginal fluid, and urine 
though generally at much lower levels than found in saliva.  Perspiration, breast milk, and feces may have 
high levels of amylase.    
 
REFERENCE: 
Gaensslen, R., Sourcebook in Forensic Serology, Immunology, and Biochemistry.  US Government 
Printing Office, 1983. 
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Method:   Detection of Urobilinogen in Fecal Stains 
 
Date: 1/27/98  Revision Date: 01/01/2007  Approved by: SAM  
 
 
REAGENTS: 
1. 10 %  ALCOHOLIC MERCURIC CHLORIDE ( HgCl2 ) 

Dissolve 0.3 g of mercuric chloride into 3 mL of reagent alcohol. 
Freshly prepare this reagent each time this procedure is conducted.  Do not store.   

 
2. 10% ALCOHOLIC ZINC CHLORIDE ( ZnCl2 ) 

Dissolve 0.3 g of zinc chloride into 3 mL of reagent alcohol. 
Freshly prepare this reagent each time this procedure is conducted.  Do not store.  

 
MATERIALS: 
1. Ultraviolet ( UV ) light source 
2. 6 x 50mm borosilicate glass test tubes.  Note: flint glass tubes will not work for this method. 
 
PROCEDURE: 
1. Prepare an aqueous extract of the unknowns and controls.  Appropriate controls include positive 

controls (neat, 1:5, and 1:10 dilutions), a negative control (reagents only) and any substrate controls 
(if applicable).  Cut out approximately 0.5cm square of the stain, and place it into a 6 x 50mm 
borosilicate glass test tube.  Add 0.5mL of distilled water to the substrate. 

 
2. Vortex the extracts, then let the extracts stand for at least 15 minutes. 
 
3. Remove the substrate from each tube. 
 
4. Add 3 drops of the 10% alcoholic mercuric chloride to each tube. 
 
5. Add 3 drops of the 10% alcoholic zinc chloride to each tube and shake the tubes to mix. 
 
6. Examine the extracts under UV light.   
 
INTERPRETATION: 
Under UV light the extracts will have a stable apple green fluorescence if urobilinogen is present.  The 
controls should yield the expected results for the test to be interpretable. 
 
A positive urobilinogen result is consistent with the presence of feces. 
 
REFERENCES: 
Gaensslen, R.E., Sourcebook in Forensic Serology, Immunology, and Biochemistry, a publication of the National 
Institute of Justice, U.S. Department of Justice, August 1983, pp. 197-8. 
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Method:   General DNA Extraction  
 
Date: 03/30/2000  Revision Date:   02/06/2009  Approved by: SAM 
 
 
REAGENTS: 
 
1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS) 
 

Mix together 1 mL of 1M Tris-HCL, ph= 7.5, 2 mL of .5M EDTA, 1 mL of 5M NaCl, 10 mL of 20% 
SDS (w/V) and 86 mL of nanopure water.  Autoclave and store at room temperature.  The solution is 
good for one year. 

 
2. 10 mg/mL PROTEINASE K 
 

Dissolve 100mg of proteinase K in 10mL of autoclaved nanopure water.  Store at -20oC in 200uL 
aliquots.  The aliquots are good for one year.  

 
3. DTT (1M DTT, 10mM Sodium Acetate, pH= 5.2) 
 

Dissolve .77g dithiothreitol in 5mL autoclaved nanopure water.  Add 50uL 1M autoclaved sodium 
acetate pH= 5.2.  Store at -20oC in 100uL aliquots.  The aliquots are good for one year. 

 
EQUIPMENT: 
 
Microcentrifuge (capable of 10,000-15,000 x g) 
 
PROCEDURE: 
 
1. Place a portion of the stain, substrate, or swab in a sterile 1.5mL microcentrifuge tube and add 400-

500uL of digest buffer and 15-20uL of 10mg/mL proteinase K.    
 
[The Large Volume protocol on the EZ1 can accommodate up to 900uL of volume in the sample tubes.  
Analysts may choose to add more digest buffer to samples to accommodate larger sized substrates.  The 
volume of proteinase K added to the sample should be proportional to the volume of digest buffer.] 
 
[If a bloodstain appears especially dirty, the analyst may add 15uL of 1M DTT to aid in the digestion of the 
bloodstain.  If a tissue sample is embedded in paraffin wax please refer to reference 2 for the process of 
removing the wax.]   
 
2. Mix gently and incubate at 56oC for at least two hours.  Following incubation the samples can be gently 

centrifuged to remove moisture from the lids.  
  

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 37 of 185 

 
 

3. At this point any samples can be purified using either phenol/chloroform/isoamyl alcohol or the 
BioRobot® EZ1.  Please refer to the desired protocol for the procedure. 

 
REFERENCES: 
1. Cetus Amplitype User Guide 1990 
2. Fregeau CJ et al. AmpFlSTR Profiler Plus and AmpFlSTR COfiler Analysis of Tissue Stored in 

GenoFix, a New Tissue Preservation Solution for Mass Disaster DNA Identification. J Forensic Sci 
2001; 46(5): 1180-1190. 
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Method:   DNA Extraction with Microscopic Examination 
 
Date: 03/30/2000  Revision Date:   01/01/2007  Approved by: SAM  
 
  
REAGENTS: 
 
1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS) 
 

Mix together 1mL of 1M Tris-HCL, ph= 7.5, 2mL of .5M EDTA, 1mL of 5M NaCl, 10mL of 20% 
SDS (w/V) and 86mL of nanopure water.  Autoclave and store at room temperature.  The solution is 
good for one year. 

 
2. 10 mg/mL PROTEINASE K 
 

Dissolve 100 mg of proteinase K in 10 mL of autoclaved nanopure water.  Aliquot solution in 200uL 
aliquots and store in -20oC freezer.  The aliquots are good for one year.  

 
EQUIPMENT: 
 
Microcentrifuge (capable of 10,000-15,000 x g) 
 
PROCEDURE: 
 
Note: This procedure is designed for evidence samples.  Reference mouth swabs do not require 
microscopic analysis (see "BioRobot EZ1 DNA Purification of Reference Samples" procedure). 
  
1. Place a portion of the substrate or swab in a 1.5mL microcentrifuge tube and add 0.75 to 1mL of 

sterile nanopure water. 
 
2. Incubate the sample at room temperature for at least 30 minutes with occasional vortexing. 
 
3. Remove the substrate and place into a second sterile 1.5mL microcentrifuge tube and retain. 
 
4. Centrifuge the sample in a microcentrifuge for 3-5 minutes at maximum speed. 
 
5. Without disturbing the pellet, remove and discard all but 50-100uL of the supernatant.  Resuspend the 

cell pellet. 
 
6. Refer to the procedure "Identification of Cellular Material Using Xmas Tree Staining." 
 
7. Add 0.5mL of digest buffer and 15-20uL of 10 mg/mL proteinase K solution.  Vortex briefly.  [The 

original substrate can be added back to increase the DNA yield from the sample]. 
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8. Incubate the sample at 56oC for at least 2 hours. 
 
9. At this point any samples can be purified using either phenol/chloroform/isoamyl alcohol or the 

BioRobot® EZ1.  Please refer to the desired protocol for the procedure. 
   
REFERENCES: 
Cetus Amplitype User Guide 1990 
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Method:   Differential DNA Extraction 
 
Date: 06/29/2000   Revision Date:   02/06/2009  Approved by: SAM  
 
 
REAGENTS: 
 
1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS) 
 

Mix together 1mL of 1M Tris-HCL, ph= 7.5, 2mL of .5M EDTA, 1mL of 5M NaCl, 10mL of 20% 
SDS (w/V) and 86mL of nanopure water.  Autoclave and store at room temperature.  The solution 
is good for one year. 

 
2. 10 mg/mL PROTEINASE K 
 
 Dissolve 100mg of Proteinase K in 10mL of autoclaved nanopure water.  Store at -20oC in 200uL 

aliquots.  The aliquots are good for one year.  
 
3. DTT (1M DTT, 10mM Sodium Acetate, pH= 5.2) 
 

Dissolve .77g dithiothreitol in 5mL autoclaved nanopure water.  Add 50uL 1M autoclaved sodium 
acetate pH= 5.2.  Store at -20oC in 100uL aliquots.  The aliquots are good for one year. 

 
EQUIPMENT: 
 
Microcentrifuge (capable of 10,000-15,000 x g) 
 
PROCEDURE: 
 
Note:  The initial dH2O wash and microscopic analysis of samples that have previously been screened is 
optional.  If this process is skipped analysts may start the differential extraction at step 8. 
 
1. Place the sample (swab or other substrate) to be extracted in a sterile 1.5mL tube and add 1mL of 

sterile distilled water. 
 
2. Incubate at room temperature for at least 30 minutes. 
 
3. Vortex the tube a couple of times during the incubation to aid in removing the cells from the substrate. 
 
4. Remove the substrate with a pipette tip or plain wood applicator and transfer it to a second sterile 

microfuge tube and retain. 
 
5. Spin the sample in a microcentrifuge for 3-5 minutes at 10,000 x g (maximum speed) at room 
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temperature. 
 
6. Without disturbing the cell pellet, remove and discard all but 50-100uL of the supernatant.  

Resuspend the cell pellet in the remaining supernatant.  Place 5uL of the sample onto a well of a slide 
(different amounts may be used).  Place the slide in an incubator or on a heat block to fix any cells to 
the slide. 

 
7. At this point proceed to the procedure "Identification of Cellular Material Using Xmas Tree Staining".  

Note: In general, 100 sperm cells are needed to obtain a DNA result.  The sperm cells observed 
microscopically, however, provide only an estimate of the total number of sperm present in a sample 
extract.  An analyst should use appropriate judgement when deciding on whether to proceed with 
DNA analysis on a particular sample. 

 
8. Add 400-500uL of digest buffer and 15-20uL of 10mg/mL proteinase K to the resuspended cell pellet 

(more digest buffer and proteinase K may be added if the substrate is especially large).  [Option: The 
original substrate can now be added back to increase the amount of cellular material removed from the 
substrate.]   

 
9. Incubate at 56oC for 1-2 hours to lyse nonsperm cells. [Option: Incubation may be longer to ensure 

lysing of the nonsperm cells]. 
 
10. Spin the sample in a microcentrifuge for 3-5 minutes at maximum speed.  Remove the supernatant and 

place in a sterile 1.5mL microcentrifuge tube.  This supernatant contains DNA from any non-sperm 
cells present in the sample.  The sample can be put aside until DNA purification.  [The reagent blank 
supernatant will act as a control for the non-sperm fraction]. 

 
11. [Option: A second digest with digest buffer and proteinase K may be performed in order to ensure that 

the sperm fraction is free of non-sperm cells]. 
 
Note:   An analyst may elect to skip directly to step 14 in order to immediately perform the microscopic 

analysis.  Steps 12 and 13 should be performed prior to step 16 if sperm cells are observed in the 
samples. 

 
12. Wash the pellet as follows:  Resuspend the pellet in 0.5-1.0mL digest buffer and vortex briefly.  Spin 

the sample in a microcentrifuge for 5 minutes at maximum speed.  Remove all but 50-100uL and 
discard. 

 
13. Repeat wash step 12 at least twice.  [Additional washes are critical when the number of sperm is low 

and the number of non-sperm cells is high]. 
 
14. Resuspend the pellet in 0.5-1.0mL sterile distilled water and vortex briefly.  Spin the cells in a 

microcentrifuge for five minutes at maximum speed.  Remove and discard all but 50-100uL of the 
supernatant.  Resuspend the cells in the remaining supernatant. 
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15. To verify the presence of sperm and the complete digestion of nonsperm cells proceed to the 

procedure "Identification of Cellular Material Using Xmas Tree Staining".   
 

Note: If the sperm fraction is probative, the entire sample being analyzed should contain 
approximately 100 sperm to proceed with DNA analysis.  In this circumstance both the sperm and 
non-sperm fractions should be continued through DNA analysis.   
 
If the non-sperm fraction is probative and sufficient sperm cells are present, both the sperm and non-
sperm fractions must be DNA typed.   
 
If the non-sperm fraction is probative and insufficient or no sperm cells are found in the sperm 
fraction, only the non-sperm fraction needs to be typed. 

 
16. Add 400-500uL digest buffer, 20uL 1M DTT and 15-20uL of 10 mg/mL proteinase K solution to the 

re-suspended sperm cell pellet. 
 
17. Incubate for at least 2 hours at 56oC. 

 
18. At this point any samples (either non-sperm or sperm fraction) can be purified using either 

phenol/chloroform/isoamyl alcohol or the BioRobot® EZ1.  Please refer to the desired protocol for 
the procedure. 

 
REFERENCES: 
Cetus Amplitype User Guide 1990 
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Method:   DNA Extraction from Hair 
 
Date: 03/30/2000   Revision Date:   03/01/2010  Approved by: SAM  
 
 
REAGENTS: 
 
1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS) 

Mix together 1mL of 1M Tris-HCL, ph= 7.5, 2mL of .5M EDTA, 1mL of 5M NaCl, 10mL of 20% 
SDS (w/V) and 86mL of nanopure water.  Autoclave and store at room temperature.  The solution 
is good for one year. 

 
2. 10 mg/mL PROTEINASE K 

Dissolve 100mg of Proteinase K in 10mL of autoclaved nanopure water.  Store at -20oC in 200uL 
aliquots.  The aliquots are good for one year.  

 
3. DTT (1M DTT, 10mM Sodium Acetate, pH= 5.2) 

Dissolve .77g dithiothreitol in 5mL autoclaved nanopure water.  Add 50uL 1M autoclaved sodium 
acetate pH= 5.2.  Store at -20oC in 100uL aliquots.  The aliquots are good for one year. 

 
MATERIALS/ EQUIPMENT: 
 
1. Microcentrifuge (capable of 10,000-15,000 x g) 
 
2. Xylene and 100% ethanol (for mounted hairs) 
 
3. Diamond scribe (for mounted hairs) 
 
4. 50mL sterile disposable plastic tubes 
 
PROCEDURE: 
 
1. Wash hair to reduce surface dirt and potential contaminants as follows: 
 
2. For loose hairs, fill a sterile 50mL plastic screw-topped tube with sterile nanopure water and place the 

hair in the tube using a pair of sterile forceps.  Wash each hair separately. 
 

For mounted hairs, freeze the slide in a -20oC freezer for 20 minutes.  Remove coverslip by cracking the 
coverslip with a diamond scribe.  Alternatively, the coverslip may be removed by soaking in xylene for 
several hours after cracking the coverslip with a diamond scribe.  Wash away the mounting medium by 
squirting the slide with xylene.  Place the hair in a 1.5mL microcentrifuge tube and add 100% ethanol.  
Finally, wash the hair in the microcentrifuge tube by removing and discarding the ethanol and then adding 
water. 
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3. Examine the hair under a dissecting microscope.  Note the possible presence of body fluids on the hair.  

Cut off 0.5cm to 1cm of the proximal (root) end for digestion.  Because the hair may contain cellular 
material on the surface that may or may not originate from the hair donor, it is advisable to cut off 0.5 
to 1cm of the shaft adjacent to the root as a control.  The remaining shaft should be retained.  [Note: 
All evidentiary hairs should be photographed prior to performing DNA testing on them.] 

 
4. Place the hair sample and its control into separate sterile 1.5mL microcentrifuge tubes.  Add 0.5mL 

digest buffer, 20uL 1M DTT and 15-20uL 10mg/mL proteinase K. 
 
5. Incubate at 56oC for at least 6 hours. 
 
6. Add an additional 15-20uL 1M DTT and 15uL of 10 mg/mL proteinase K to the samples. 
 
7. Incubate at least 6 hours or until the hair is dissolved. 
 
8. At this point any samples can be purified using either phenol/chloroform/isoamyl alcohol or the 

BioRobot® EZ1.  Please refer to the desired protocol for the procedure. 
   
REFERENCES: 
Cetus Amplitype User Guide 1990 
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Method: The Processing and DNA Extraction of Bone Samples 
 
Date: 06/21/2005   Revision Date:   04/01/2008  Approved by: SAM 
 
 
REAGENTS: 
 
1. LIQUID NITROGEN (16 liters is needed as a minimum) obtained from the 50 gallon tank located in 

the Trace Evidence section.  
  
2. 10-20% BLEACH (Sodium Hypochlorite) 
 

Dilute store bought bleach between 1:5 and 1:10 with water. 
  
3. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS) 
  

Mix together 1mL of 1M Tris-HCL, ph= 7.5, 2mL of 0.5M EDTA, 1mL of 5M NaCl, 10mL of 20% 
SDS (w/V) and 86mL of nanopure water.  Autoclave and store at room temperature.  The solution is 
good for one year. 

 
4. 10mg/mL PROTEINASE K 
 

Dissolve 100mg of proteinase K in 10mL of autoclaved nanopure water.  Store at -20oC in 200uL 
aliquots.  The aliquots are good for one year.  

 
5. DTT (1M DTT, 10mM Sodium Acetate, pH= 5.2) 
 

Dissolve .77g dithiothreitol in 5mL autoclaved nanopure water.  Add 50uL 1M sodium acetate pH= 
5.2.  Store at -20oC in 100uL aliquots.  The aliquots are good for one year. 

 
6. AMMONIUM OXALATE (saturated, pH= 3.0) 
 

Make a saturated solution of ammonium oxalate by adding ammonium oxalate to 100mL of nanopure 
water.  Adjust to pH= 3.0 by adding HCL. 

 
7. 0.5M EDTA (pH= 8.0) 
 

Dissolve 186.1g disodium ethylenediamine tetraacetate-2H2O to 800mL of distilled water.  Stir 
vigorously and adjust the pH to 8.0 by adding NaOH pellets (approximately 20g).  Adjust final volume 
to one liter with distilled water and autoclave. 

 
EQUIPMENT: 
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1. 6850 Freezer Mill with grinding accessories 
 
2. 50mL plastic sterile tubes 

PROCEDURE: 
A bone kit has been assembled for the analysts that require the tools needed to process bone samples for 
casework.  The kit includes a vise, clamps to secure the vise to a table, a hacksaw with a supply of blades, 
sandpaper, and a Dremel™ tool with accessories.  It is intended that the vise be used to secure the bone 
sample while sectioning a portion for analysis. 
 
1. Clean the two metal end plugs, the metal impactor, and the plastic vial with soap and water being 

careful to remove all of the bone debris. Following this cleaning soak the components in 10% bleach 
solution for no longer than 30 minutes. 

 
2. Rinse in water and dry all the components (If the metal plugs and impactor are not dried they will 

rust). 
 

3. Swab all components using a nanopure water moistened cotton-tipped swab.  This swab will serve as a 
control during the extraction procedure and should be extracted alongside the bone sample. 

 
4. Remove a portion of the evidence bone (the amount of bone sectioned will depend on the age and 

condition of the bone as well as the environmental exposure) using a clean hacksaw blade. Clean the 
bone piece by removing adhering tissue, decaying marrow, and any other debris.  Use the provided 
sandpaper to remove the approximately 1mm of the outermost surfaces of the bone; including the 
central area where the marrow was (the bone section may need to be cut in half length-wise to 
accomplish this). 

  
5. Soak the bone sample in a 10-20% bleach solution for approximately 15 minutes. Rinse the bone 

section twice with nanopure water. 
 
6. Wrap the bone piece in a latex glove and use a hammer to break the bone into several smaller 

fragments. 
 
7. Tightly place one steel end plug on the plastic grinding vial. Place bone fragments and metal impactor 

inside vial. Close the vial with the other metal end plug. 
 
8. Open the freezer mill lid by pressing the Lid Up/Down switch. Lift the metal gate handle up and turn 

it clockwise to line it up with the slot on the gate. Pull the gate down to insert the vial. Insert the vial, 
close, and lock the gate (loosely tighten the gate). 

 
9. Wearing insulated gloves and other appropriate protective gear gradually fill the tub with 16 liters of 

liquid nitrogen. This requires the carboy that is used to transport liquid nitrogen to be filled 
completely four times. 
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10. Lower the lid slowly by pressing the Lid Up/Down switch until the coil enters the liquid nitrogen. 

Pause to allow boiling of the nitrogen around the warm coil. When the boiling subsides, close the lid 
the rest of the way. 

 
11. When the vapor stream has slacked off (30 seconds or so) check the liquid nitrogen level with the 

internal sensor by pressing control keys 2 and 3 simultaneously. 
 
12. When you press the RUN key (with sufficient liquid nitrogen in the tub, a loaded   vial in the coil, and 

the factory settings in place), the Freezer/Mill will perform      the following steps: 
 

a. The mill cools for 8 min., while the TIME display counts down the minutes remaining in the pre-
cooling period. The T3 indicator light should be on. 

b. The first grinding period begins and lasts for 2 minutes, while the TIME display counts down the 
time remaining in that grinding period, and the RUN indicator light is lit. The CYCLE display 
shows 3. 

c. The first cooling period begins and lasts for 2 minutes, while the TIME display counts down and the 
T2 indicator light is on. The CYCLE display still shows 3. 

d. The second grinding/cooling cycle takes place, the same as in steps b  and c combined. The TIME 
display will count down, and the appropriate  RUN and COOL indicator lights will be on in turn, 
while the CYCLE display shows 2. 

e. The third grinding/cooling cycle is like the second (step d) except that the CYCLE display shows 1. 
f. At the end of the third grinding cycle, the TIME display will flash END for several seconds, and 

then the control panel will return to Program Mode, exhibiting the same parameters as when the 
mill was first started. 

 
13. Wearing protective gear, raise the lid by pressing the Lid Up/Down switch and remove the vial by 

opening the locked gate. 
 
14. Fit the metal end plug extractor over one end of the vial and turn knob clockwise several turns until 

the screw engages the metal end plug. Squeeze the lever, then turn the knob clockwise and repeat until 
the end plug is removed. (If the screw locks up wait briefly for vial to warm up before attempting to 
open again.) 

 
15. When the end-plug is removed from the vial, empty the contents of the vial into a suitable container. 

Perhaps the easiest means of gathering the ground bone is first to pour the contents of the vial into a 
disposable plastic weighboat and then in turn transfer the contents to a 50ml conical plastic tube. 

 
16. Clean the two metal end plugs, the metal impactor, and the plastic vial with soap and water being 

careful to remove all of the bone debris. Following this cleaning soak the components in 10% bleach 
solution for no longer than 30 minutes.  

 
17. Rinse in water and dry all the components (If the metal plugs and impactor are not dried they will 
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rust). 
 
18. If running another bone sample ensure the liquid nitrogen level is appropriate and proceed. 
 
19. After the milling of the bone is complete (refer to 6850 Freezer Mill Procedure), pour the ground 

bone into a clean weighboat and then transfer the ground bone into a 50mL plastic tube. 
 
Steps #20-22 are optional and involve decalcifying the bone powder over a three day period using 0.5M 
EDTA.  In some cases, the decalcifying step will increase the amount of DNA recovered from the ground 
bone.  If a BioRobot® EZ1 extraction is to be performed then the bone sample must be decalcified.  A 
BioRobot® EZ1 extraction is only recommended with relatively fresh bone samples. 
 
20. Decalcifying is accomplished by adding 40mL of 0.5M EDTA, pH = 8.0 to the 50mL plastic tube 

containing the ground bone.  Place the tube on a rocking shaker overnight and the following morning 
spin the tube in the swinging bucket rotor at approximately 2500rpm for 5 minutes.  Pour the 
supernatant off into another 50mL plastic tube.  Save this tube for step #21.  Add 40mL of 0.5M 
EDTA to the bone powder and resuspend the pellet.  Place the tube on the rocking shaker.  The 0.5M 
EDTA should be changed approximately 4-5 times over the three day period. 

 
21. The decalcification process should be monitored by the addition of saturated ammonium oxalate pH= 

3.0, to the decanted supernatants.  The addition of the ammonium oxalate to the decanted supernatant 
will produce a cloudy precipitate if calcium is present.  If the supernatants remains clear after the 
addition of ammonium oxalate the decalcification is complete. The supernatant can be discarded. 

 
22. Following decalcification, wash the bone pellet three times by adding 40mL of sterile nanopure water, 

resuspending the pellet and centrifuging the sample for 5 minutes at approximately 2500rpm.  Discard 
the supernatant. 

 
23. To the bone powder (no decalcification) or the bone pellet (decalcification), add 7mL (for organic 

DNA purification) or 600-700uL (for BioRobot® EZ1 DNA purification) of extraction buffer,  200uL 
of 10 mg/mL proteinase K ,and 100uL of 1M DTT and mix.  Incubate the tube at 56oC for at least 4 
hours. 

 
24. To the initial incubation add another 200uL of 10 mg/mL proteinase K and 100uL of 1M DTT.  

Incubate the tube at 56oC at least 6 hours. 
 
If the samples will be purified using the BioRobot® EZ1, please refer to the BioRobot® EZ1 DNA 
purification procedure.  If phenol/chloroform/isoamyl alcohol DNA purification is to be performed then 
continue with step #25 of this procedure. 
 
25. Add 7mL of phenol/chloroform/isoamyl alcohol to the bone sample.  Vortex the sample, spin the 

tube at approximately 3000rpm and transfer the upper aqueous phase to a new 50mL tube.  Continue 
to purify the sample using phenol/chloroform/isoamyl alcohol until the aqueous-organic interface is 
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clear. 
 
26. [Optional] Add 7mL of butanol to the tube, vortex, spin the tube at approximately 3000rpm for 2 

minutes and remove the butanol phase (upper) and discard. 
  
27. The purified sample can now be washed and concentrated.  Please refer to the protocol for the use of 

the Centricon-100 centrifugal filter devices (DNA Purification/Concentration Using Centricon YM-
100 Centrifugal Filter Devices) to concentrate the purified samples.  Each purified bone sample may 
require several centricon filter devices as the extracts may have fine bone powder in them which tends 
to clog the devices. 

 
REFERENCES: 
Hochmeister MN et al. "Typing of Deoxyribonucleic Acid (DNA) Extracted from Compact Bone from 
Human Remains. J Forensic Sci. 1991 Nov;36(6):1649-61. 
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Method:   Organic DNA Purification Using Phenol/Chloroform/Isoamyl alcohol 
 
Date: 05/24/2005   Revision Date:   01/01/2007  Approved by: SAM  
 
 
REAGENTS: 
 
1. PHENOL/CHLOROFORM/ISOAMYL ALCOHOL (25:24:1) 
 

Add 0.1%(w/v) 8-hydroxyquinoline (Sigma Catalogue #H-6878) to the phenol/chloroform/isoamyl 
alcohol (Fisher BP1752I-400) to prevent oxidation.  Store at 4oC.  The solution is good for one year.  
 
NOTE:  See additional directions concerning the preparation of phenol/chloroform/isoamyl alcohol as 
outlined in the Reagent Preparation Log. 

 
2. n-BUTANOL 
 

To 50mL of n-butanol add approximately 50mL of autoclaved nanopure water and shake.  Following 
separation the upper layer is n-butanol which is now saturated with water.  The solution is good for one 
year. 

 
PROCEDURE: 
 
1. Remove the substrate (if applicable), and add 0.5mL buffered phenol/chloroform/isoamyl alcohol 

solution.  Vortex for 15 seconds.   
 

[Phenol/chloroform extractions must be carried out in a hood with a lab coat and eye protection]. 
 
2. Spin in a microcentrifuge for 3-5 minutes at maximum speed. 
 
3. Use a sterile pipette tip or equivalent to transfer the upper aqueous phase to a new sterile 1.5mL 

microcentrifuge tube. 
 
4. Repeat steps 1-3 an additional one or two times or until the aqueous phase is clear.  For these 

additional extractions, the lower phenol-chloroform layer may be removed and discarded, thus 
eliminating the need for a fresh microcentrifuge tube. 

 
5. The addition of 0.5 to 0.75mL of water saturated n-butanol is an optional step to further purify the 

extracted sample (n-butanol removes any residual phenol-chloroform).  Vortex 15 seconds. 
 
6. Spin in microcentrifuge for one minute at maximum speed.  Discard the upper layer which is n-

butanol. 
7. The purified sample can now be washed and concentrated.  Please refer to the protocol for the use of 
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either the Microcon-YM100 centrifugal filter devices (DNA Purification/Concentration Using 
Microcon YM-100 Centrifugal Filter Devices) or the Centricon-100 centrifugal filter devices (DNA 
Purification/Concentration Using Centricon YM-100 Centrifugal Filter Devices) to concentrate the 
purified samples. 

 
REFERENCES: 
Cetus Amplitype User Guide 1990 
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Method:   DNA Purification/Concentration Using Microcon YM-100 Centrifugal Filter 
Devices 

 
Date: 05/24/2005  Revision Date:   01/01/2007  Approved by: SAM  
 
 
REAGENTS: 
 
TE BUFFER (10mM Tris-HCL, 0.1M EDTA pH= 8.0) 
 
Mix together 10mL of 1M Tris-HCL, pH= 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure water.  
Aliquot into 100mL bottles, autoclave and store at room temperature.  The solution is good for nine 
months. 
 
MATERIALS: 
 
1. Microcon-YM 100 Centrifugal Filter Devices (Amicon) 
 
2. Microcentrifuge (capable of 10,000-15,000 x g) 
 
PROCEDURE: 
 
Note:  The capacity of the Microcon-YM100 reservoir is approximately 500uL.  If the purified extract has a 
larger volume it may require adding any remaining amount of sample that did not fit into the reservoir after 
the first spin.  This protocol may also be used to further concentrate previously purified samples. 
 
1. Assemble the Microcon-YM100 unit by inserting the sample reservoir into the filtrate vial. 
 
2. Add approximately 50uL of TE buffer to the upper Microcon-YM100 reservoir. 
 
3. Add the entire extracted DNA sample on top of the TE buffer.  Seal with the attached cap. 
 
4. Centrifuge the assembled Microcon spin-column in a microcentrifuge for 12-15 minutes at 2300rpm 

(~500 x g).  The DNA sample will be concentrated in about 5-15uL of TE buffer in the bottom of the 
upper Microcon-100 reservoir (molecules with molecular weights of less than 100,000 Daltons will 
pass through the filter). 

 
5. Discard the effluent in the filtrate vial. Retain the tube for further wash steps. 
 
6. Add approximately 300uL of TE buffer to the concentrated DNA solution in the Microcon reservoir. 
 
7. Centrifuge the sample(s) at 2300rpm for 12-15 minutes.  Discard the effluent and repeat the TE wash 

(steps 5-7) at least one more time. 
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8. After the last wash, 5-200uL of TE buffer may be added to the Microcon-100 column (depending on 

desired final volume/concentration).  Collect the DNA sample by inverting the reservoir into a new 
microcon tube and centrifuge at approximately 3200rpm (approximately 1000 x g) for 3-5 minutes. 

 
9.   The concentrated purified DNA now resides in the tube.  Cap the tube and store frozen.  Alternatively, 

transfer the purified DNA to a different tube, such as a sterile screw-cap tube for storage. 
 
REFERENCES: 
Microcon Centrifugal Filter Device User Guide, Revision J. Millipore 2000 
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Method:   DNA Purification/Concentration Using Centricon YM-100 Centrifugal Filter 
Devices 

 
Date: 01/01/2007   Revision Date:   01/01/2007  Approved by: SAM  
 
 
REAGENT: 
 
TE BUFFER (10mM Tris-HCL, 0.1M EDTA pH= 8.0) 
 
Mix together 10mL of 1M Tris-HCL, pH= 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure water.  
Aliquot into 100mL bottles, autoclave and store at room temperature.  The solution is good for nine 
months. 
 
MATERIALS: 
 
1. Ultracel-YM 100 Centrifugal Filter Devices (Amicon) 
 
2. Table Top Centrifuge with Fixed Angled Rotor (Sorvall RT6000B or RT6000D) 
 
PROCEDURE: 
 
1. Assemble the Ultracel-YM 100 (Centricon) unit by inserting the sample reservoir into the filtrate vial. 
 
2. Add approximately 1.5mL of TE buffer to the upper Centricon reservoir. 
 
3. Add the entire extracted DNA sample on top of the TE buffer.  Cover the top of the sample reservoir 

with the retentate vial. 
 
4. Centrifuge the column in the Sorvall RT6000B (or RT6000D) at approximately 4300 rpm 

(approximately 2000 x g) at room temperature for 7 minutes.  The DNA sample will be concentrated 
in about 40uL of TE buffer in the bottom of the upper Centricon reservoir (molecules with molecular 
weights of less than 100,000 Daltons will pass through the filter). 

 
5. Discard the effluent in the filtrate vial. 
 
6. Add approximately 2mL of TE buffer to the concentrated DNA solution in the sample reservoir. 
 
7. Repeat steps 7-8 two more times for a total of three washes. 
 
8. After the last wash, collect the approximately 40uL of concentrated DNA sample by inverting the 

sample reservoir into the provided retentate vial and centrifuge at approximately 1800 rpm 
(approximately 500 x g) for two minutes. 

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 55 of 185 

 
 

 
9. The concentrated purified DNA now resides in the retentate vial.  Transfer the purified DNA to an 

appropriate tube and store frozen.   
 
REFERENCES: 
Centricon Centrifugal Filter Device User Guide, Revision J. Millipore 2005 
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Method:   BioRobot® EZ1 DNA purification of Evidence Samples 
 
Date: 01/01/2007   Revision Date:   04/01/2008  Approved by: SAM  
 
 
REAGENTS: 
 
BioRobot® EZ1 DNA Investigator reagent cartridges.  The cartridges contain all reagents required for the 
DNA extraction and purification of samples on the BioRobot® EZ1.  The reagents in the cartridges 
includes guanidine thiocyanate/guanidine hydrochloride, the paramagnetic silica coated beads, ethanol, TE 
buffer, and sterile water. 
 
MATERIALS/EQUIPMENT: 
 
1. EZ1 DNA Investigator kit (QIAGEN Catalogue #952034) 
  
2. BioRobot® EZ1 
 
PROCEDURE: 
 
1. Remove the substrate (if applicable), and transfer the liquid digest to the EZ1 sample tubes provided in 

the EZ1 DNA Investigator kit. 
 
Optional:  The addition of RNA may improve the DNA yields of samples that contain low amounts of 
DNA.  Analysts may add 1ug of RNA to the sample lysates prior to EZ1 purification of the samples. 
 

a) Add 310uL of TE buffer to the supplied tube of carrier RNA (310ug) to obtain a solution of 
1ug/uL. 

b) Dissolve the carrier RNA thoroughly.  Add 1uL of the carrier RNA to your sample lysates.  
Continue following the protocol at step 2. 

 
Note:  The dissolved carrier RNA should be stored at -20oC when not being used.  

 
The following steps deal with the set-up and operation of the BioRobot® EZ1. 
 
2. Insert the DNA Investigator v1.0 protocol card into the card slot on the BioRobot® EZ1 and turn the 

instrument on. 
 

3. Press “START” to display the protocols menu, then select the desired protocol.  The Large Volume 
protocol should be selected if evidence samples are being extracted.   

 
4. Select the desired eluent (TE or water).    
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5. Select the desired elution volume; 50uL is recommended for most evidence samples; 200uL is 
recommended for samples with very high expected DNA yields (such as non-sperm fractions from 
vaginal swabs, etc).  Note that the elution volume will be the same for all samples on the same 
BioRobot® EZ1. 

 
6. Press any key to proceed through the text displayed in the LCD.  The text in the LCD prompts the 

loading of the BioRobot® EZ1. 
 
The following steps deal with the loading of samples and reagents into the BioRobot® EZ1. 
 
7. Invert the reagent cartridges (1-6 per extraction run per instrument) to mix, and then tap the 

cartridges to deposit the reagents to the bottom of their wells. Insert the appropriate number of 
reagent cartridges in the cartridge rack.  Additional samples can be accommodated in additional 
instruments or in subsequent instrument runs. 

 
8. Load the cartridge rack (with cartridges) into the BioRobot® EZ1.  Ensure that the reagent cartridges 

are seated properly. 
 
9. Load 1-6 tip holders containing the filter-tips into row 2 of the tip rack. 
 
10. Load 1-6 opened sample tubes (from Step 3.) into row 4 of the tip rack. 
 
11. Load 1-6 uncapped appropriately labeled elution tubes into row 1 of the tip rack.  Check to ensure that 

the elution tubes are in the order corresponding to the sample tube order so that no sample mix-ups 
occur. Close the workstation door. 

 
12. Press “START” to start the extraction protocol. 
 
13. When the protocol ends, the LCD displays “FINISHED”.  If you intend to run another extraction 

protocol, press “ESC” to return to the “Protocols” menu.  Otherwise, press “STOP” twice to return 
the motors to the home positions. 

 
14. Open the workstation door.  Remove and cap the elution tubes containing your purified DNA. 
 
The BioRobot® EZ1 can be cleaned by rinsing the tube rack, tip rack, and cartridge rack, briefly, in a 
solution of 5% Bleach.  The UV cross linker may be used to decontaminate the BioRobot® EZ1 
components.  The BioRobot® EZ1 components may also be cleaned using a diluted neutral soap followed 
by water. 
 
Unless another extraction protocol is being performed the BioRobot® EZ1 may be switched “OFF”. 
 
REFERENCES: 
1. BioRobot® EZ1 Genomic DNA Kit Handbook.  Qiagen February 2003 
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2. Magtration® System 6GC Operation Manual Version 1.1.  Precision System Science Co. 2002. 
3. Montpetit SA, Fitch IT, O’Donnell PT. A simple automated instrument for DNA extraction in 

forensic casework, J Forensic Sci. 2005 May;50(3):555-63. 
 

4. Kishor R, et al.  Optimization of DNA extraction from low yield and degraded samples using the 
BioRobot EZ1 and BioRobot M48.  J Forensic Sci.  2006 Vol. 51(5): 1055. 
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Method:  DNA Extraction from Reference Samples Using the BioRobot® EZ1 
 
Date: 06/02/2003  Revised:  04/01/2008  Approved by: SAM 
 
 
REAGENTS: 
 
1. DIGEST BUFFER (10mM Tris-HCL, 10mM EDTA, 50mM NaCl, 2% SDS) 
 

Mix together 1mL of Tris-HCL, pH = 7.5, 2mL of 0.5M EDTA, 1mL of 5M NaCl, 10mL of 20% SDS 
(w/v) and 86mL of nanopure water.  Autoclave and store at room temperature.  The solution is good 
for one year. 

  
2. 10mg/mL PROTEINASE K 
 

Dissolve 100mg of proteinase K in 10mL of autoclaved nanopure water.  Store at -20oC in 200uL 
aliquots.  The aliquots are good for one year. 

 
3. BioRobot EZ1 DNA Investigator reagent cartridges.   
 

The cartridges contain all reagents required for the DNA extraction and purification of samples on the 
BioRobot EZ1.  The reagent in the cartridges included guanidine thiocyanate/guanidine hydrochloride, 
the paramagnetic silica coated beads, ethanol, TE buffer, and sterile water. 

 
MATERIALS/EQUIPMENT: 
 
1. EZ1 DNA Investigator kit (QIAGEN Catalogue #952034) 
 2. BioRobot® EZ1  
 
PROCEDURE: 
 
1. To a sterile 1.5mL tube (an EZ1 sample tube is uded if the Tip-Dance protocol is used – see step 5) 

add 190uL of digest buffer, 10uL of 10mg/mL proteinase K and the appropriate amount of the 
reference sample (bloodstain/liquid blood/reference mouth swab). 

 
2. Mix gently and incubate at 560C for at least 30 minutes.  During the incubation, the robot may be set-

up for extraction. 
 
3. Remove the substrate (if applicable), and transfer the liquid digest to the EZ1 sample tubes provided in 

the EZ1 DNA Extraction kit. 
 
The following steps deal with the set-up and operation of the BioRobot® EZ1. 
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4. Insert the DNA Investigator v1.0 protocol card into the card slot on the BioRobot® EZ1 and turn the 
instrument on. 

 
5. Press “START” to display the protocols menu then select the “Trace”, “Trace TD”, or “Normalization” 

protocol.  The Normalization protocol will limit the DNA yield of the samples by employing a limited 
amount of paramagnetic beads in the extraction.  In the Trace TD protocol the protocol uses a Tip-
Dance technique that can accommodate the purification of a sample with up to a maximum of ¼ swab 
in the tube.  If this option is selected the substrate, if it is less than or equal to ¼ swab, need not be 
removed prior to purification on the EZ1. 

 
6. Select the desired eluent (TE or water).    
 
7. Select the desired elution volume; 200uL is recommended for most reference sample extractions. 
 
8. Press any key to proceed through the text displayed in the LCD.  The text in the LCD prompts the 

loading of the BioRobot® EZ1. 
 
The following steps deal with the loading of samples and reagents into the BioRobot® EZ1. 
 
9. Invert the reagent cartridges (1-6 per extraction run per instrument) for your extraction to mix, then 

tap the cartridges to deposit the reagents to the bottom of their wells.  Insert the appropriate number 
of reagent cartridges in the cartridge rack.  Additional samples can be accommodated in additional 
instruments or in subsequent instrument runs. 

 
10. Load the cartridge rack (with cartridges) into the BioRobot® EZ1.  Ensure that the reagent cartridges 

are seated properly in the cartridge rack. 
 
11. Load 1-6 tip holders containing the filter-tips into row 2 of the tip rack. 
 
12. Load 1-6 opened sample tubes (from Step 3.) into row 4 of the tip rack. 
 
13. Load 1-6 uncapped appropriately labeled elution tubes into row 1 of the tube rack.  Check to ensure 

that the elution tubes are in the order corresponding to the sample tube order so that no sample mix-
ups occur.  Close the workstation door. 

 
14. Press “START” to start the extraction protocol. 
 
15. When the protocol ends, the LCD displays “FINISHED”.  If you intend to run another extraction 

protocol, press “ESC” to return to the “Protocols” menu.  Otherwise, press “STOP” twice to return 
the motors to the home positions. 

 
16. Open the workstation door.  Remove and cap the elution tubes containing your purified DNA. 
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The BioRobot® EZ1 can be cleaned by rinsing the tube rack, tip rack, and cartridge rack, briefly, in a 
solution of 5% Bleach.  The UV cross linker may be used to decontaminate the BioRobot® EZ1 
components.  The BioRobot® EZ1 components may also be cleaned using a diluted neutral soap followed 
by water. 
 
Unless another extraction protocol is being performed the BioRobot® EZ1 may be switched “OFF”. 
 
REFERENCES: 
1. BioRobot® EZ1 Genomic DNA Kit Handbook.  Qiagen February 2003 
2. Magtration® System 6GC Operation Manual Version 1.1.  Precision System Science Co. 2002. 
3. Montpetit SA, Fitch IT, O’Donnell PT. A simple automated instrument for DNA extraction in forensic 

casework, J Forensic Sci. 2005 May;50(3):555-63. 
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Method:   QuantifilerTM Setup Using the Qiagen BioRobot® Universal 
 
Date: 10/07/2005    Revision Date:   06/18/2008  Approved by: SAM  
 
 
REAGENTS: 
 
1. TE Buffer(10mM Tris-HCI, 0.1mM EDTA, pH 8.0):   
 

Mix together 10mL of 1M Tris-HCl, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure 
water.  Aliquot into bottles, autoclave and store at room temperature.  This solution is good for nine 
months. 

  
2. Quantifiler Human (or Duo) DNA Quantification Kit: Applied Biosystems (P/N 4343895 or 4387746 

(Duo))  
 

A.  Quantifiler Human (or Duo) Primer Mix 

B.  Quanti f i ler  (or Duo) PCR Reaction Mix 

  C.  Quanti f i ler Human DNA Standard 
 
The Reaction Mix should be removed from the kit upon receipt and stored at 2 to 8oC.  The remaining 
components of the kit should be stored at -15 to -25oC.  The primer sets contain a light sensitive dye, and 
should be stored protected from light.  The expiration date is printed on the kit. 

 
MATERIALS:  
 
1. 96- Well Optical Reaction Plates Applied Biosystems (P/N N801-0560) 
2. Optical Adhesive Covers Applied Biosystems (P/N 4311971) 
3. MicroAmp Splash free Support Base Applied Biosystems (P/N 4312063) 
 
EQUIPMENT: 
 
1. Qiagen Universal BioRobot Universal Liquid Handler Qiagen Corporation 
2. ABI Prism 7000/7500 Sequence Detection System Applied Biosystems 
 
PROCEDURE: 
 
1. This protocol is to setup the 96-well optical plate for qPCR DNA quantitation using QuantifilerTM 

(Human or Duo) quantitation kits.  The protocol provides the option to create the DNA standard 
dilution series manually or have the BioRobot Universal perform the dilution.  If the analyst opts to 
create the DNA standard dilution series manually, the dilutions should be made in 0.2mL tubes using 
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the minimum volume guidelines in Table 3-1 of the Quantifiler User’s Manual.   
 
2. Important notes to remember for using the BioRobot Universal for setup: 

a. Sarstedt screw-cap tubes are required for use on the instrument as they fit securely in the cooling 
blocks.  Caps should be removed after tubes are placed in the cooling blocks and replaced prior 
to removing tubes from the cooling block. 

b. If the Universal BioRobot Universal is to prepare the dilution series of the DNA standard it is 
important that the initial 50ng/uL standard be thoroughly mixed prior to placing it on the deck. 

 
3. Thaw the appropriate Quantifiler Primer Mix and concentrated DNA standard (which is stored at -

20oC).  Vortex the Primer Mix and the refrigerated qPCR Reaction Mix for 5 seconds.  Spin the Primer 
Mix and DNA standard tubes briefly in a microcentrifuge to remove any liquid from the caps. 

 
4. Prepare a four-fold (1:3) dilution of the 200ng/uL human DNA standard in TE buffer to obtain the 

initial 50ng/uL standard (see Table 3-1 in the Quantifiler User’s Manual for additional details if 
preparing the standards manually).  

 
5. Determine the total number of samples to be amplified including the set of eight human DNA standards 

(run in duplicate) and one qPCR blank.  Create a master mix by combining the following volumes of 
reagents into a screw-cap tube: 
 

a. 10.5ul of Primer Mix    x   # of Samples  
b. 12.5ul of qPCR Reaction Mix  x   # of Samples  

 
Note:  Additional master mix (~10%) should be created to allow for pipeting error. 

 
6. Open the Universal 8000 Quant Setup in the SDPD Worksheet maker v2.2 (found on the FB 

network H:\Worksheets).  
 

a. The default spreadsheet shows the locations for the DNA standards (50 0.023ng/uL). 
 

b. Fill out the “Sample Name” column with a list of the sample names.  Note:  Delete any unused 
rows below your samples (Highlight then Edit>Delete). 
 

c. The Setup Spreadsheet should be saved as a *.csv file type.  This is accomplished by using the 
“Save as…” command from the File menu.  The .csv file must be saved in the ImportData 
folder on the Qiagenuniversal hard drive.  (Note: *.csv file names should begin with the 
analysts’ initials followed by case # (e.g. initials(XX-XXXXXX).csv). 
 

d. When finished, the qPCR worksheet should be printed for your case notes.   
 

e. Exit the SDPD Worksheet maker v2.2. 
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7. Open QiaSoftTM v.5 software (on the desktop).  Log in as  “sdpd” and leave the password blank. 
 
a. Under “applications” select “Forensic” in the drop-down menu (▼) and then select 

”Quantifiler Reaction Setup”. 
b. Click “Run” button (►).  Follow the prompts from the protocol for preliminary setup. 
c. Enter the number of samples (excluding DNA Standards). 
d. Enter the appropriate .csv file name. 
e. Check the .csv table to ensure correct setup sheet was selected. 
f. The System Liquid bottle should be filled above the minimum.  The protocol will not continue 

if liquid level is below minimum. 
g. Enter whether the robot will be creating the DNA standard dilution (Yes/No). 
h. Empty tip waste (if necessary). 
i. Refill the tip racks (if necessary).  If tips run out the instrument will prompt you to refill later. 
j. Place the 96-well optical plate on a splash-free support base in the appropriate location on the 

deck making sure to tape the sides of the plate to the base. 
k. Place your DNA samples in the appropriate order (according to the setup sheet filled in 

earlier).  You may use your printed copy to ensure the sample positions are correct. 
Note:  The samples are to be placed in the cooling blocks in a left to right direction, filling each column 
completely before the next.  No tube or an empty tube should be placed in the position for the qPCR blank. 

l. If the Universal BioRobot Universal is to be used to create the dilution series, then eight 0.2mL 
tubes are required.  They should be setup as indicated by the default DNA standard locations.  
The 50ng/uL DNA standard tube should contain 40uL and the remaining tubes should be 
empty.  If the dilutions were manually created then the dilution tubes can be placed in their 
appropriate locations (each tube should contain at least 20uL of liquid). 

m. Place the Quantifiler Master Mix and TE Buffer (if the instrument is preparing the DNA 
Standard serial dilution) in the appropriate places on the deck.  Note: if more than 48 samples 
are being quantified then the master mix will need to be split into two tubes (follow the 
prompts from the instrument). 

 
8. The BioRobot Universal will now dilute the DNA standard (if selected), add master mix to the 96-well 

optical plate, and then add 2uL of the samples to the master mix. 
 
9. When the protocol has finished, the tubes can be re-capped and removed, and the 96-well optical plate 

can be covered with an optical adhesive cover and carried to the amplification room for loading into 
the ABI 7000/7500 SDS. 

 
10. The qPCR analysis can be continued by following the “Quantitative PCR DNA with the QuantifilerTM 

Human DNA Quantification Kit” or Quantitative PCR with the Quantifiler® Duo DNA Quantification 
Kit protocol at step 9. 

 
References: 
1. BioRobot 8000 Users manual.  Qiagen Corporation. 
2. QiaSoft 5 Software System Users Guide.  Qiagen Corporation. 
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Method: Quantitative PCR with the QuantifilerTM Human DNA Quantification Kit 
 
Date:  08/12/2005   Revision Date:   06/18/2008  Approved by: SAM 
 
 
REAGENTS: 
 
1. TE Buffer (10mM Tris-HCI, 0.1 mM EDTA, pH 8.0) 
 

Mix together 10mL of 1M Tris-HCl, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure 
water.  Aliquot into bottles, autoclave and store at room temperature.  This solution is good for one 
year. 

 
2. Quantifiler Human DNA Quantification Kit: Applied Biosystems (P/N 4343895) 
 

A. Quantifiler Human Primer Mix 
B. Quantifiler PCR Reaction Mix 
C. Quantifiler Human DNA Standard 

 
The Reaction Mix should be removed from the kit upon receipt and stored at 2 to 8°C. The remaining 
components of the kit should be stored at -15 to -25°C. The primer sets contain a light sensitive dye, and 
should be stored protected from light. The expiration date is printed on the kit. 
 
MATERIALS: 
 
1. 96- Well Optical Reaction Plates Applied Biosystems (P/N N801-0560) 
 
2. Optical Adhesive Covers Applied Biosystems (P/N 4311971) 
 
3. MicroAmp Splash free Support Base Applied Biosystems (P/N 4312063) 
 
 
EQUIPMENT: 
 
ABI Prism 7500 Sequence Detection System Applied Biosystems 
 
PROCEDURE: 
 
1. Thaw the Quantifiler Primer Mix and concentrated DNA standard (stored at -20C). Vortex the 

Quantifiler Primer Mix and the refrigerated Quantifiler PCR Reaction Mix for 5 seconds. Spin the 
Primer Mix and DNA standard tubes briefly in a microcentrifuge to remove any liquid from the caps. 

 
2. Prepare a three-fold (1:2) dilution series with eight concentration points, ranging from 50ng/uL to 
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0.023ng/uL, by diluting the 200ng/uL human DNA standard in TE buffer. To obtain the initial 
50ng/uL standard a 1:3 dilution is required.  (See Table 3-1 in the Quantifiler User's Manual for 
additional details) 

 
3. Determine the total number of samples to be amplified including the set of eight human DNA standards 

(run in duplicate) and one qPCR blank. Create a master mix by combining the following volumes of 
reagents into a 1.5ml microcentrifuge tube: 

 
 10.5ul of Quantifiler Primer Mix   x  # of Samples 
 12.5ul of Quantifiler PCR Reaction Mix  x  # of Samples 
 

Note: Additional master mix (~10%) should be created to allow for pipetting error. 
 
4. Vortex the master mix at medium speed for 5 seconds and spin the tube briefly in a microcentrifuge to 

remove any liquid from the cap. 
 
5. With the 96-well optical reaction plate in a support base dispense 23uL of the master mix into each 

sample well. 
 
6. Add 2uL of sample, standard, or control to the appropriate wells. 
 
7. Carefully seal the reaction plate with the optical adhesive cover. Use the applicator to ensure the cover 

forms a smooth airtight seal over the entire 96-well surface. 
 
8. Transport the reaction plate to the ABI 7500 SDS in the amplification area. 
 
9. Turn on the computer (if necessary) and then the SDS instrument. 
 
10. Push the plate door in and slide it out  until it provides room to insert the plate. 
 
11. Position the plate in the thermal block so that well Al is in the upper left corner and the notched corner 

is in the upper right corner. 
 
12. Gently close the door to by sliding it backward into position.   

 
13. Launch the 7500 SDS Software and set up a plate document (File> New)  either by using a blank 

document or opening a plate document template. The plate document shows the location of 
samples/standards on the reaction plate.  If a sample import file (.txt) has been created it can be 
imported by selecting File>Import Sample Setup and browsing for the appropriate file.  If the 
sample setup was imported then skip to step 18. 

 
14. If required, add detectors to the plate document. If the detectors for the Quantifiler kit have been 

created, they will be listed in the Detector Manager: Tools>Detector Manager. Highlight the 
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Quantifiler Human and IPC detectors in order to make them available to the plate. Click "Add to Plate 
Document". 

 
15. Highlight the entire plate document, then from the Well Inspector (View>Well Inspector) add the 

detectors (Quantifiler Human and IPC) to all the wells of the plate document. 
 
16. Add sample information for each well by double clicking on it (or highlight and View>Well 

Inspector). The Well Inspector box will appear. Add the sample name. If clicking on a well where a 
quantitation standard is located two changes need to be made to the Quantifiler Human detector. 
Change task from "unknown" to "standard" and add the concentration of the standard to the 
"Quantity" column. 

 
17. When finished filling out the plate document save it as a SDS document (*.sds). 
 
18. Select the Instrument tab and review the Quantifiler amplification profile which should consist of: 
 

Initial incubation at 95°C for 10 minutes. 
  40 cycles of the following profile:  

95°C for 15 seconds  
60°C for 1 minute 

 
If need be, delete the initial 50°C incubation step and change the reaction volume to 25uL. If any 
changes were made save the file and click "Start" or simply click on “Start”. 

 
19. Following completion of the run the plate document can be analyzed. Verify the analysis settings 

(Analysis>Analysis Settings) which should be: 
 

Detector: All 
Threshold: .200000 
Baseline Start (cycle): 6 
Baseline End (cycle): 15 

 
20. Once you have verified the settings are correct, analyze your data. Analysis>Analyze 
 
21. Interpret results by examining the standard curve and the IPCs, which are all accessible from the 

Results tab. Quantitation values for the unknowns are available from the Plate tab. 
 
22. Turn the 7500 SDS instrument off.  
 
INTERPRETATION 
 
The following information can be used to assist in the interpretation of the Quantifiler results: 
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Quality of the standard curve: 
In general, the slope of the standard curve for the Quantifiler Human kit should be between -2.9 and -3.3 
with a Y-intercept value of 28.7-29.8. 
 
If the 50ng/uL standard is prepared appropriately the expected Ct value is approximately 23.1-24.1.  The 
Ct values between the subsequent points on the standard curve should be approximately 1.6 cycles, with 
the Ct value for the 0.023ng/uL expected to be approximately 33.1-35.5.  Some variation in these data 
points is expected. 
 
The r2 value of your slope should be above 0.98 and approach 1.0.  The r2 value is an indication of how well 
the points on the standard curve fit the trendline through the points. 
 
The above information should serve to provide some guidance as to the expectations of the values for the 
standard curve.  In general, if the values obtained for the standard curve are within the expected range, the 
amount of DNA to be amplified should be in the range of the validated target, with case or sample specific 
exceptions possible.  If the values obtained from the standard curve are outside the values listed above, it is 
an indication that there may be problems relying on the quantitation information obtained, and that your 
input amount of DNA for amplification may need to be adjusted from the validated target.  Quantitation 
assays yielding slope, intercept, and Ct values outside of those expected may require a new quantitation 
assay to yield more reliable information.  Repeating of analyses is at the discretion of the analyst. 
 
Based on internal validation of the Quantifiler Human kit, the ideal target amount of DNA in approximately 
1.8ng for the Identifiler amplification kit, 0.3ng of DNA for the Minifiler amplification kit, and 0.75ng of 
DNA for the Yfiler amplification kit. 
 
Assessment of sample quality: 
If a sample has a high human Ct value and a normal IPC Ct value (~28) the sample has a low amount of 
DNA. 
 
If a sample has a low human Ct value and a normal or slightly high IPC Ct value the sample has a high 
amount of DNA.  If the sample has a high amount of human DNA it will often out compete the IPC for 
amplification components thus decreasing its amplification efficiency. 
 
If a sample has a high human Ct value and a high IPC Ct value the sample is likely inhibited.  Appropriate 
troubleshooting measures should be employed with the sample to overcome the potential inhibitors. 
 
REFERENCE: 
QuantifilerTM Human DNA Quantification Kit User's Manual 
  

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 69 of 185 

 
 

Method: Quantitative PCR with the Quantifiler® Duo DNA Quantification Kit 
 
Date:  6/16/08   Revision Date:   03/01/2010  Approved by: SAM 
 
 
REAGENTS: 
 
3. TE Buffer (10mM Tris-HCI, 0.1 mM EDTA, pH 8.0) 
 

Mix together 10mL of 1M Tris-HCl, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure 
water.  Aliquot into 100mL or 250mL bottles, autoclave and store at room temperature.  This solution 
is good for twelve months. 

 
4. Quantifiler Duo DNA Quantification Kit: Applied Biosystems (P/N 4387746) 
 

D. Quantifiler Duo Primer Mix 
E. Quantifiler Duo PCR Reaction Mix 
F. Quantifiler Duo DNA Standard 

 
The Reaction Mix should be removed from the kit upon receipt and stored at 2 to 8°C.  The remaining 
components of the kit should be stored at -15 to -25°C.  The primer sets contain a light sensitive dye, and 
should be stored protected from light.  The expiration date is printed on the kit. 
 
MATERIALS: 
 
4. 96- Well Optical Reaction Plates Applied Biosystems (P/N N801-0560) 
 
5. Optical Adhesive Covers Applied Biosystems (P/N 4311971) 
 
6. MicroAmp Splash free Support Base Applied Biosystems (P/N 4312063) 
 
EQUIPMENT: 
 
ABI Prism 7500 Sequence Detection System Applied Biosystems 
 
PROCEDURE: 
 
1. Thaw the Quantifiler Duo Primer Mix and concentrated DNA standard (stored at -20C).  Vortex the 

Quantifiler Duo Primer Mix and the refrigerated Quantifiler Duo PCR Reaction Mix for 5 seconds.  
Spin the Primer Mix and DNA standard tubes briefly in a microcentrifuge to remove any liquid from 
the caps. 

 
2. Prepare a three-fold (1:2) dilution series with eight concentration points, ranging from 50ng/uL to 
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0.023ng/uL, by diluting the 200ng/uL human DNA standard in TE buffer.  To obtain the initial 
50ng/uL standard a 1:3 dilution is required.  (See Table 3-1 in the Quantifiler Duo User's Manual for 
additional details). 

 
3. Determine the total number of samples to be amplified including the set of eight human DNA standards 

(run in duplicate) and one qPCR blank.  Create a master mix by combining the following volumes of 
reagents into a 1.5ml microcentrifuge tube: 

 
 10.5ul of Quantifiler Duo Primer Mix    x  # of Samples 
 12.5ul of Quantifiler Duo PCR Reaction Mix  x  # of Samples 
 

Note: Additional master mix (~10%) should be created to allow for pipetting error. 
 
4. Vortex the master mix at medium speed for 5 seconds and spin the tube briefly in a microcentrifuge to 

remove any liquid from the cap. 
 
5. With the 96-well optical reaction plate in a support base dispense 23uL of the master mix into each 

sample well. 
 
6. Add 2uL of sample, standard, or control to the appropriate wells. 
 
7. Carefully seal the reaction plate with the optical adhesive cover.  Use the applicator to ensure the cover 

forms a smooth airtight seal over the entire 96-well surface. 
 
8. Transport the reaction plate to the amplification area. 
 
9. Turn on the computer (if necessary) and then the 7500 SDS instrument. 
 
10. Press the tray door on the SDS instrument to open it. 

 
11. Position the reaction plate in the plate holder so that well Al is in the upper left corner and the notched 

corner is in the upper right corner and close the tray door. 
 
12. Launch the 7500 SDS Software and set up a plate document (File> New) either by using a blank 

document or opening a plate document template.  The plate document shows the location of 
samples/standards on the reaction plate.  If a sample import file (.txt) has been created it can be 
imported by selecting File>Import Sample Setup and browsing for the appropriate file.  If the 
sample setup was imported then skip to step 18. 

 
13. If required, add detectors to the plate document.  If the detectors for the Quantifiler kit have been 

created, they will be listed in the Detector Manager: Tools>Detector Manager.  Highlight the Dual 
Quant Human, Dual Quant Y and Dual Quant IPC detectors in order to make them available to the 
plate.  Click "Add to Plate Document". 
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14. Highlight the entire plate document, then from the Well Inspector (View>Well Inspector) add the 

detectors (Human, Y and IPC) to all the wells of the plate document. 
 
15. Add sample information for each well by double clicking on it (or highlight and View>Well 

Inspector).  The Well Inspector box will appear.  Add the sample name.  If clicking on a well where a 
quantitation standard is located, two changes need to be made to the Dual Quant Human and Dual 
Quant Y detectors.  Change task from "unknown" to "standard" and add the concentration of the 
standard to the "Quantity" column. 

 
16. Select the Instrument tab and review the Quantifiler Duo amplification profile which should consist of: 
 

Incubation at 50°C for 2 minutes 
Incubation at 95°C for 10 minutes 

  40 cycles of the following profile:  
95°C for 15 seconds  
60°C for 1 minute 

 
Change the sample volume to 25uL and ensure that the 9600 emulation box is checked.   
 

17. When finished filling out the plate document save it as a SDS document (*.sds) and click “Start” to start 
the run. 

 
18. Following completion of the run the plate document can be analyzed.  Verify the analysis settings 

(Analysis>Analysis Settings) which should be: 
 

Detector: All 
Threshold: .200000 
Baseline Start (cycle): 3 
Baseline End (cycle): 15 

 
19. Once you have verified the settings are correct, analyze your data.  Analysis>Analyze. 
 
20. Interpret results by examining the standard curves and the IPCs, which are all accessible from the 

Results tab.  Quantitation values for the unknowns are available from the Plate tab. 
 
21. Turn the 7500 SDS instrument off.  
 
INTERPRETATION: 
 
The following information can be used to assist in the interpretation of the Quantifiler Duo results: 
 
Quality of the standard curve: 
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In general, the slope of the standard curve for the Quantifiler Duo kit should be between -3.0 and -3.6 with 
a Y-intercept value between 29 and 30 for the human curve and 30 and 30.8 for the Y curve.   
 
If the 50ng/uL standard is prepared appropriately the expected Ct value is approximately 23.2-24.2 for the 
human curve and 24.1-25.0 for the Y curve.  The Ct values between the subsequent points on the standard 
curve should be approximately 1.6 cycles, with the Ct value for the 0.023ng/uL expected to be 
approximately 34.2-35.4 for the human curve and 34.8-37.1 for the Y curve.  Some variation in these data 
points is expected. 
 
The r2 value of your slope should be above 0.98 and approach 1.0.  The r2 value is an indication of how well 
the points on the standard curve fit the trendline through the points. 
 
The above information should serve to provide some guidance as to the expectations of the values for the 
standard curve.  In general, if the values obtained for the standard curve are within the expected range, the 
amount of DNA to be amplified should be in the range of the validated target, with case or sample specific 
exceptions possible.  If the values obtained from the standard curve are outside the values listed above, it is 
an indication that there may be problems relying on the quantitation information obtained, and that the 
input amount of DNA for amplification may need to be adjusted from the validated target.  Quantitation 
assays yielding slope, intercept, and Ct values outside of those expected may require a new quantitation 
assay to yield more reliable information.  Repeating of analyses is at the discretion of the analyst. 
 
Based on internal validation of the Quantifiler Duo kit, the ideal target amount of DNA in approximately 
1.0ng for the Identifiler amplification kit, 0.3-0.4ng of DNA for the Minifiler amplification kit, and 0.5-
0.75ng of DNA for the Yfiler amplification kit. 
 
Assessment of sample quality: 
If a sample has a high human Ct value and a normal IPC Ct value (~28) the sample has a low amount of 
DNA. 
 
If a sample has a low human Ct value and a normal or slightly high IPC Ct value the sample has a high 
amount of DNA.  If the sample has a high amount of human DNA it will often out compete the IPC for 
amplification components thus decreasing its amplification efficiency. 
 
If a sample has a high human Ct value and a high IPC Ct value the sample is likely inhibited.  Appropriate 
troubleshooting measures should be employed with the sample to overcome the potential inhibitors. 
 
The relative amount of male and female DNA in a mixture can be determined by dividing the total human 
DNA quantitation by the male DNA quantitation and subtracting one.  As an example, if the total DNA 
quantitation is four times the male DNA quantitation, there is approximately three times as much female 
DNA as male DNA. 
 
REFERENCE: 
Quantifiler® Duo DNA Quantification Kit User's Manual 
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Method:   Concentrating DNA Extracts with Microcon YM-100 Filters 
 
Date: 04/01/2011         Approved by: SAM  
 
 
REAGENTS: 
 
TE BUFFER (10mM Tris-HCL, 0.1M EDTA pH= 8.0) 
 
Mix together 10mL of 1M Tris-HCL, pH= 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure water.  
Aliquot into 100mL bottles, autoclave and store at room temperature.  The solution is good for nine 
months. 
 
MATERIALS: 
 
1. Microcon-YM 100 Centrifugal Filter Devices (Amicon) 
 
2. Microcentrifuge (capable of at 1,000 x g) 
 
PROCEDURE: 
 
Note:  The capacity of the Microcon-YM100 reservoir is approximately 500uL.  If the purified extract has a 
larger volume it may require adding any remaining amount of sample that did not fit into the reservoir after 
the first spin.  This protocol may also be used to further concentrate previously purified samples. 
 
1. Assemble the Microcon-YM100 unit by inserting the sample reservoir into the filtrate vial. 
 
2. Add approximately 50uL of TE buffer to the upper Microcon-YM100 reservoir. 
 
3. Add the appropriate amount of extracted DNA sample to be concentrated on top of the TE buffer.  Seal 

with the attached cap. 
 
4. Centrifuge the assembled Microcon spin-column in a microcentrifuge for 12-15 minutes at 2300rpm 

(~500 x g).  The DNA sample will be concentrated in about 5-15uL of TE buffer in the bottom of the 
upper Microcon-100 reservoir (molecules with molecular weights of less than 100,000 Daltons will 
pass through the filter). Check the microcon assembly periodically during the spin to ensure that the 
filter has not dried out.   
 
Important: Spinning the filter to dryness can cause irreversible binding of the DNA to the membrane. 

 
5. Discard the effluent in the filtrate vial. Place the Microcon spin-column right-side up into a new into 

filtrate vial. 
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8. Add 3-6uL of TE buffer to the Microcon-100 column (depending on desired final volume).  Gently 
vortex the filter assembly. 

 
9. Collect the DNA sample by inverting the reservoir into a new microcon tube and centrifuge at 

approximately 3200 rpm (approximately 1000 x g) for 3-5 minutes. 
 
10. The concentrated purified DNA now resides in the tube.  The volume can be further adjusted as 

necessary to achieve the desired concentration.  Cap the tube and store frozen.  Alternatively, transfer 
the purified DNA to a different tube, such as a sterile screw-cap tube for storage. 

 
REFERENCE: 
Microcon Centrifugal Filter Device User Guide, Revision J. Millipore 2000 
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Method:   Amplification with the AmpFlSTR IdentifilerTM Kit 
 
Date:  06/01/2004 Revis ion Date: 07/25/2007 Approved by: SAM 
   
 
Information for concentrating sample:  Validation studies at the SDPD DNA laboratory have demonstrated 
that concentrating the amount of EDTA in samples greater than 4-fold will result in a decrease in 
amplification efficiency. As such, analysts may choose to use water for the final wash during the 
Microcon/Centricon-100 concentration procedure or elute in water for BioRobot® EZ1 DNA 
purifications thus eliminating the TE from the sample.  Any additional concentration steps may be 
performed without concerns of altering the solute concentration.   
 
If DNA extracts are to be stored long-term they must be stored frozen.  
  
REAGENTS:  
 
1. TE Buffer (10mM Tris-HCI, 0.1 mM EDTA, pH 8.0) 
 

Mix together 10mL of 1M Tris-HCl, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure 
water.  Aliquot into 100mL bottles, autoclave and store at room temperature.  This solution is good for 
nine months. 

 
2. AmpFlSTR IdentifilerTM PCR Amplification Kits: Applied Biosystems (P/N 4322288) 
 

A.  AmpFlSTR PCR Reaction Mix 
B.  AmpF lSTR Identi f i lerT M Primer Set 
C.  AmpliTaq Gold™ DNA Polymerase 
D.  AmpF lSTR Control  DNA 9947A 

 
The AmpliTaq Gold™ DNA Polymerase enzyme should be removed from the kit upon receipt and stored 
at -15 to -25oC.  The remaining components of the kits  
should be stored at 2 to 8oC.  The primer sets contain a light sensitive dye, and  
should be stored protected from light.  The expiration date is printed on the kit. 
 
3. Bovine Serum Albumin (4.97 mg/mL) Fisher Scientific (P/N CAS 9048-46-8) 
 
MATERIALS:  
1. MicroAmp Autoclaved Reaction Tubes with Caps Applied Biosystems (P/N N801-0612) 
2. MicroAmp 9700 Tray Applied Biosystems (P/N N801-0541) 

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 76 of 185 

 
 

 
EQUIPMENT: 
GeneAmp PCR System 9700 Thermal Cyclers Applied Biosystems 
 
PROCEDURE: 
 
1. Fill out an AmpFlSTR IdentifilerTM Amplification Worksheet and determine the total number of 

samples to be amplified including the positive control (9947A), the negative amplification control, and 
all samples.   

 
2. Label a 0.2mL MicroAmp Reaction tube for each of the samples to be amplified. 
 
3. Vortex the AmpFlSTR PCR Reaction Mix, AmpFlSTR IdentifilerTM Primer Set, AmpliTaq Gold™ 

DNA Polymerase, and AmpFlSTR Control DNA 9947A for 5 seconds.  Spin the tubes briefly in a 
microcentrifuge to remove any liquid from the caps. 

 
4. Create a master mix by combining the following volumes of reagents into a 1.5mL microcentrifuge 

tube: 
 

a. 10.5uL of AmpFlSTR PCR Reaction Mix   x   # of Samples 
 

b. 0.5uL of AmpliTaq Gold DNA Polymerase   x  # of Samples 
 

c. 5.5uL of AmpFlSTR Identifiler Primer Set   x   # of Samples 
 
In an effort to reduce the effects of possible inhibitors present in the samples to be amplified, an additional 
1.1uL of AmpliTaq Gold DNA Polymerase and 0.9uL of 4.97mg/mL bovine serum albumin (BSA Fraction 
V) may be added to the samples of interest.  This may be accomplished by either adding the additional 
reagents to the individual reaction tubes or to the PCR Master Mix if all of the amplified samples are to have 
additional Taq and BSA added.  Additional Taq/BSA must also be added to the reagent blanks associated 
with the samples supplemented with Taq/BSA. 
 
The addition of extra BSA and AmpliTaq Polymerase is meant as a trouble shooting procedure.  It is not 
designed to be a routine alteration of the protocol.  The total reaction volume including the additional Taq 
and BSA should be 25uL. 

 
5. Vortex the master mix at medium speed for 5 seconds and spin the tube briefly in a microcentrifuge to 

remove any liquid from the cap. 
 
Note: Steps 6 - 8 are performed in a biological hood using dedicated pipettes. 

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 77 of 185 

 
 

 
6. Dispense 15uL of the master mix into each labeled 0.2mL reaction tube. 
 
7. If less than 10uL of sample is added for any sample, the difference should be made up by adding TE 

buffer.  
 
8. Add sample to the labeled 0.2mL reaction tubes as follows:   
 

For all evidence and reference samples, add approximately 1.8ng of target DNA in a volume equal to 
or less than 10uL.  Note: 1.8ng is a suggested target amount of DNA.  The actual amount added will 
depend on the nature of the sample and any additional information obtained from DNA quantitation.   

 
For reagent blanks add a volume that is equal to the greatest volume from any of the evidence samples 
associated with it. 

 
Add 5-10uL (0.1ng/uL) of AmpFlSTR Control DNA 9947A to the positive amplification control tube.  
If less than 10uL of Control DNA is added, the difference is made up by adding TE buffer. 

 
Add 10uL of TE buffer or water to the negative control tube. 

 
9. Transport the tubes to the Amplification Area.  Place a MicroAmp tray containing the PCR reaction 

tubes one of the thermal cyclers.  Use the capping tool to firmly close the caps on all PCR reaction 
tubes. 

 
10. Turn the thermal cycler on (if not already done). 
 
11. Select the program named Identifiler. 
 

a. Initial incubation at 95°C for 11 minutes. 
 

b. 28 cycles of the following profile:  
Denaturing at 94°C for 1 minute 

Annealing at 59°C for 1 minute 

Extending at 72°C for 1 minute 
 

c. Final extension at 60°C for 90 minutes 
d. Indefinite incubation at 25°C. 

 

The amplified products can be removed from the thermal cycler at any time after reaching 25°C.  
Amplified samples are stored in the freezer. 
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REFERENCES: 
AmpFlSTR IdentifilerTM PCR Amplification Kit User’s Manual 
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Method: Amplification with the AmpFlSTR® Identifiler Plus® kit 
 
Date:   10/19/2010 Approved By:  SAM 
 
 
If DNA extracts are to be stored long-term they must be stored frozen. 
 
REAGENTS: 
 
1. TE Buffer (10 mM Tris-HCl, 0.1 mM EDTA, pH 8.0) 

 
Mix together 10 mL of 1 M Tris-HCl, pH = 8.0 with 0.2 mL of 0.5 M EDTA and 990 mL nanopure 
water.  Aliquot into 100 mL bottles, autoclave and store at room temperature.  This solution is good 
for nine months. 
 

2. AmpFlSTR® Identifiler Plus® PCR Amplification Kits: Applied BioSystems  
 
A. AmpFlSTR® Identifiler Plus® Master Mix 
B. AmpFlSTR® Identifiler Plus® Primer Set 
C. AmpFlSTR® Control DNA 9947A 
 

Store all kit components at -15 to -25 oC upon receipt.  Store all components at 2 to 8 oC after initial use.  
The primers contain light-sensitive dyes, and should be stored protected from light.  The expiration date is 
printed on the kit. 
 
MATERIALS: 
 

1. MicroAmp Autoclaved  Reaction Tubes with Caps - Applied Biosystems (P/N N801-0612) 
 
2. MicroAmp 9700 Tray  - Applied Biosystems (P/N N801-0541) 

 
EQUIPMENT: 
GeneAmp PCR System 9700 Thermal Cyclers - Applied Biosystems 
 
PROCEDURE: 
 
1. Fill out an AmpFlSTR® Identifiler Plus® Amplification Worksheet and determine the total number of 

samples to be amplified including the positive control (9947A DNA), the negative amplification 
control, and all samples. 
 

2. Label a 0.2 mL MicroAmp Reaction Tube for each of the samples to be amplified. 
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3. Vortex the AmpFlSTR® Identifiler Plus® Master Mix, AmpFlSTR® Identifiler Plus® Primer Set, and 
AmpFlSTR® Control DNA 9947A.  Vortex the three tubes for 5 seconds and spin briefly in a 
microcentrifuge to remove any liquid from the caps.   
 

4. Create a master mix by combining the following volumes of reagents into a 1.5 mL microcentrifuge 
tube: 
 
a. 10 μL AmpFlSTR® Identifiler Plus® Master Mix x (# samples) + 10 % 
b.  5 μL AmpFlSTR® Identifiler Plus® Primer Set x (# samples) + 10 % 
 

5. Vortex the master mix for 5 seconds and then spin briefly in a microcentrifuge to remove any liquid 
from the cap.   

 
Note: Steps 6-8 must be performed in a biological hood using dedicated pipettes. 
 
6. Aliquot 15 μL of the master mix into each labeled 0.2 mL reaction tube. 

 
7. If less than 10 μl of sample is added for any sample, the difference should be made up by adding TE 

buffer for a final volume of 10 μl. 
 

8. Add sample to the labeled 0.2 mL reaction tubes as follows: 
 
For all evidence and reference samples, add approximately 1.5 to 2.0 ng of target DNA in a volume 
equal to or less than 10 μL.  Note: 1.5 to 2.0 ng is a suggested target amount.  The actual amount added 
will depend on the nature of the sample and any additional information obtained from DNA 
quantitation. 
 
For reagent blanks add a volume that is equal to the greatest volume from any of the evidence samples 
associated with it.   
 
Add 6-7 μL (0.1 ng/μL) of AmpFlSTR® Control DNA 9947A to the positive amplification control 
tube.  Add TE buffer to obtain a final volume of 10 μL.   
 
Add 10 μL of TE buffer or water to the negative control tube. 

 
9. Transport the tubes to the Amplification Room.  Place a MicroAmp tray containing the PCR reaction 

tubes into one of the thermal cyclers. Use the capping tool to firmly close the caps on all PCR reaction 
tubes.  

 
10. Turn the thermal cycler on (if not already done). 

 
11. Select the ID Plus x28 program. 
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a. Initial Incubation 
95 oC, 11 minutes 

 
b. 28 Cycles 

94 oC, 20 seconds 
59 oC, 3 minutes 

 
c. Final Extension 

60 oC, 10 minutes 
 

d. Final Hold 
4 oC, ∞ 

 
12. Remove the amplified products from the thermal cycler anytime after reaching 4 oC, then store in the 

freezer. 
 
REFERENCES: 
AmpFlSTR® Identifiler Plus® PCR Amplification Kit User’s Manual 
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Method: Amplification with the AmpFlSTR MiniFilerTM Kit 
 
Date:   07/25/2007 Approved By:  SAM 
 
 
INTRODUCTION: 
 
The AmpFlSTR MiniFilerTM PCR Amplification Kit is designed as an adjunct kit to the AmpFlSTR 
IdentifilerTM kit for genotyping challenged samples that are degraded and/or contain PCR inhibitors.  The 
key procedural differences between the systems are detailed below.  All procedures for the AmpFlSTR 
MiniFilerTM PCR Amplification Kit may also be found in the User Guide.   
 
REAGENTS: 
 
1. TE Buffer (10mM Tris-HCl, 0.1mM EDTA, pH 8.0) 

 
Mix together 10 mL of 1M Tris-HCl, pH= 8.0 with 0.2 mL of 0.5M EDTA and 990 mL nanopure 
water.  Aliquot into 100 mL bottles, autoclave and store at room temperature.  This solution is good 
for nine months. 
 

2. AmpFlSTR MiniFilerTM PCR Amplification Kits: Applied BioSystems  
A. AmpFlSTR MiniFilerTM Master Mix 
B. AmpFlSTR MiniFilerTM Primer Set 
C. AmpFlSTR Control DNA 007 

 
The master mix and primer set should be stored at -20oC upon receipt, and at 2 to 8oC after initial use.  The 
control DNA 007 should be stored at 2 to 8oC upon receipt and after initial use.  The expiration date is 
printed on the kit. 
 
MATERIALS: 

1. MicroAmp Autoclaved Reaction Tubes with Caps Applied Biosystems (P/N N801-0612) 
2. MicroAmp 9700 Tray Applied Biosystems (P/N N801-0541) 
3. 96-well Plate  Applied Biosystems 

 
EQUIPMENT: 
GeneAmp PCR System 9700 Thermal Cyclers Applied Biosystems 
 
PROCEDURE: 
 
1. Fill out an AmpFlSTR MiniFilerTM Amplification Worksheet and determine the total number of samples 

to be amplified including the positive control (007 DNA), the negative amplification control, and all 
samples. 
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2. Label a 0.2 mL MicroAmp Reaction Tube for each of the samples to be amplified. 
 

3. Vortex the AmpFlSTR MiniFilerTM Master Mix, AmpFlSTR MiniFilerTM Primer Set, and AmpFlSTR 
Control DNA 007.  Vortex the three tubes for 5 seconds and spin briefly in a microcentrifuge to 
remove any liquid from the caps.   
 

4. Create a master mix by combining the following volumes of reagents into a 1.5 mL microcentrifuge 
tube: 
 
a. 10 μL AmpFlSTR MiniFilerTM Master Mix  x (# samples) + 10% 
b.  5 μL AmpFlSTR MiniFilerTM Primer Set  x (# samples) + 10% 
 

5. Vortex the master mix for 5 seconds and then spin briefly in a microcentrifuge to remove any liquid 
from the cap.   

 
Note: Steps 6-8 must be performed in a biological hood using dedicated pipettes. 
 
6. Aliquot 15μL of the master mix into each labeled 0.2mL reaction tube. 

 
7. If less than 10 μl of sample is added for any sample, the difference should be made up by adding TE 

buffer for a final volume of 10 μl. 
 

8. Add sample to the labeled 0.2mL reaction tubes as follows: 
 
For all evidence and reference samples, add approximately 0.3ng of target DNA in a volume equal to or 
less than 10μL.  Note: 0.3ng is a suggested target amount.  The actual amount added will depend on the 
nature of the sample and any additional information obtained from DNA quantitation. 
 
For reagent blanks add a volume that is equal to the greatest volume from any of the evidence samples 
associated with it.   
 
Add 2-4μL (0.1ng/μL) of AmpFlSTR Control DNA 007 to the positive amplification control tube.  
Add TE buffer to obtain a final volume of 10 μL.   
 
Add 10μL of TE buffer or water to the negative control tube. 

 
9. Transport the tubes to the Amplification Room.  Place a MicroAmp tray containing the PCR reaction 

tubes onto a thermal cycler . 
 

10. Turn the thermal cycler on (if not already done). 
 

11. Select the MiniFiler program. 
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a. Initial Incubation 
95oC, 11 minutes 

 
b. 30 Cycles 

94oC, 20 seconds 
59oC, 2 minutes 
72oC, 1 minute 

 
c. Final Extension 

60oC, 45 minutes 
 

d. Final Hold 
4oC, ∞ 

 
12.  Remove the amplified products from the thermal cycler anytime after reaching 4oC, then store in the 

freezer. 
 
REFERENCE: 
AmpFlSTR MiniFilerTM PCR Amplification Kit User’s Manual 
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Method:   Amplification with the AmpFlSTR YfilerTM Kit 
 
Date:  07/25/2007      Approved by: SAM 
   
 
Amplification and analysis of Y-STR DNA markers using the AmpFlSTR YfilerTM STR kit is performed using 
similar procedures to those for AmpFlSTR IdentifilerTM STR analysis.  The key procedural differences 
between the systems are detailed here.     
 
REAGENTS:  
 
1. AmpFlSTR YfilerTM PCR Amplification Kits: Applied Biosystems (P/N 4359513) 

A.  AmpFlSTR YfilerTM PCR Reaction Mix 
B.  AmpF lSTR Yfi lerT M Primer Set 
C.  AmpliTaq Gold™ DNA Polymerase 
D.  AmpF lSTR Control  DNA 007 (do not use Control  DNA 9947A – female DNA) 

 
PROCEDURE: 
 
1. Fill out an AmpFlSTR YfilerTM Amplification Worksheet and determine the total number of samples to 

be amplified including the positive control (007), the negative amplification control, and all samples.   
 
2. Label a 0.2mL MicroAmp Reaction tube for each of the samples to be amplified. 
 
3. Vortex the AmpFlSTR YfilerTM PCR Reaction Mix, AmpFlSTR YfilerTM Primer Set, AmpliTaq Gold™ 

DNA Polymerase, and AmpFlSTR Control DNA 007 for 5 seconds.  Spin the tubes briefly in a 
microcentrifuge to remove any liquid from the caps. 

 
4. Create a master mix by combining the following volumes of reagents into a 1.5mL microcentrifuge 

tube: 
 

a. 9.2uL of AmpFlSTR YfilerTM PCR Reaction Mix   x   (# of samples +10%) 
 

b. 0.8uL of AmpliTaq Gold DNA Polymerase   x  (# of samples +10%) 
 

c. 5.0uL of AmpFlSTR Identifiler Primer Set   x   (# of samples +10%) 
 
5. Vortex the master mix at medium speed for 5 seconds and spin the tube briefly in a microcentrifuge to 

remove any liquid from the cap. 
 
Note: Steps 6 - 8 are performed in a biological hood using dedicated pipettes. 
 
6. Dispense 15uL of the master mix into each labeled 0.2mL reaction tube. 
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7. If less than 10uL of sample is added for any sample, the difference should be made up by adding TE 

buffer.  
 
8. Add sample to the labeled 0.2mL reaction tubes as follows:   
 

For all evidence and reference samples, add approximately 0.75ng of male target DNA in a volume 
equal to or less than 10uL.  Note: 0.75 ng is a suggested target amount of DNA.  The actual amount 
added will depend on the nature of the sample and any additional information obtained from 
quantitation (or estimation of the concentration) of male DNA in a sample.  

 
For reagent blanks add a volume that is equal to the greatest volume from any of the evidence samples 
associated with it. 

 
Add 5-10uL (0.1ng/uL) of AmpFlSTR Control DNA 007 to the positive amplification control tube.  If less than 
10uL of Control DNA is added, the difference is made up by adding TE buffer. 

 
Add 10uL of TE buffer to the negative control tube. 
 

9. Transport the tubes to the Amplification Area.  Place a MicroAmp tray containing the PCR reaction tubes into 
one of the thermal cyclers.  Use the capping tool to firmly close the caps on all PCR reaction tubes. 

 
10. Turn the thermal cycler on (if not already done). 
 
11. Select the program named Yfiler. 
 

a. Initial incubation at 95°C for 11 minutes. 
 

b. 30 cycles of the following profile:  
Denaturing at 94°C for 1 minute 
Annealing at 61°C for 1 minute 
Extending at 72°C for 1 minute 

 
c. Final extension at 60°C for 80 minutes 

 
d. Indefinite incubation at 4°C. 

 
The amplified products can be removed from the thermal cycler at any time after reaching 4°C.  Amplified 
samples are stored in the freezer. 
 
REFERENCES: 
AmpFlSTR YfilerTM PCR Amplification Kit User’s Manual 
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Method:   IdentifilerTM Setup Using the Qiagen BioRobot® Universal 
 
Date: 03/05/2007 Revision Date: 07/25/2007 Approved by: SAM  
 
 
REAGENTS: 
 
1. TE Buffer(10mM Tris-HCI, 0.1mM EDTA, pH 8.0):   
 

Mix together 10mL of 1M Tris-HCl, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure 
water.  Aliquot into 100mL bottles, autoclave and store at room temperature.  This solution is good for 
nine months. 

  
2. AmpFlSTR IdentifilerTM PCR Amplification Kits: Applied Biosystems (P/N 4322288) 
 

A.  AmpFlSTR PCR Reaction Mix 

B.  AmpF lSTR Identi f i lerT M Primer Set 

C.  AmpliTaq Gold™ DNA Polymerase 

D.  AmpF lSTR Control  DNA 9947A 
 
3. Bovine Serum Albumin (4.97mg/mL) Fisher Scientific (P/N CAS 9048-46-8) 
  
 
The Reaction Mix should be removed from the kit upon receipt and stored at 2 to 8oC.  The remaining 
components of the kit should be stored at -15 to -25oC.  The primer sets contain a light sensitive dye, and 
should be stored protected from light.  The expiration date is printed on the kit. 

 
MATERIALS:  
1. 96- Well Optical Reaction Plates Applied Biosystems (P/N 4306737) 
2. Full Plate Covers Applied Biosystems (P/N N801-0550) 
3. Aluminum Seal tape for 96-Well Plates Fisher Scientific (P/N 232698) 
 
EQUIPMENT: 
1. Qiagen Universal BioRobot Universal Liquid Handler Qiagen Corporation 
2. GeneAmp PCR System 9700 Thermal Cyclers Applied Biosystems 
  
PROCEDURE: 
 
This protocol is to setup the 96-well optical plate for PCR DNA amplification using IdentifilerTM. 
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1. Important notes to remember for using the BioRobot Universal for setup: 
a. Sarstedt screw-cap tubes are required for use on the instrument as they fit securely in the cooling 

blocks.  Caps should be removed after tubes are placed in the cooling blocks and replaced prior 
to removing tubes from the cooling block. 

b. The maximum volume of sample is 10uL.  If additional Taq DNA polymerase and bovine serum 
albumin (BSA) are to be added the maximum amount of sample is 8uL.  Taq/BSA should be 
prepared using 0.9uL BSA (4.97mg/mL) and 1.1uL of Taq DNA polymerase per sample with an 
additional 15-20% added to accommodate for robotic pipetting. 

 
2. Vortex the AmpFlSTR PCR Reaction Mix, AmpFlSTR IdentifilerTM Primer Set, AmpliTaq Gold™ 

DNA Polymerase, and AmpFlSTR Control DNA 9947A for 5 seconds.  Spin the tubes briefly in a 
microcentrifuge to remove any liquid from the caps. 

  
3. Create a master mix by combining the following volumes of reagents into a 1.5mL Sarstedt screw-cap 

tube: 
 

a. 10.5uL of AmpFlSTR PCR Reaction Mix   x   # of Samples 
 
b. 0.5uL of AmpliTaq Gold DNA Polymerase   x  # of Samples 
 
c. 5.5uL of AmpFlSTR Identifiler Primer Set   x   # of Samples 

 
Note:  Additional master mix (~10%) should be created to allow for pipetting error. 

 
4. The Master Amp Sheet within SDPD Worksheet maker v2.2 (found on the FB network 

H:\Worksheets) is the primary sheet for using the BioRobot Universal for amplification setup.  
 

a. The Master Amp Sheet shows the deck positions of all samples and their destination 
positions. 

 
b. Fill out the “Sample Name” column with a list of the sample IDs and the DNA conc. 

[ng/uL] column.  Ensure that the VolumeSample, VolumeTE, and TaqBSA columns are 
completed appropriately.  (Note:  The TaqBSA column cannot contain all zeros) 

 
c. Delete any unused rows below your samples (Highlight then Edit>Delete). The file can 

be saved as an excel workbook for future use. 
 

d. The Master Amp Sheet should be saved as a *.csv file type.  This is accomplished by 
using the “Save as…” command from the File menu.  The .csv file must be saved in the 
ImportData folder on the Qiagenuniversal hard drive.  (Note: *.csv file names should 
begin with the analysts’ initials followed by case # (e.g. initials(XX-XXXXXX).csv). 

 
e. When finished, the PCR worksheet(s) should be printed for the case notes.   
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f.  Close the .csv file. 

 
5. Open QiaSoftTM v.5 software (on the Qiagenuniversal computer desktop).  Log in as “sdpd” and leave 

the password blank. 
 

a. Under “applications” select “Forensic” in the drop-down menu (▼) and then select ”SDPD 
Identifiler Amplification v1.2.2”. 

b. Click “Run” button (►).  Follow the prompts from the protocol for preliminary setup. 
c. Enter the number of samples to be amplified. 
d. Enter the appropriate .csv file name. 
e. The .csv table will be checked  by the software and can be viewed to ensure correct file 

was selected. 
f. The System Liquid bottle should be filled above the minimum.  The protocol will not 

continue if liquid level is below minimum. 
g. Empty tip waste (if necessary). 
h. Refill the tip racks (if necessary).  If tips run out the instrument will prompt you to refill 

later. 
i. Place the 96-well optical plate on the appropriate location on the deck making sure to tape 

the side(s) of the plate to the base. 
j. Place your DNA samples in the appropriate order (according to the setup sheet filled in 

earlier).  You may use your printed copy to ensure the sample positions are correct. 
Note:  The samples are to be placed in the cooling blocks in a left to right direction, filling each column 
completely before the next. 

a. Four tubes containing TE buffer should be placed in the appropriate location on the deck. 
b. Taq/BSA should be prepared in the appropriate amount and be placed in the appropriate 

location on the deck. 
c. Place the Identifiler Master Mix in the appropriate place(s) on the deck.  Note: if more 

than 48 samples are being quantified then the master mix will need to be split into two 
tubes (follow the prompts from the instrument). 

 
6. The BioRobot Universal will now add the master mix, TE buffer, Taq/BSA and sample DNA to the 96-

well optical plate. 
7. When the protocol has finished, the tubes can be re-capped and removed, and the 96-well optical plate 

can be covered with a rubber plate cover and carried to the amplification room for loading into the 
GeneAmp 9700 thermalcycler. 

 
References: 
1. BioRobot 8000 Users manual.  Qiagen Corporation. 
2. QiaSoft 5 Software System Users Guide.  Qiagen Corporation. 
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Method:   Identifiler PlusTM, MinifilerTM,YfilerTM Setup Using the Qiagen BioRobot® 
Universal 

 
Date: 03/01/2010  Approved by: SAM  
 
 
REAGENTS: 
 
1. TE Buffer(10mM Tris-HCI, 0.1mM EDTA, pH 8.0):   
 

Mix together 10mL of 1M Tris-HCl, pH = 8.0 with 0.2mL of 0.5M EDTA and 990mL nanopure 
water.  Aliquot into 100mL bottles, autoclave and store at room temperature.  This solution is good for 
nine months. 

  
3. AmpFlSTR® Identifiler Plus® PCR Amplification Kits: Applied BioSystems  

A. AmpFlSTR® Identifiler Plus® Master Mix 
B. AmpFlSTR® Identifiler Plus® Primer Set 
C. AmpFlSTR® Control DNA 9947A 
  

2. AmpFlSTR YfilerTM PCR Amplification Kits: Applied Biosystems (P/N 4365495) 
A.  AmpFlSTR PCR Reaction Mix 
B.  AmpF lSTR Yfi lerT M Primer Set 
C.  AmpliTaq Gold™ DNA Polymerase 
D.  AmpF lSTR Control  DNA 007 

 
3. AmpFlSTR MinifilerTM PCR Amplification Kits: Applied Biosystems (P/N 4373874) 

A.  AmpFlSTR MinifilerTM Master Mix 
B.  AmpF lSTR Minif i lerT M Primer Set 
C.  AmpF lSTR Control DNA 007 

  
The Reaction Mix should be removed from the kit upon receipt and stored at 2 to 8oC.  The remaining 
components of the kit should be stored at -15 to -25oC.  The primer sets contain a light sensitive dye, and 
should be stored protected from light.  The expiration date is printed on the kit. 

 
MATERIALS:  
 
1. 96- Well Optical Reaction Plates Applied Biosystems (P/N 4306737) 
2. Full Plate Covers Applied Biosystems (P/N N801-0550) 
3. MicroAmp 8-cap strip Applied Biosystems (P/N N801-0535) 
 
EQUIPMENT: 
1. Qiagen Universal BioRobot Universal Liquid Handler Qiagen Corporation 
2. GeneAmp PCR System 9700 Thermal Cyclers Applied Biosystems 
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PROCEDURE: 
 
This protocol is to setup the 96-well optical plate for PCR DNA amplification using IdentifilerTM. 
 
1. Important notes to remember for using the BioRobot Universal for setup: 

a. Sarstedt screw-cap tubes are required for use on the instrument as they fit securely in the cooling 
blocks.  Caps should be removed after tubes are placed in the cooling blocks and replaced prior to 
removing tubes from the cooling block. 

b. The maximum volume of sample is 10uL.  If additional Taq DNA polymerase is to be added, the 
maximum amount of sample is 8uL. 

 
2. Yfiler - Vortex the AmpFlSTR PCR Reaction Mix, AmpFlSTR YfilerTM Primer Set, AmpliTaq Gold™ 

DNA Polymerase, and AmpFlSTR Control DNA 007 for 5 seconds.  Spin the tubes briefly in a 
microcentrifuge to remove any liquid from the caps. 

 
Minifiler – Vortex the AmpFlSTR MinifilerTM Master Mix, AmpFlSTR MinifilerTM Primer Set, and 
AmpFlSTR Control DNA 007 for 5 seconds.  Spin the tubes briefly in a microcentrifuge to remove any 
liquid from the caps.  (Skip to Step 4.) 
  

3. Create a master mix for the appropriate kit by combining the following volumes of reagents into a 
1.5mL Sarstedt screw-cap tube: 

 
Identifiler Plus 
10 μL AmpFlSTR® Identifiler Plus® Master Mix x # samples + 10 % 
5 μL AmpFlSTR® Identifiler Plus® Primer Set  x # samples + 10 % 
 
Yfiler 
9.2uL of AmpFlSTR YfilerTM PCR Reaction Mix x   # of samples + 10 % 
0.8uL of AmpliTaq Gold DNA Polymerase    x  # of samples + 10 % 
5.0uL of AmpFlSTR Identifiler Primer Set    x   # of samples + 10 % 

 
Minifiler 
10 μL AmpFlSTR MiniFilerTM Master Mix  x # of samples + 10 % 
5 μL AmpFlSTR MiniFilerTM Primer Set  x # of samples + 10 % 

 
 Note:  Additional master mix (~10%) should be created to allow for pipetting error. 

 
4. The Master Amp Sheet within SDPD Worksheet maker v3.3 (found on the FB network 

H:\Worksheets) is the primary sheet for using the BioRobot Universal for amplification setup.  
 

a. The Master Amp Sheet shows the deck positions of all samples and their destination positions. 
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b. Fill out the “Sample Name” column with a list of the sample IDs and the DNA conc. [ng/uL] 
column.  Ensure that the VolumeSample and VolumeTE are completed appropriately. 

 
c. Delete any unused rows below your samples (Highlight then Edit>Delete). The file can be saved 

as an excel workbook for future use. 
 

d. The Master Amp Sheet should be saved as a *.csv file type.  This is accomplished by using the 
“Save as…” command from the File menu.  The .csv file must be saved in the ImportData folder 
on the Qiagenuniversal hard drive.  (Note: *.csv file names should begin with the analysts’ 
initials followed by case # (e.g. initials(XX-XXXXXX).csv). 

 
e. When finished, the PCR worksheet(s) should be printed for the case notes.   

 
f. Close the .csv file. 

 
5. Open QiaSoftTM v.5 software (on the Qiagenuniversal computer desktop).  Log in as “sdpd” and leave 

the password blank. 
 
a. Under “applications” select “Forensic” in the drop-down menu (▼) and then select ”Minifiler 

– Yfiler Amplification v.1”. 
b. Click “Run” button (►).  Follow the prompts from the protocol for preliminary setup. 
c. Enter the number of samples to be amplified. 
d. Enter the appropriate .csv file name. 
e. The .csv table will be checked by the software and can be viewed to ensure correct file was 

selected. 
f. The System Liquid bottle should be filled above the minimum.  The protocol will not continue 

if liquid level is below minimum. 
g. Empty tip waste (if necessary). 
h. Refill the tip racks (if necessary).  If tips run out the instrument will prompt you to refill later. 
i. Place the 96-well optical plate on the appropriate location on the deck making sure to tape the 

side(s) of the plate to the base. 
j. Place your DNA samples in the appropriate order (according to the setup sheet filled in 

earlier).  You may use your printed copy to ensure the sample positions are correct. 
Note:  The samples are to be placed in the cooling blocks in a left to right direction, filling each column 
completely before the next. 

a. Four tubes containing TE buffer should be placed in the appropriate location on the deck. 
b. Place the Master Mix in the appropriate place(s) on the deck.  Note: if more than 48 samples 

are being quantified then the master mix will need to be split into two tubes (follow the 
prompts from the instrument). 

 
6. The BioRobot Universal will now add the master mix, TE buffer, and sample DNA to the 96-well 

optical plate. 
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7. When the protocol has finished, the tubes can be re-capped and removed, and the 96-well optical plate 
can be covered with a rubber plate cover and carried to the amplification room for loading into the 
GeneAmp 9700 thermalcycler. 

 
References: 
1. BioRobot 8000 Users manual.  Qiagen Corporation. 
2. QiaSoft 5 Software System Users Guide.  Qiagen Corporation. 
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Method: WellAware Set-up of Samples for Amplification 
 
Date:  12/06/2010              Approved by: SAM 
______________________________________________________________________ 
 
REAGENTS: 
 
This protocol is for manual setup, using the WellAware as a pipetting assistant, of a 96-well optical plate for 
PCR amplification using the IdentifilerTM, MinifilerTM, or YfilerTM amplification kits. Please refer to the 
Identifiler amplification protocol for information on master mix preparation and other additional 
information regarding this protocol.  
 
MATERIALS: 
 
1. 96-Well Optical Reaction Plate  Applied Biosystems (P/N N801-0560) 
2. Full Plate Covers Applied Biosystems (P/N N801-0550)  
3. Aluminum Seal tape for 96-Well Plates Fisher Scientific (P/N 232698)  
4. Pre-scored 96-well plate sealing tape  Nunc (P/N 236701) 
 
 
EQUIPMENT:  
1. WellAware  BioTX  
2. GeneAmp PCR System 9700 Thermal Cyclers  Applied Biosystems  
 
PROCEDURE: 
 
1. Open the PCR (1-24) worksheet (or the Minifiler or Yfiler Amp worksheets) in the SDPD 

Worksheet maker v4.0 (found on the FB network H:\Worksheets).  Click on the orange ‘Make 
WellAware eSOP’ button to generate a WellAware eSOP (electronic standard operating procedure). 
Save the eSOP as a text file in the WellAware folder on the FB network.  This is accomplished by using 
the “Save as…” command from the File menu. The Text (Tab delimited) file must be saved in the 
WellAware folder on the FB network. 
 
[Note:  The eSOP requires a case number be entered on the worksheet] 

 
2. When finished, the PCR worksheet should be printed for your case notes.  

 
3. Power on the WellAware computer located in the hood in the amplification set-up room.  Open the 

BioTX Lab Suite software. 
 

4. Under the Modules tab, click on ‘WellAware’ then under the Electronic SOPs tab, click on ‘Open 
Saved eSOP.’ Navigate to the WellAware folder on the FB Network and open your saved eSOP. 
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5. Place a 96-Well Optical Reaction Plate on the bottom right surface of the WellAware screen. 
 

6. Begin the protocol. [It is recommended that when manually pipetting into a 96-well plate that one of 
the pre-scored tape seals be used to minimize potential contaimination.] 
 

7. When the protocol has finished the 96-well optical plate can be covered with a rubber plate cover and 
carried to the amplification room for loading into the GeneAmp 9700 thermalcycler.  
 

8. When the protocol is complete, exit the WellAware software. 
 

9. Power off the WellAware computer. 
 
REFERENCE: 
WellAware User Guide. 
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Method:   ABI 310 Cleaning and Setup  

Date: 9/15/2001  Revis ion Date:   01/01/2007  Approved by: SAM  
            _____ 
 
It is not necessary to change the polymer and capillary for every run, nor is it necessary to perform all steps 
of this procedure in every circumstance (e.g., when adding a small volume of polymer in order to complete 
a long run).  Capillaries are changed after approximately 200 injections. 
 
Approximately 5uL of polymer is used per injection.  Do not put unused polymer back into the bottle since 
the polymer in the syringe decomposes over time at room temperature. 
 
REAGENTS: 
 
1. 310 Genetic Analyzer Performance Optimized Polymer 4 (POP-4 TM): 
 Applied Biosystems (P/N 402838) 
 Store at 2-8oC.  See bottle for printed expiration date. 
 
2. 310 Genetic Analyzer Buffer with EDTA (10X):  Applied Biosystems (P/N 402824) 

Store at 2-8oC.   
  
MATERIALS: 
 
1. 310 Genetic Analyzer Capillaries (47cm X 50um):  Applied Biosystems (P/N 402839)   
2. Genetic Analyzer 4mL Buffer Vials:  Applied Biosystems (P/N 401955) 
3. Hamilton Gastight® Syringe, 1mL:  ABD (P/N 604418-Rev A) 
4. ABI PRISM® 310 Data Collection Software 
 
PROCEDURE: 
 
Reminder:  If the syringe needs to be filled, remove the POP-4 polymer from the refrigerator and allow it 
to equilibrate to room temperature.  It is useful to open the vial slightly to allow the polymer to de-gas. 
 
1. Power on the ABI 310 instrument. 
 
2. Power on the computer or select Restart from the Start>Shutdown menu (it is useful but not 

required to restart the computer on a weekly basis to clear the RAM memory).  
 
Note: The 310 instrument needs to be powered on before the computer is powered on. 
 
3. Launch the ABI Prism 310 Collection Software. 
 
4. Determine if the capillary should be replaced by selecting Change Capillary… from the 
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Instrument menu and note the number of injections (the capillary should be changed at 
approximately 200 injections).   

 
If opting not to replace the capillary click Cancel.   
 
If the capillary will be replaced click on Reset Capillary Injection Counter, or manually change 
the Capillary Injection Counter to zero, and click OK. 

 
5. Home the Syringe: 
 

• Choose Manual Control from the Window menu. 
• Select Syringe Home from the Function drop-down menu, and click Execute. 

 
6. Remove and clean the syringe: 
 

• Open the instrument doors. 
• Move the syringe drive toggle to the left. 
• Unscrew the syringe from the pump block. 
• Clean and rinse the syringe with nanopure water. 
• Dry the outside of the syringe with a Kimwipe® and remove excess water from the inside of the 

syringe by blowing into it with compressed air. 
• Dampen the end of the plunger with nanopure water before inserting the plunger into the 

syringe. 
 
7. Remove the capillary: 
 

• Open the door covering the heat plate on the 310 instrument, remove the tape holding the 
capillary to the heat plate, and pull the capillary through the electrode thumbscrew. 

• Open the laser detector door on the 310 instrument and remove the capillary from the vertical 
groove of the detector window. 

• Unscrew the ferrule on the right side of the pump block and pull out the capillary. 
• Store the capillary ends in two tubes filled with nanopure water and closed with septa if the 

capillary is to be used again.  Do not allow these tubes to dry out. 
 
Note:  Do not use the GS-Wash Capillary and Block module to wash the capillary. 
 
8. Remove and clean the pump block: 
 

• Grasp the pump block with both hands and pull straight out from the instrument. 
• Remove all the fittings from the pump block. 
• Rinse the anode buffer reservoir with nanopure water, then dry with a Kimwipe®. 
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• Rinse the outside of the pump block thoroughly with tap water. 
• Rinse the inside of the pump block buy using a plastic syringe with nanopure water. 
• Dry the pump block and fittings with a Kimwipe® or allow to air dry. 
• Replace, but do not tighten, the fittings. 

 
9. Clean the cathode electrode: 
 

• Press the Tray button to the left of the pump block to move the tray platform forward. 
• Moisten a Kimwipe® with nanopure water and gently wipe the electrode with an up/down 

motion. 
• Dry the electrode with a fresh Kimwipe®. 
• Press the Tray button again to move the platform back into position. 

 
The POP-4 polymer should be warmed to room temperature before filling the syringe.  Precipitate in the 
bottle should go back into solution at room temperature.  Mix the polymer thoroughly by inversion before 
using. 
 
10. Fill the syringe with POP-4TM polymer: 
 

• Prime the syringe by drawing up a small amount of POP-4 TM solution (0.2mL maximum) into 
the syringe and pulling the plunger to the 1.0mL mark to coat the wall of the syringe with 
polymer.  Discard this polymer solution. 

• Fill the syringe manually with a maximum of 0.8mL of POP-4 TM polymer.  This amount is 
sufficient for approximately 100 injections if 0.3mL is used to fill the empty pump block. 

• Wipe the outside of the syringe with a Kimwipe® to dry. 
• Attempt to remove any air bubbles by inverting and tapping on the syringe, and then pushing a 

small amount of polymer with the air bubbles out of the tip. 
 
11. Replace the pump block: 
 

• Verify that the gold electrode socket at the back of the block is dry. 
• Align the steel shafts on the instrument with the holes on the block, and then gently push the 

block onto the shafts. 
• Ensure that the plunger valve of the buffer reservoir is aligned with the activator arm.  It may 

be necessary to move the activator arm up or down by selecting Buffer Valve Open or 
Close from the Function drop-down menu in the Manual Control window and clicking 
Execute. 

 
12. Install the syringe: 
 

• The syringe toggle drive on the instrument should be moved to the left in order to attach the 
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syringe to the pump block. 
• Place the syringe through the right-hand port of the plastic syringe guide plate and screw the 

syringe into the pump block.  The syringe should be finger tight in the block. 
• Hand-tighten the valves on the pump block to the left of and below the syringe. 
 

13. Install the capillary: 
 

• Clean the capillary window with a Kimwipe® dampened with 95% ethanol.  Do not touch the 
capillary window after cleaning. 

• Insert the end of the capillary that is closest to the window through the center of the plastic 
ferrule on the right side of the pump block. 

• Screw the capillary and ferrule into the block, positioning the capillary directly below the 
opening to the glass syringe. 

• Screw the ferrule to finger tightness to secure the capillary.  Test the fitting by gently pulling 
on the capillary-it should not move.  The end of the capillary must visibly protrude out of the 
ferrule to seal tightly.  If the ferrule is tightened without the capillary protruding, the opening 
in the ferrule will be sealed closed, and a new ferrule will be required. 

• Open the laser detector door, and position the capillary in the vertical groove of the detector 
window. 

• Align the green mark on the capillary with the top edge of the detector plate.  The central part 
of the capillary window should rest over the laser detector window without putting strain or 
tension on the capillary. 

• Close the laser detector door.  Do not turn the ferrule screw after the detector door is closed.  
If the screw needs adjustment, first release the capillary from the detector. 

• Thread the other end of the capillary through the capillary hole in the electrode thumbscrew 
until it protrudes past the tip of the electrode by approximately 0.5mm. 

• Secure the capillary in place by taping the capillary against the heat plate. 
• Close the heat plate door. 

 
14. Filling the buffer reservoirs: 
 

• Dilute 1.5mL of 10X Genetic Analyzer Buffer (with EDTA) to a 1X concentration by adding 
13.5mL of nanopure water. 

• Fill the anode buffer reservoir to the red line with the 1X Genetic Analyzer Buffer and place 
the reservoir on the pump block. 

• Fill a 4mL glass vial to the fill line with the 1X Genetic Analyzer Buffer.  Insert a plastic vial lid 
with attached septum into the glass vial and place the vial into position 1 on the autosampler 
platform.  This will serve as the cathode buffer. 

• Fill a second 4mL glass vial to the fill line with nanopure water.  Insert a plastic vial lid with 
attached septum into the glass vial and place the vial into position 2 on the autosampler. 
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• Fill a 1.5mL microfuge tube (with the cap cut off) with about 1mL of nanopure water, and 
place it into position 3 on the autosampler platform. 

 
15. Filling the pump block: 
 

• Select Buffer Valve Close from the Function drop-down menu in the Manual Control 
window and click Execute. 

• Partially unscrew the waste valve on the pump block below the syringe. 
• Push down on the syringe plunger until the valve space is filled with polymer.  This will 

remove the air bubbles at this valve site and should use about 0.1mL of polymer. 
• Tighten the waste valve to close. 
• Select Buffer Valve Open from the Function drop-down menu and click Execute.   
• Push down on the syringe plunger to push enough polymer through the block so that all of the 

air bubbles are removed from the polymer channel.  Observe the bubbles as they travel through 
and out of the block and a drop of the polymer falls through the anode buffer.  This process 
should use approximately 0.2mL of polymer. 

• Select Buffer Valve Close from the Function drop-down menu and click Execute. 
 
16. Seat the syringe drive: 
 

• Move the syringe toggle drive to the right so that it is positioned over the syringe plunger. 
• Select Syringe Down from the Function pop-up menu in the Manual Control window 

and click Execute. 
• Enter a number in the Value box and click Execute.  This task can be performed repeatedly 

until the toggle nears the syringe plunger.  Enter smaller numbers in the Value box until the 
toggle makes contact with the syringe plunger. 

 
17. Calibrate the autosampler: 
 

• Choose Autosampler Calibration… from the Instrument menu. 
• Click Start on the Autosampler Calibration window. 
• Click Resume after ensuring that no autosampler tray is present. 
• Click on the direction arrows and the page up and page down keys to align the front 

calibration point on the autosampler with the capillary.  To make fine adjustments, press 
the shift key on the keyboard while clicking the direction arrow.  The end of the capillary 
must be centered nearly touching the calibration point. 

• When done, click Set. 
• Repeat for the rear calibration point. 
• When done, click Set, then Resume, and then Done. 
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18. Set the temperature (optional): 
 

• Close the instrument doors. 
• Select Temperature Set from the Function pop-up menu. 
• Enter 60 in the Value box and click Execute.  It takes about 30 minutes for the instrument to 

reach the run temperature of 60oC. 
 
REFERENCES: 
AmpFlSTR Profiler Plus TM PCR Amplification Kit User’s Manual 
AmpFlSTR COfiler TM PCR Amplification Kit User Bulletin 
ABI PRISM® 310 Genetic Analyzer User’s Manual 
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Method:  Preparation of AmpFlSTR IdentifilerTM, MinifilerTM, or YfilerTM Amplified 
Samples for Analysis on the ABI 310 

 

Date: 06/01/2004  Revision Date:   07/25/2007 Approved by: SAM   
            _____ 
 
REAGENTS: 
 
1. HIDI Formamide:  Applied Biosystems (P/N 4311320) 

Dispense the formamide into 500uL aliquots and store frozen.  The frozen formamide can be used up to 
1 year after being aliquoted.  

 
Caution:  Formamide is a known teratogen and is harmful by inhalation, skin contact, and ingestion.  
Use in a fume hood and wear chemical resistant gloves and safety glasses when handling. 

 
2. GeneScan-500 [LIZ] Internal Lane Size Standard: 

Applied Biosystems (P/N 4322682) 
The kit may be stored up to six months at 4oC. 

 
3. AmpFlSTR IdentifilerTM Allelic Ladder:  (included in the IdentifilerTM kit)  

Store at 2 to 8oC, protected from light. 
Or 
4. AmpFlSTR YfilerTM Allelic Ladder:  (included in the YfilerTM kit)  

Store at 2 to 8oC, protected from light. 
Or 
5. AmpFlSTR MinifilerTM Allelic Ladder:  (included in the MinifilerTM kit)  

Store at 2 to 8oC, protected from light. 
 
MATERIALS: 
 
1. 0.5mL Genetic Analyzer sample tubes: 

Applied Biosystems (P/N 401955) 
 
2. Septa for 0.5mL Genetic Analyzer sample tubes: 

Applied Biosystems (P/N 401956) 
 
PROCEDURE: 
 
1. Label a 0.5mL Genetic Analyzer sample tube for each of the samples, allelic ladder(s), and blanks. 
 
2. Aliquot 25uL of formamide into the formamide blank tube. 
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3. Create a master mix by combining the following volumes of reagents into a 1.5mL microcentrifuge 
tube: 

 
• 24.5uL formamide  x  (# of samples + 10%) 

 
• 0.5uL GeneScan-500 [LIZ]  x  (# of samples + 10%) 

 
 This mixture can be stored at 2-6oC for up to two weeks. 
 
4. Vortex the master mix, then spin briefly in a microcentrifuge.  Aliquot 25uL of the master mix into 

each of the remaining 0.5mL Genetic Analyzer sample tubes.   
 
5. Seal each tube with a septum.  Ensure the septa are not sealed shut. 
 
6. Add 1.5-3uL of AmpFlSTR IdentifilerTM ( MinifilerTM or YfilerTM) Allelic Ladder to the appropriate 

0.5mL Genetic Analyzer sample tube(s).  Mix the contents of the tube by pipetting up and down or by 
stirring with a pipette tip. 

 
7. Add 1.5uL of amplified DNA to each sample tube.  Mix the contents of each tube by pipetting up and 

down or by stirring with a pipette tip.  
 

8. Denature the samples by placing them in the 95oC heat block for three minutes. 
 
9. Chill the tubes immediately in a freezer block for three minutes.  
 
10. Place the tubes into a 48-well 310 sample tray and check to ensure that no septa became unseated 

during the heating process. 
 
11. Open the doors of the ABI 310 instrument and press the Tray button to the left of the pump block.  

Place the tray onto the autosampler with position A1 at the upper right.  Press the Tray button again 
to return the autosampler.  Close the instrument doors. 

 
REFERENCES: 
AmpFlSTR IdentifilerTM PCR Amplification Kit User’s Manual 
AmpFlSTR MinifilerTM PCR Amplification Kit User’s Manual 
AmpFlSTR YfilerTM PCR Amplification Kit User’s Manual 
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Method:   Capillary Electrophoresis of Samples on the Applied Biosystems 310 Genetic 
Analyzer 

Date:  06/01/2006   Revision Date: 02/06/2009 Approved by: SAM   
            ____ 
 
MATERIALS: 
 
Applied Biosystems 310 Data Collection Software 
 
PROCEDURE: 
 
1. Launch the 310 Data Collection software from the icon on the desktop. 
 
2. Under the File menu, select New and click the GeneScan Sample Sheet 48 Tube icon. 
 
3. Fill out the Sample Sheet: 

• For Identifiler, MiniFiler,  or Yfiler Samples:  Ensure that the 5-dye option is selected.  This option 
can be selected from the drop-down menu in the upper-right corner of the window. 

• In the Sample Name column, fill in the appropriate name at each tray position. 
When finished filling in all sample names, highlight the Sample Name column by single clicking in 
the gray bar at the top and select Copy from the Edit menu. 
Alternatively, if a 310 import text file has been created the sample sheet can be automatically 
populated.  Ensure that the 5-dye option is chosen, then select File>Import Sample Setup and 
browse for the appropriate text file. 

• Highlight the Sample Info column and select Paste from the Edit menu. 
• For the 5-dye option (Identifiler, Minifiler, or Yfiler): a diamond symbol should appear next to the 

orange box in the Std column for each sample.  If no diamond appears, click in the box next to the 
orange dye color box placing a diamond symbol there.  Highlight the Std column and select Fill 
Down from the Edit menu to place a diamond symbol in the Orange dye color for each sample.   

• The Collection name column can be left blank. 
• Select Save from the File menu and save the sample sheet with a unique identifier. 

 
4. Fill out an injection list: 

• Select File > New.   Then click the GeneScan Injection List icon. 
• From the Sample Sheet drop-down menu, choose the appropriate sample sheet. 
• For additional injections, highlight the Inj. # and select Insert or Add from the Edit menu to 

insert a blank injection.  Highlight the sample you wish to re-inject,  
• Select Copy from the Edit menu, then highlight the blank row and select Paste  from the Edit 

menu.  The formamide injection blank should be injected at the  beginning of the run.   
• For Identifiler or Yfiler samples:  Select GS STR POP4 (1mL) G5 v2 from the Module drop-

down menu for the first sample.  Click on the Module column heading and choose Fill Down 
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from the Edit menu.   
The run time can be modified by changing the value in the Run Time column.  The injection time 
can be modified by changing it in the Inj Secs column. 

• The Matrix column for all samples should indicate <none>. 
• The Auto Anlz column should be deselected for each sample (no “x” in the boxes of this column). 
• No other information is required in the injection list window 

 
5. Fill in the Operator’s name and click the Run button.  Select Status from the Window menu to view 

the run parameters. 
 
6. When the run is complete: 

• Close the Injection List.  Select Save at the prompt. 
• Highlight the Sample Sheet in the Sample Sheets folder [D:\Applied Bio\310\Sample Sheets] and 

move it into the Run Folder [D:\Applied Bio\310\Runs]. 
• Rename the Run Folder uniquely following protocol and move it into the individual Analyst’s 

Folder [on the FB network [H:\3130-310 Run Folders\(Analyst folder)] prior to any analysis. 
 
REFERENCES: 
AMPFlSTR IdentifilerTM PCR Amplification Kit User’s Manual 
AMPFlSTR YfilerTM PCR Amplification Kit User’s Manual 
ABI PRISM® 310 Genetic Analyzer User’s Manual 
GeneScan® Analysis Software User’s Manual 
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Method:   Creating a Matrix with GeneMapper ID Software 

Date: 12/06/06   Revision Date: 07/25/2007 Approved by: SAM     
            _____ 
 
A new matrix will be made as needed. 
 
REAGENTS: 
 
1. HIDI Formamide:  Applied Biosystems (P/N 4311320) 

Dispense the formamide into 500ul aliquots and store frozen.  The frozen formamide can be used up to 
1 year after being aliquoted.  

 
2. Matrix Standard Set DS-33(6-FAM, VIC, NED, PET and LIZ): 

PE Applied Biosystems (P/N 4318159) 
 
3. PowerPlex Matrix Standards (JOE, FL, TMR and CXR): 

Promega Corporation (Cat #DG3640) 
 
PROCEDURE: 
 
1. Prepare and run matrix samples: 

• Prepare one tube for each matrix standard sample by combining 1-3ul of matrix standard with 25ul 
deionized formamide. 

• Seal each tube with a septum. 
• Follow steps 9 through 12 of the Preparation of Amplified Samples for Analysis on the ABI 310 

procedure. 
• Follow the steps of the Capillary Electrophoresis procedure.  Designate appropriate sample names 

based on the dye color (i.e. FAM, VIC, NED). 
 
2. Create a new matrix: 

• Import the matrix samples into a new GeneMapper ID project. 
• View the raw data to determine the data point range for each of the matrix standards.  This range 

should begin after the primer peak in a flat part of the baseline and extend to include all portions of 
the sample with a stable baseline and no anomalies (i.e. spikes).  You must have at least five peaks 
to create a matrix. 

• Select Tools>GeneMapper Manager.  Then click the Matrices tab. 
• Click the New button. 
• Enter a Matrix name and description (optional).  The following naming convention should be used 

when naming the matrix: 
5-dye matrix(310#X)date or 4-dye matrix(310#X)date as appropriate. 

• Choose the number of dyes from the Number of Dyes drop down list. 
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• The buttons represent each of the dye colors (i.e. B = blue, Y = yellow).  Click a button to display 
a pop-up menu which can be linked to a sample file that represents the dye color for that button. 

• Enter the start point in the Start At field. 
• Enter the total number of data points to include in order to calculate the matrix in the Points field 

(in most cases the default value can be used unless a portion of your data needs to be excluded). 
• Repeat this procedure for the other four matrix files and click Create. 
• A window appears which contains the matrix values.  “1.0000” should appear in the diagonal set of 

boxes from upper left to lower right.  In general, all other numbers should be less than 1.0000. 
• Click OK. 

 
3. Evaluate the matrix: 

• Apply the new matrix to the project created in step 2.  For each matrix sample, display all five 
colors separately on one screen showing only electropherogram data. Visible peaks should be in the 
color of the matrix standard run in that injection and the electropherograms for the other four 
colors should be relatively flat.   

 
4. Save the matrix to the FB Network: 

• A copy of the new matrix should be saved in the following location:  H:\3130-310 Run 
folders\310 MATRIX\310#X_date. 

 
REFERENCES: 
1. AmpFlSTR IdentifilerTM PCR Amplification Kit User’s Manual  
2. AmpFlSTR YfilerTM PCR Amplication Kit User’s Manual 
3. AmpFlSTR MinifilerTM PCR Amplification Kit User’s Manual 
4. GeneMapper® ID Software User’s Manual Version 3.1 
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Method:  ABI 3130 Genetic Analyzer Instrument Preparation and Cleaning 
 

Date:  06/01/06  Revision Date:   01/01/2007  Approved by: SAM   
            _____ 
 
INTRODUCTION: 
 
Although the 3130 Genetic Analyzer functions by the same principals as the 310 Genetic Analyzer, there 
are certain fundamental differences including the way in which the instrument is prepared for a run.  For 
example, the pump block does not need to be routinely removed from the instrument for cleaning, but 
rather is flushed with water while in place on the instrument, and the polymer is not injected via a syringe, 
but rather is drawn directly from the manufacturer’s bottle.  
 
REAGENTS: 
 
3130 Genetic Analyzer Performance Optimized Polymer (POP-4TM): 
Applied Biosystems (P/N 4352755) 
Store at 2-8C.  See bottle for expiration date. 
(Note:  this is not the same as 310 POP-4TM used on the 310) 
 
Genetic Analyzer Buffer (10X) with EDTA: 
Applied Biosystems (P/N 402824) 
Store at 2-8C. 
(Note:  this is the same buffer used on the 310) 
 
MATERIALS: 
 
1. 3130 & 3100-Avant Capillary Array (36 cm):  Applied Biosystems 4-capillary array (P/N 4333464)  
2. 96-Well Optical Reaction Plates: Applied Biosystems (P/N 4306737) 
3. Plate Septa for 96-well: Applied Biosystems (P/N 4315933) 
4. 3130 and 3100 Series Plate Base 96-well:Applied Biosystems (P/N 431723) 
5. 3100 Genetic Analyzer Plate Retainer 96-well:Applied Biosystems (P/N 4317241) 
6. Buffer/Water Reservoirs: Applied Biosystems (P/N 628-3202) 
7. Septa for Buffer/Water Reservoirs: Applied Biosystems (P/N 628-0150) 
 
PROCEDURE: 
 
Powering on the 3130 and launching the Data Collection software 

1. Power on the computer monitor, then power on the computer.  At the Log On prompt, hit OK (or 
Enter) leaving the Password window blank. 

 
2. Before turning on the 3130 instrument, ensure that the oven door is closed and locked, that the 
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instrument doors are closed, and the computer is powered on. 
 
3. Power on the instrument by pressing the on/off button on the front of the instrument.  Ensure that the 

green status light is on and not flashing before proceeding. 
 
4. Click on the Run 3130 Data Collection V3.0 icon on the desktop.  As the software launches, the 

Service Console appears.  Initially the Service Console displays four red circles, indicating that all 
applications are off.  As each application activates, the red circles (off) change to yellow triangles 
(activating) and then to green squares (on).  This may take several minutes. 

 

     
   
 
Note:  the Data Collection Software contains numerous wizards that can be followed to accomplish various 
tasks.  To access these wizards, launch Data Collection and click on GA Instruments > ga3130 > 
SDPD3130A > Instrument Status and select a specific wizard from the Wizards drop-down menu. 
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Installing or replacing the capillary array 
The capillary array should be replaced after approximately 250 injections per capillary, or removed from 
the instrument for storage if the instrument is to be shut down for an extended period of time. 
 
Select the Install Array Wizard for guidance.   
 
Wash the pump block 
The pump chamber, channels and tubing should be washed on a weekly basis, or before each batch of runs. 

  
Select the Water Wash Wizard for guidance.   
 
Replenishing  polymer 
Polymer should be replenished as needed, but unused polymer should be replaced with fresh polymer after 
approximately two weeks on the instrument.   
 
1. Remove the polymer from the refrigerator and allow to equilibrate to room temperature.  Open 

the cap of the bottle slightly to allow de-gassing. 
 
2. Select the Replenish Polymer Wizard for guidance. 

 
Removing bubbles from the pump block 
Periodically, check the pump chamber, channels and tubing for air bubbles.  Press the button on the right 
hand side of the front of the instrument to turn on the lamp inside the instrument.  This will help locate any 
air bubbles. 
 
Select the Bubble Removal Wizard for guidance.   

 

Preparing buffer and filling reservoirs 
It is recommended that the 1X 3130 buffer in the anode and cathode buffer reservoirs should be replaced 
before each batch of runs, however, multiple runs have been completed using the same buffers with no 
adverse affects. 
 
1. Add 5mL of 10X 3130 Genetic Analyzer buffer to a 50mL graduated cylinder and make up to 50mL 

with nanopure water.  Mix. 
 
2. Check that the oven and instrument doors are closed and press the Tray button on the front of the 

instrument.  The autosampler will move to the forward position.  (Note:  the autosampler will not 
move if the instrument doors are open.) 
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 Wait until the autosampler stops and open the instrument doors. 
 
3. Remove the cathode buffer (position 1), waste (position 2) and water (position 4) reservoirs at the 

front of the autosampler.  (Note:  position 3 is and should remain vacant.) 
 
4. Remove and discard the septa, and rinse the reservoirs with nanopure or distilled water. Do not use 

any detergents when rinsing these reservoirs. 
 
5. Rinse the cathode reservoir with 1X 3130 buffer and then fill to the line with 1X 3130 buffer 

(approximately 16mL). 
 
6. Fill the waste and water reservoirs to the line with nanopure water (approximately 16mL). 
 
7. Place fresh septa on the reservoirs and place the reservoirs back in their respective positions. 
 
8. Remove the anode buffer reservoir from the bottom of the lower polymer block by firmly pulling 

down and twisting slowly. 
 
9. Clean and rinse the reservoir with nanopure water, and then rinse with 1X 3130 buffer.   
 
10.  Fill the anode reservoir to the line with 1X 3130 buffer (approximately 16mL). 
 
11. Replace the anode reservoir on the lower polymer block. 
 
12. Close the instrument doors and press the Tray button to return the autosampler to its original 

position.    
 
Calibration of the autosampler 

Only a trained instrument specialist should calibrate the 3130 autosampler.  Under no circumstance should 
an analyst attempt to calibrate the autosampler. 
 
(See also Procedures for Performing a Spatial Calibration, Spectral Calibration, and Flushing and Filling the 
Water Trap) 
 
REFERENCES: 
Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide. 
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Method:  Preparation of AmpFlSTR Identifiler Plus TM (IdentifilerTM, MinifilerTM or 
YfilerTM) Samples for Analysis on the Applied Biosystems 3130 Genetic 
Analyzer 

Date:  06/01/2006  Revision Date:   04/01/2011  Approved by: SAM   
            _____ 
 
REAGENTS: 
 
1. HIDI Formamide:  Applied Biosystems (P/N 4311320) 
 

Dispense the formamide into 500ul aliquots and store frozen.  The frozen formamide can be used up to 
1 year after being aliquoted.  

 
Caution:  Formamide is a known teratogen and is harmful by inhalation, skin contact, and ingestion.  
Use in a fume hood and wear chemical resistant gloves and safety glasses when handling. 

 
2. GeneScan-500 [LIZ] Internal Size Standard: Applied Biosystems (P/N 4322682) 

The tubes may be stored for up to six months at 4oC. 
 
3. AmpFlSTR IdentifilerTM (MinifilerTM or YfilerTM) Allelic Ladder:  (included in the IdentifilerTM, 

MinifilerTM, or YfilerTM kits)  
Store at 2 to 8oC, protected from light. 

 
MATERIALS: 
 
1. 96-Well Optical Reaction Plates:  Applied Biosystems (P/N 4306737) 
2. Plate Septa for 96-Well plates:  Applied Biosystems (P/N 4315933) 
3. MicroAmp Splash Free Support Base:  Applied Biosystems (P/N 4312063)  
4. 96-well cooling block: Stored in the reagent freezer 
 
PROCEDURE: 
 
Note: Prior to preparing samples, the 9700 thermal cycler can be turned on so that the top plate can come 
to temperature. 
 
1. Take out a new 96-well reaction plate. 
  
2. Create a master mix by combining the following volumes of reagents into a 1.5mL microcentrifuge 

tube. 
8.7uL formamide x (# of samples + 10%) 
0.3uL GS500 [LIZ] x (# of samples + 10%) 
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3. Vortex the master mix. 
  
4. Aliquot 10uL of formamide into the formamide blank well (suggestion: A1) if used as a control. 
 
5. Aliquot 9uL of the master mix into each of the appropriate wells on the 96-well reaction plate to 

accommodate the numbers of amplified samples and allelic ladders samples. 
 
6. Add 1uL of AmpFLSTR Identifiler PlusTM (Identifiler, MinifilerTM or YfilerTM) Allelic Ladder to the 

appropriate well(s) on the reaction plate. A second ladder is recommended when setting up your 3130 
plate. 

 
7. Add 1uL of amplified sample to each sample well of the reaction plate. 

 
Note:  The 3130 instrument samples wells in sets of four (a through D and E through H).  Any extra wells 
in a set of four should have either formamide of formamide/internal size standard included in them so that 
the capillaries are not descending into empty wells. 
 
8. Place a 96-well septa mat onto the reaction plate, and place the reaction plate in the 9700 thermal 

cycler. The plate may be spun down prior to denaturing.   
 
9. Denature the samples by running the denature 95 3min protocol.  Important: Do not clamp down 

the cover plate of the 9700 onto the septa mat-covered reaction plate as it will melt.  Simply slide the 
cover plate forward to cover the reaction plate without clamping it down. 

 
10. After the denaturation protocol is finished, chill the reaction plate by immediately placing it the 96-well 

cooling block (-200C) for three minutes. 
 
11. Place the reaction plate into a 3130 base plate (it will only fit in one orientation) and secure a plate 

retainer on top of the reaction plate.  Check to ensure that the retainer clip is properly seated. 
 
12. Press the tray button on the front of the 3130 Genetic Analyzer.  When the tray presents itself, open 

the doors of the instrument and place the tray onto the right side position (only option available at this 
time) of the autosampler (the tray will only fit in one orientation).  Close the instrument doors. 

 
13. To start a run on the 3130 Genetic Analyzer please see the Capillary Electrophoresis of 

Amplified Samples protocol. 
 

REFERENCES: 
AmpFlSTR Identifiler PlusTM PCR Amplification Kit User’s Manual  
AmpFlSTR IdentifilerTM PCR Amplification Kit User’s Manual  
AmpFlSTR YfilerTM PCR Amplication Kit User’s Manual 
AmpFlSTR MinifilerTM PCR Amplification Kit User’s Manual 
Applied Biosystems 3130 User’s Bulletin. 
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Applied Biosystems 3130 User’s Manual. 
Applied Biosystems 3130 Getting Started Guide. 
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Method:  Preparation of AmpFlSTR Identifiler PlusTM, IdentifilerTM, MinifilerTM, or 
YfilerTM Amplified Samples for Analysis on the ABI 3130 Using the Automated 
CAS-1200 

Date: 04/01/2008   Revision Date:   04/01/2011  Approved by: SAM   
            _____ 
 
REAGENTS: 
 
1. HIDI Formamide:  Applied Biosystems (P/N 4311320) 

Dispense the formamide into 500uL aliquots and store frozen.  The frozen formamide can be used up to 
1 year after being aliquoted.  

 
Caution:  Formamide is a known teratogen and is harmful by inhalation, skin contact, and ingestion.  
Use in a fume hood and wear chemical resistant gloves and safety glasses when handling. 

 
2. GeneScan-500 [LIZ] Internal Lane Size Standard: 

Applied Biosystems (P/N 4322682) 
The kit may be stored up to six months at 4oC. 

 
3. AmpFlSTR Identifiler PlusTM, IdentifilerTM , YfilerTM, or MinifilerTM Allelic Ladder:  (included in the 

Identifiler PlusTM, IdentifilerTM , YfilerTM, or MinifilerTM kits)  
Store at 2 to 8oC, protected from light. 

 
MATERIALS: 

 
1. 3130 and 3100 Series 96-well Plate Base:  Applied Biosystems (P/N 4317237) 
2. 3100 Genetic Analyzer 96-well Plate Retainer:  Applied Biosystems (P/N 4317241) 
3. 96-Well Optical Reaction Plates:  Applied Biosystems (P/N N801-0560) 
4. Plate Septa for 96-Well Plates:  Applied Biosystems (P/N 4315933) 
5. 96-Well Cooling Block:  Stored in the reagent freezer 
 
EQUIPMENT: 
 
1. CAS-1200  Corbett Robotics 
2. GeneAmp PCR System 9700 Thermal Cycler Applied Biosystems 
 
PROCEDURE: 
 
Note: Prior to preparing samples, the 9700 thermal cycler can be turned on so that the top plate can come 
to temperature. 
 
1. Remove the cover from the 96-well optical reaction plate that contains amplified samples. 
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2. Place the amplified sample plate on the C1 Sample plate area on the deck of the CAS-1200.  Place a 

new 96-well optical reaction plate on the C2 Reaction plate area on the deck of the CAS-1200. 
 
3. Create a master mix by combining the following volumes of reagents into a 5mL tapered tube: 
 

• 17.4uL formamide  x  (# of samples + 20%) 
 

• 0.6uL GeneScan-500 [LIZ]  x  (# of samples + 20%) 
 
 This mixture can be stored at 2-6oC for up to two weeks. 
 
4. Vortex the master mix.  Place the tube of master mix into Well A on the M1 (Mix Plate) deck on the 

CAS-1200.  See diagram for deck layout and proper tube placement. 
 
5. Place a 2mL flat tube containing ample AmpFlSTR IdentifilerTM ( MinifilerTM or YfilerTM) Allelic 

Ladder in Well A on the R1(Reaction Plate) deck on the CAS-1200.  Make sure the Ladder has been 
mixed (via vortexing) and spun down (in a microcentrifuge) prior to loading on the deck. 

 
6. Place a 1.5mL tapered tube containing at least 100uL formamide into Well I on the R1 (Reaction 

Plate) deck on the CAS-1200. 
 
7. Choose the “3130 Plate Set-up 2uL” protocol (or verify that this is the protocol that is currently open). 
 
8. Look at the C1 Sample Plate on the computer monitor.   
 

8A.  If you have more samples than are lit up with the colored indicators on the Sample 
Plate: 

 
Select the Sample Plate (there should be a red square around the plate). 
Highlight (click and drag) to add the extra wells that you need to correspond with the number of 
samples that were amplified, including the positive and negative controls (a red square around the well 
indicates that the well has been selected). 
Right click and select “Add selected wells to sample bank.” 

 
In the Update Sample Bank window, select “Existing bank” (the only choice is “Amplified samples 
Identifiler”).  Click “Add selection.”  The added wells should now light up with color indicators, and the 
Reaction Plate should automatically correlate with the Sample Plate.  There will be seven additional 
wells that are color indicated on the Reaction Plate:  1 for formamide only, 1 for master mix only, and 
2 for ladder (one in the first well and one in the last well). 

 
8B.  If you have fewer samples than are lit up with the colored indicators on the Sample 
Plate: 
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Select the Sample Plate (there should be a red square around the plate). 
Highlight (click and drag) to select the wells that you need to remove to correspond with the number of 
samples that were amplified, including the positive and negative controls (a red square around the well 
indicates that the well has been selected). 
Right click and select “Remove selected wells from sample bank.” 

 
In the Update Sample Bank window, click “Delete selection.”  The previously lit wells should turn 
clear, and the Reaction Plate should automatically be updated to correlate with the Sample Plate.  
There will be seven additional wells that are color indicated on the Reaction Plate:  1 for formamide 
only, 1 for master mix only, and 2 for ladder (one in the first well and one in the last well). 
 

9. Ensure that there are enough 50uL Tecan tips for the run: 
  
 Refill the tip racks in plate positions A2, B1, and B2 (if necessary).  Although plate position A1 is for 

200uL tips, 200uL tips are not used in this protocol.  If there are not enough tips for the run, the instrument 
will prompt you in the Checklist window when you attempt to start the run. 

 
To replace the tips, remove the empty tip rack from the tip rack holder on the instrument, and replace with a full 
rack of tips (the full tip rack will only seat one way on the tip rack holder).  Using the mouse, highlight (click and 
drag) the tip positions that are now available based on where the tips were just added.  Right click and choose “Set 
selected tips to ‘Available’”. 
 
10. To signal the CAS-1200 to begin the protocol, either click on the green dot with the arrow in it on the 

shortcut tool bar, or choose “Control” on the tool bar and select “Start.”  In the Checklist window, click 
on each message box, such that there’s an X in each box.  Verify that the tip disposal box is not too full 
(empty it, if necessary), and click OK. 

 
11. The CAS-1200 will now add the master mix, formamide blank, ladders and DNA samples to the 96-

well optical reaction plate. 
 

12. When the protocol has finished, the sample plate on C1 on the deck (the plate containing the original 
amplified samples) can be covered with a foil cover for freezer storage.   

 
13. Remove the reaction plate from the C2 deck position and place a plate septa mat on it.  Denature the 

samples by placing the plate in the 95oC heat block for three minutes.  Choose the protocol entitled 
Denature 21uL.  Important: Do not clamp down the cover plate of the 9700 onto the septa mat-
covered reaction plate as it will melt.  Simply slide the cover plate forward to cover the reaction plate 
without clamping it down.  
  

14. Chill the plate immediately in a freezer block for three minutes.  
 

15. Place the plate into a 3130 and 3100 Series 96-well plate base (it will only fit in one orientation) and 
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cover with a 3100 Genetic Analyzer 96-well plate retainer.  Check to ensure that the retainer clip is 
properly seated. 
 
Deck Layout Diagram 

             

 
 

 
 

 
16. Press the Tray button on the front of the 3130 CE instrument.  Once the autosampler has moved 

forward, open the doors and place the tray onto the autosampler with position A1 at the upper right.  
Close the instrument doors. 
 

17. To start a run on the 3130 Genetic Analyzer please see the Capillary Electrophoresis of 
Amplified Samples protocol. 

 
Select sample re-preparation using the CAS-1200: 
 
In order to re-prepare select samples from the 96-well plate of amplified samples, highlight all of the wells 
that you do not want re-prepared and delete them from the sample plate following step 8B. 
 

Master Mix 

(5mL tapered tube) 

Ladder (2mL flat 
tube) 

Formamide Sample plate      
(amplified DNA) 

Reaction plate 
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REFERENCES: 
 
CAS-1200 Liquid Handling System Manual 
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Method:  Decontaminating the CAS-1200 using the automated UV protocol  

Date: 04/01/2008        Approved by: SAM   
            _____ 
 
EQUIPMENT: 
 
1. CAS-1200  Corbett Robotics 
 
PROCEDURE: 
 
1. Remove the box of ejected tips and use the plug that is attached to the side of the tip ejector chute to 

plug the tip ejector chute.  
  

2. With the 3130 Plate Setup 2.8uL program open, click on the UV Light icon (the yellow light bulb). 
 

3. In the UV lamp control window, choose the length of time you wish the UV lamp to be active by 
sliding the flashing cursor right or left (a minimum of 5 minutes is recommended). 

 
4. Select Start. 

 
5. When the UV light operation has completed, click OK, unplug the tip ejector chute, and re-position 

the ejected tips box. 
 

REFERENCES: 
CAS-1200 Liquid Handling System Manual 
  

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 121 of 185 

 
 

Method:   Capillary Electrophoresis of Amplified Samples on the Applied Biosystems 
3130 Genetic Analyzer 

Date:  06/01/06   Revision Date:   07/25/2007  Approved by: SAM 
 
 
MATERIALS: 
 
ABI PRISM® 3130 Data Collection Software 
 
PROCEDURE: 
 
1. Launch the ABI Prism 3130 Collection Application.   
 
2. In the navigation pane of the Data Collection software click GA Instruments > ga3130 > Plate 

Manager.  Click NEW to open the New Plate dialog box.  Alternatively if a 3130 plate record (*.txt 
file) has been created using the SDPD Worksheet maker v2.2 it can be imported to the database by 
clicking on import in the Plate Manager then browsing for the appropriate file. 

 
3. Complete the information in the New Plate Dialog box (note: It is suggested that Plate Records be 

saved with analysts’ initials at the beginning of the name so that they can be located more easily in the 
database.) and hit OK.  The GeneMapper Plate Editor opens. 

 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a.  
b.   
a. GeneMapper Plate Editor:   In the Sample Name column of a row, enter a sample name, 

then click the next cell.  The value of 100 is automatically displayed in the priority column 

Plate Name (see above note) 

Description (optional) 

Application will be  

SDPD 3130A ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 122 of 185 

 
 

for the entered samples.  
 

 
 
b. An optional Comment column is available. 
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c. In the Sample Type column, select applicable sample type from the drop-down list.  In the 

Size Standard column, select CE_G5_HID_GS500 from the drop-down list.  In the Panel 
column, select Identifiler_v2 from the drop-down list.  In the Analysis Methods column, 
select SDPD Analysis Methods from the drop-down list.  Scroll across to the Results 
Group 1 column, select SDPD_Results_Group from the drop-down list.  In the 
Instrument Protocol 1 column, select the applicable protocol (e.g. 
SDPD_Identifiler_Protocol) from the drop-down list.  For all columns with the 
exception of Sample Type), fill down to select for all samples.  Note:  The 
SDPD_Identifiler_Protocol will be the standard protocol used in Identifiler analysis and is 
set with a 5 second injection.  See below for details on altered injection times and re-
injections. 

d. Click OK to save your changes and close the plate editor.  
 

Important: After clicking OK within the plate editor, the completed plate record is stored in the Plate 
Manager database.  Once in the Plate manager database, the plate record can be searched for, edited, 
exported, or deleted. 
 
4.  If you want to inject a sample more than once within a run: 

a. Select Edit > Add Sample Run.  Additional Results Group and Instrument Protocol 
columns are added to the right on the Plate Record. 

b. Complete the Results Group and Instrument Protocol columns for the additional 
injections.  Note:  If samples are slated to be injected more than once, subsequent 
injections of these samples will occur immediately after the first injection.  Click OK to 
save your changes and close the Plate Record.  

 
5. In the navigation pane of the Data Collection software click GA Instruments > ga3130 > 

SDPD3130A > Run Scheduler.  Click Find All or locate your plate record using the Search 
button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Locate your plate record in 
this window. 
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6. Link the plate record to the 3130 by highlighting your pending plate record, then double-clicking on 
the yellow plate (B:).  A “B” will appear to the left of the linked plate record and the plate will turn 
green. 

 

 
  
7. Once the plate is linked, the run can be started by clicking the green arrow ►.  If desired, the oven can 

be preheated in GA Instruments > ga3130 > SDPD3130A > Manual Control prior to starting 
the run.  To turn the oven on you must first send the command to turn the oven on followed by 
sending the command to heat the oven to 60oC. 

  
8. After the run is complete and you determine that re-injections are necessary you may do the following 

to start those re-injections. 
a. Locate you plate record in the plate record manager (GA Instruments > ga3130 > 

Plate Manager) and click Edit. 
b. Select Edit > Add Sample Run.  Additional Results Group, Instrument Protocol 

columns are added to the right on the plate record. 
c. Complete the Results Group and Instrument Protocol columns for the additional 

injections.  Note:  If altered injection times are desired instrument protocols have been 
created for 3 second and 1 second injection times.  These can be selected from the drop-
down menu.  If an injection time other than 3 or 5 seconds is required, a new Protocol will 
have to be created.  Click OK to save your changes, and then close the plate record. 

d. Complete steps 5 and 6 to initiate the re-injection run. 
 
9. When the run is complete: 

Link 
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• Rename the Run Folder uniquely and move it into the individual Analyst’s Folder on the FB 
network [H:3130-310 Run Folders\Analyst folder)] prior to any analysis. 

 
REFERENCES: 
ABI PRISM® 3130 Genetic Analyzer User’s Manual 
ABI PRISM® 3130 Genetic Analyzer Getting Started Guide 
ABI PRISM® 3130 Genetic Analyzer User’s Bulletin 
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Method:  Performing a Spectral Calibration on the Applied Biosystems 3130 Genetic 
Analyzer 

Date:  06/01/2006   Revision Date:   03/01/2010  Approved by: SAM  
              
 
INTRODUCTION: 
A spectral calibration creates a “matrix” that is used during a run to spectrally separate the raw data from 
the instrument into the 5-dye components saved to the sample files.  (Note: on the 3130, the spectral is 
applied to the raw data in real-time whereas on the 310s the matrix is applied upon analysis).  A spectral 
calibration should be performed: 
 

• If a decrease in spectral separation (pull-up and/or pull-down) is observed 
• After the laser or CCD camera has been realigned or replaced by a service engineer  

 
REAGENTS: 
1. HIDI Formamide: Applied Biosystems (P/N 4311320) 
 

Dispense the formamide into 500ul aliquots and store frozen.  The frozen formamide can be used 
up to 1 year after being aliquoted.  

 
Caution:  Formamide is a known teratogen and is harmful by inhalation, skin contact, and 
ingestion.  Use in a fume hood and wear chemical resistant gloves and safety glasses when handling. 

 
2. DS-33 Matrix Standards (Dye Set G5):  Applied Biosystems (P/N 4345833) 

Store at 2 to 8oC, protected from light.  Stable for one year. 
(This is the matrix standard set used when analyzing amplified DNA fragments generated using the 
Indentifiler kit, and labeled with 6FAM-, VIC-, NED-, PET-, and LIZ-) 

 
MATERIALS: 
1. 96-Well Optical Reaction Plates: Applied Biosystems (P/N 4306737) 
2. Plate Septa for 96-well:Applied Biosystems (P/N 4315933) 
3. MicroAmp Splash free Support Base PE Applied Biosystems (P/N 4312063) 
4. 96-well cooling block: Stored in the reagent freezer 
 
PROCEDURE: 

Preparing the Spectral Calibration Chemistry 
 

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 127 of 185 

 
 

1. Remove DS-33 Matrix Standard tube from the refrigerator, vortex to mix, then spin briefly in a 
microcentrifuge. 

 
2. For a 36cm array, combine 5-7uL of standard with 193-195uL formamide (for a total volume of 200uL) 

in a 1.5mL microfuge tube.  Vortex to mix, then spin briefly in a microcentrifuge. 
 
3. Aliquot 10uL of standard/formamide mix into 4 wells (sugg: A1-D1) of a 96-well optical reaction 

plate. 
 
4. Place a 96-well septa mat onto the reaction plate, and place the reaction plate in the 9700 thermal 

cycler. 
 
5. Denature the samples by running the spectraldenature protocol.  Important: Do not clamp down 

the cover plate of the thermal cycler on the septa covered reaction plate as it will melt.  Simply slide the 
cover plate forward to cover the reaction plate without clamping it down. 

 
6. After the denaturation protocol is finished, chill the reaction plate immediately in the 96-well cooling 

block (-20oC) for two minutes.  
 
7. Place the reaction plate into a 3130 base plate (it will only fit in one orientation) and secure a plate 

retainer on top of the reaction plate.  Check to ensure that the retainer clip is properly seated. 
 
8. Press the Tray button on the exterior of the 3130 Genetic Analyzer.  When the tray presents itself, 

open the doors of the instrument and place the tray onto the right side position of the autosampler (the 
tray will fit on the autosampler in one orientation only).  Close the instrument doors. 

 
Performing a Spectral Calibration  
 
1. In the navigation pane of the Data Collection software, click: GA Instruments>ga3130>Plate 

Manager. 
 
2. Click New.  The New Plate Dialog box opens.  Enter the details shown below (add the appropriate 

date to the name): 
 ARCHIV
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3. Click OK. 
 
4. The Spectral Calibration Plate Editor dialog box opens. 
 

• In the Sample Name column of A01, enter sample name (e.g. G5MatrixStd) 
• Click on the Comment cell.  The value 100 automatically displays in the Priority column 
• In the Instrument Protocol 1 column, select the spectral instrument protocol G5Spectral 

from the drop-down menu 
• Highlight the entire row and select Edit > Fill Down Special.  The software automatically 

fills in the appropriate well numbers (i.e. A1-D1) 
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Click OK. 
 

5. In the navigation pane of the Data Collection software, click: 

GA Instruments > ga3130 > SDPD3130A > Run Scheduler > Plate View. 
 
6. Search for your plate record.  Select Barcode in the Type of Search drop-down list and type in the 

plate name then click Search.  The plate record will appear in the lower box.  Alternatively, you can 
select Find All and all previous plate records will appear.  (You can also perform an Advanced 
search for the plate record.  See page 41 of the Applied Biosystems 3130/3130xl Genetic Analyzers 
Getting Started Guide.) 

  
7. Highlight the desired plate record and then click on the plate position indicator to the right to link the 

plate.  The plate map color will change from yellow to green when it is successfully linked and a “b” 
will appear beside the linked plate record. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. In the toolbar of the Data Collection software window, click ► to begin the run. 
 
9. The Processing Plates dialog box opens.  Click OK.  The Spectral Calibration run time is 

approximately 35 min. 
 
10. After the run, the pass or fail status of each capillary is recorded in the Event Log section of the 

Instrument Status window: 
• Click GA Instruments > ga3130 > SDPD3130A > Instrument Status > Event 
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Log. 
• Event Messages will indicate whether or not each capillary was successfully calibrated. 
• Each capillary should have a Q-value above 0.95 and a Condition Number in the range 

7 to 12. 
 
Evaluating the Spectral Calibration Data 
 
Note:  the spectral calibration of each capillary should be evaluated even if the Spectral Calibration Results 
box indicated that they passed.  If the spectral calibration failed, see the Applied Biosystems 3130/3130xl 
Genetic Analyzers Maintenance, Troubleshooting and Reference Guide. 
 
1. Click GA Instruments > ga3130 > SDPD3130A > Spectral Viewer. 
 

 
 
2. Select G5 from the Dye Set drop-down list (if it is not already displayed). 
 
3. In the plate diagram, dark green boxes should be present at A1-D1.  The dark green boxes confirm 

that the four capillaries passed the spectral calibration.  Tan colored boxes in the plate diagram indicate 
failed spectral calibration. 

 
4. Select a well in the plate diagram.  The dark green box will turn light green, and the spectral profile 

and raw data corresponding to that well/capillary will be displayed.  No spectral profile will be 
displayed if the spectral calibration failed.  Evaluate each well/capillary for the following: 
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a. Verify that the order of the peaks in the spectral profile from left to right are:   Blue-
Green-Yellow-Red-Orange [In the top window] 

b. Verify that the order of the peaks in the raw data from left to right are: Orange-Red-
Yellow-Green-Blue [In the bottom window] 
 

5. Verify that the peaks in the spectral profile do not contain gross overlaps, dips or other irregularities 
 
6. The spectral run name will default to the day, date and time of the run.  The name may be changed by 

clicking Rename.    
 
Activating the Spectral Calibration 
Note:  a run cannot start unless a calibration file that matches the dye set and capillary array length to be 
used for the run is active. 
 
1. In the navigation pane of the Data Collection software, click:  GA Instruments > ga3130 > 

SDPD3130A > Spectral Viewer. 
 
2. Select G5 from the Dye Set drop-down menu. 
 
3. Select a spectral calibration from the List of Calibrations. 
 
4. Click Set. 
 
Evaluating a Spectral 
The manufacturer’s engineering specifications state that pull-up between 1-5% is within tolerable limits.  In 
general the average pull-up expected is approximately 3% with some outliers being around 5%.  If the 
average pull-up observed is in excess of 3%, a new spectral should be created.  If the average pull-up 
observed is consistently above 5%, even after attempts at new spectrals, it may indicate a problem with the 
instrumentation and the DNA Technical Manager needs to be informed. 
 
REFERENCES: 
1. Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide. 
2. Applied Biosystems DS-33 (Dye Set G5) Matrix Standard Kit product insert 
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Method:  Performing a Spatial Calibration on the Applied Biosystems 3130 Genetic 
Analyzer 

Date:  06/01/2006  Revision Date:   01/01/2007  Approved by: SAM 
            _____ 
 
INTRODUCTION: 
 
The 3130 Genetic Analyzer Data Collection software uses images collected during the spatial calibration to 
establish a relationship between the signal emitted by each capillary and the position where the signal is 
detected on the CCD camera.  A spatial calibration should be performed when you: 
 

• Install or replace a capillary array 
• Temporarily remove the capillary array from the detection block 
• Move the instrument 

 
PROCEDURE: 
 
Creating a Spatial Calibration file 
 
1. In the navigation pane of the Data Collection software, click: GA Instruments > ga3130 > 

SDPD3130A > Spatial Run Scheduler. 
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2. In the Spatial Protocol section, select one of the following: 
 

• Protocol > 3130SpatialNoFill_1, if the capillary contains fresh polymer, otherwise select; 
• Protocol > 3130SpatialFill_1 
 

(Note:  you do not need to fill the capillaries each time you perform a spatial calibration.) 
 
3. Click Start. 
  

The calibration run lasts approximately: 
 
• 2 min. without filling the capillaries, or; 
• 6 min. when filling the capillaries 
 

(Note:   the spatial profile window turns black when you start a spatial calibration.) 
 

Evaluation the Spatial Calibration file 
 
1. Evaluate the spatial calibration profile using the following criteria: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Peak Attribute Acceptable Criteria 

Height Similar height for all peaks. 

Orange crosses One orange cross marking the top of every peak.  No 
misplaced crosses. 

Shape Single sharp peak for each capillary. 
Small shoulders are acceptable. 

Spacing The difference between adjacent positions is 13 to 16 
pixels.  Theoretical spacing between capillaries is 15. ARCHIV
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2. Examine each row in the 4 Capillary Positions table and verify that the values in both the Left spacing 

and Right spacing columns range between 13 and 16 pixels.  The “+” sign denotes the top of each peak.  
If a “+” is out of alignment, it may be manually moved as follows:  

 
 To move the cross: 
 Type a new value in the Positions (pixels) box for the capillary of interest. 

Click outside of the box or press Enter. 
 

 
 
Accepting or Rejecting a Spatial Calibration 
 
Based on the above criteria (Height, + position, shape, and spacing), if the calibration: 
 

• Passed, click Accept to write the calibration data to the database and .ini file.  This will 
irrevocably replace the current spatial file. 

• Failed, click Reject then see the Applied Biosystems 3130/3130xl Genetic Analyzers Maintenance, 
Troubleshooting and Reference Guide. 
 

 
 

 
 
 
 
 
 
 
REFERENCES: 
 
Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide. 
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Method:  Flushing and Filling the Water Trap on the Applied Biosystems 3130 Genetic 
Analyzer 

Date:  06/01/2006   Revision Date:   01/01/2007  Approved by: SAM  
            _____ 
 
INTRODUCTION: 
The PDP water trap at the top of the pump block should be flushed with distilled or deionized water once a 
week to remove any diluted polymer and to clear air bubbles.  The trap should be filled with water at all 
times. 
 
MATERIALS: 
1. A 20mL syringe, preferably the all-plastic Luer lock syringe (Applied Biosystems P/N 4324463) that 

was supplied with the instrument. 
 

(Note:  syringes smaller than 20mL should not be used, as they may generate excessive pressure within the 
trap.) 
 
2. Distilled or deionized water. 
 
PROCEDURE: 
 
1. Fill the syringe with nanopure water. 
 
2. Attach the syringe to the forward-facing Luer fitting at the top of the pump block.  Hold the fitting 

with one hand while threading the syringe onto the fitting clockwise with the other hand.  
 
3. Open the Luer fitting by grasping the body of the fitting and turning it and the attached syringe 

approximately one-half turn counterclockwise. 
 
4. Open the exit fitting at the top left side of the pump block by turning it approximately one-half turn 

counterclockwise. 
 
5. Hold an empty tube or beaker under the exit fitting to receive approximately 5mL of flushed water 

waste.  Flush the trap by pushing steadily on the syringe plunger.  
 
(Note:  do not use excessive force.  Take approximately 30 seconds to flush 5mL.) 
 
6. Once flushing is complete, re-tighten Luer fittings and remove the syringe. 
 
REFERENCES: 
 
Applied Biosystems 3130/3130xl Genetic Analyzers Getting Started Guide. 
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Method:   GeneMapper IDTM Analysis of Data 

Date:  06/01/2006    Revision Date:   04/01/2011  Approved by: SAM  
            _____ 
 
INTRODUCTION: 
 
GeneMapperTM ID software is an automated genotyping software package that combines the precision-sizing 
capabilities of the GeneScan® Analysis software with the allele-calling power of Genotyper® software, but 
includes additional features and enhancements.  The software will genotype samples based on allelic bin 
definitions stored within the Panel Manager.  The AmpFlSTR panels and bins are pre-installed in the Panel 
Manger within the software.  Custom SDPD Analysis Methods have also been created in the GeneMapper 
Manager for use in analyzing raw data files for Identifiler Plus, Identifiler, Yfiler,  and Minifiler amplifications, 
respectively.  An analysis method defines the analysis parameters to be used for the analysis of samples imported 
into the Project Window.  When the GeneMapperTM ID software is installed on any computer, the Panel, Bin 
Set and Analysis Method have to be defined prior to the analysis of raw data files.  See also the procedure for 
importing panels and bins. 
 
MATERIALS: 
 
Applied Biosystems GeneMapperTM ID Software  
 
PROCEDURE: 
 
1. Open the GeneMapperTM ID software by clicking on the icon located on the computer’s desktop and 

log-in.  Using the drop-down menu select your user ID as the User Name.  The password is case 
sensitive.  Upon successful log-in the Project Window will open.  The project window is the primary 
window for the user interface. 

  
2. To add samples to the Project Window.  Select File>Add Samples to Project. 

For samples run on the 3130:  
• Navigate to Forensic Biology on FB server H:\3130-310 Run Folders to locate the desired run 

folder. 
• Select the desired run folder and click Add To List.  The selected folder will appear in the 

Samples To Add box on the right. Note:  Multiple run folders can be added to the same project.  
Click Add to import the files into the project and close the dialog box. 

3. For each sample within the Project Window select the appropriate Sample Type, Analysis 
Method, Panel, Size Standard, and Matrix (if appropriate).  Unknowns should be designated 
Sample, Allelic Ladders should be designated Allelic Ladder, the positive PCR control should be 
designated as Positive Control, and any reagent blanks, amplification blanks, or formamide blanks 
should be designated as Negative Controls.   
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For Identifiler Plus analyses, the analysis method will be ID-X Identifiler Plus, the panel will be 
Identifiler_Plus_Panels_v1, and the size standard will be CE_G5_Identifiler_Plus_GS500. 
 
For Identifiler analyses, the analysis method will be SDPD v2 Analysis Method, the panel will be 
Identifiler_v2, and the size standard will be CE_G5_HID_GS500.   
 
For Minifiler analyses, the analysis method will be Minifiler Analysis Method, the panel will be 
Minifiler_GS500_v1, and the size standard will be CE_G5_HID_GS500.    
 
For Yfiler analyses, the analysis method will be SDPD Yfiler Analysis Method, the panel will be 
Yfiler_v2, and the size standard will be CE_G5_HID_GS500.   
 
Samples run on the 310s will require a Matrix file, samples run on the 3130 will not require a Matrix 
file as the Spectral is applied to the sample in real time on the 3130.   

 
Note:  In general, analysis parameters will not change with the exception of the analysis range which will be 
dependent on the electrophoresis of each run. 
 
4. Click ► (Analyze), and the Save project dialog box opens.  Save the project with a uniquely identifying 

name [e.g. initials(Case #)].  After analysis, the project is automatically saved, and the Genotypes Tab 
becomes available.  Analyzing the data sizes and genotypes the samples in the project.  There must be at 
least one ladder in each run folder analyzed for the analysis to be successful. 

  
5. Accurate application of the size standard to the samples can be verified in a variety of ways.  Using the 

Process Component Quality Values (PQVs) such as the Sizing Quality flag is an efficient method of 
verifying the sizing of individual samples.  In the Samples tab of the Project Window the sizing quality 
of each sample is displayed as a symbol (■ = Pass, ▲= Check sizing for problems, or ● = Low 
Quality, sizing failed).  Alternatively, individual or multiple samples can be selected in the project 
window and the Size Match Editor used to view the size standard for each sample.  It is possible to 
overwrite the Sizing Quality PQV in this window for individual samples.  This could be done, for 
example, if the 450bp size standard peak was not detected for a particular sample, but it was 
determined that the absence of this standard would not affect the sizing of any peaks within the sample. 

 
6. The migration of the samples within the run can also be verified in a number of ways.  For Identifiler, 

Minifiler, and Yfiler, one method is to select all the samples within the Project Window and then 
select Display Plots.  From the plot settings drop-down menu, select Overlay Liz.  Using the 
cursor, zoom in on the 250bp peak in the plot window, and select all the 250bp peaks by clicking 
within them. Select View>Table Filter>Show Selected Rows (or press CTRL+S).  The 250bp 
peak should size consistently and overlap.  The difference in the migration of this fragment should be 
<1bp across the entire run.  Note: If it is >1bp the project may require some troubleshooting to obtain 
reliable genotyping of the samples.  Close the sample plot. 

 
7. The individual sample files can be reviewed and printed for the analytical record.  If needed, labels can 
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be edited within the samples.  To edit labels, select the labeled peak to be edited.  With the desired 
peak highlighted, right-click and select the applicable option of changing or deleting the label.  An Edit 
Allele Comment dialog box will open and a reason for the change can be input.  Sample plots with 
edited labels should be printed for the analytical record with the edit displayed in the plot and with the 
Allele Edit Comment displayed in the Table. 

 
8. PQVs can be used to assess the quality of a variety of aspects of each sample.    Below is a list of some of 

the PQVs that can be used to assist in the analysis of the sample data: 
OS =  Off-Scale data.  If off-scale data is present in the sample, ▲ is automatically displayed 

within the size standard region of the signal.  Otherwise a ■ is displayed 
SQ =  Sizing Quality.  The sizing quality is calculated based on the similarity of the size standard 

fragment pattern and the actual size standard peak distribution pattern in the sample. 
AE = Allele Edit.  This box will be checked when the marker allele calls have been edited. 
ADO= Allele Display Overflow.  This box is checked when the number of alleles at any locus 

exceeds the number that can be displayed (this number is selected by the user. 
AN = Allele Number.  ▲ is automatically displayed when the number of alleles at any locus is 

greater than the user defined expected allele number.  Note:  Currently set to 4 in the 
SDPD Analysis Method. 

Bin= Out of Bin Allele.  ▲ is automatically displayed when the apex of a called peak is outside 
the boundary of a bin. 

PHR = Peak Height Ratio.  ▲ is automatically displayed when there are two alleles present at any 
locus and the ratio between the lower allele height and the higher allele height is below the 
user defined threshold.  Note:  Currently set to 0.6 in the SDPD Analysis Method. 

LPH = Low Peak Height.  ▲ is automatically displayed when alleles are lower than the specified 
values and do not result in the proper intensity.  Note:  Currently set to 200rfu for 
homozygotes and 75rfu for heterozygotes in the SDPD Analysis Method. 

SPU = Spectral Pull-up.  ▲ is automatically displayed when any locus displays pull-up.  Pull-up is 
defined by the system to be when the height of a labeled peak is less than 5% of any larger 
peak within +/- 1 data point.  

BP =  Broad Peak. ▲ is automatically displayed when the peak width of a labeled peak is wider 
than 1.5bp. 

SP =  Split Peak.  ▲ is automatically displayed when the GeneMapperTM ID software detects a 
split peak. 

CC =  Control Concordance.  ▲ is automatically displayed when the result for any positive 
control sample does not match the defined alleles for any locus.  ▲ is also automatically 
displayed when peaks are detected in negative controls. 

GQ = Genotype Quality.  Is an overall assessment of the quality of an individual locus based on a 
mathematical formula using the previously mentioned PQVs as variables.  The user can 
define the weights applied to the above PQVs in this formula in the Analysis Method. 

 
Note:  Other PQVs exist but not all are applicable to human identification testing.  For more information 
please see the GeneMapperTM ID software user’s guide. 

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 139 of 185 

 
 

 
9. When the analysis of the GeneMapperID project is completed the project file should be exported to the 

appropriate folder on the Forensic Biology network.  To export the project: highlight the project in the 
Projects tab in GeneMapper Manager and click the Export button.  Browse for the appropriate 
folder on the network (Forensic Biology on FB server (H:)>GeneMapper ID 
Projects>Analysts folder) and save the exported project using the Project name.  Use of analysts 
initials at the start of the file name will be useful in locating projects as the number of files increases and 
is highly recommended [e.g. inits(XX-XXXXXX;etc)] .   

 
10. The original project should be deleted from the GeneMapperID database once the project is exported.  

To delete the original project:  highlight the project in the Projects tab in GeneMapper Manager 
and click the Delete button.  Prior to deleting the project it is recommended to check that the file was 
exported to the appropriate folder. 

 
11. To view exported GeneMapperID projects.  Open GeneMapper Manager and from the Projects 

tab click Import.  Browse to Forensic Biology on FB server (H:) > GeneMapper ID Projects 
and select the desired project.  Click OK.  The project will have been imported to the GeneMapperID 
database and can be opened as usual.  When the imported project is no longer needed it should be 
deleted from the database (see step 10.). 

 
REFERENCES: 
AmpFlSTR IdentifilerTM PCR Amplification Kit User’s Manual 
AmpFlSTR YfilerTM PCR Amplification Kit User’s Manual 
AmpFlSTR MinifilerTM PCR Amplification Kit User’s Manual 
PowerPlex®Y Amplification Kit User’s Manual 
GeneMapperTM ID Software version 3.1 User Manual. 
GeneMapperTM ID Software Tutorial. 
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Method:  Importing Panel and Bin Definitions into GeneMapperTM ID Software  

Date:  06/01/2006   Revision Date:   02/06/2009  Approved by: SAM  
            _____ 
 
INTRODUCTION: 
 
The GeneMapperTM ID software will genotype samples based on allelic bin definitions stored within the 
Panel Manager.  Custom SDPD Analysis Methods have also been created in the GeneMapper Manager for 
use in analyzing raw data files for Identifiler, Minifiler, and Yfiler amplifications, respectively.  An analysis 
method defines the analysis parameters to be used for the analysis of samples imported into the Project 
Window.  When the GeneMapperTM ID software is installed on any computer, the Panel, Bin and Analysis 
Method have to be defined prior to the analysis of raw data files.  Follow the procedure below to import 
panel and bin definitions. 
 
MATERIALS: 
 
Applied Biosystems GeneMapperTM ID Software  
 
PROCEDURE: 
 
1. Open the GeneMapperTM ID software by clicking on the icon located on the computer’s desktop and 

log-in.  Using the drop-down menu select SDPD as the User Name.  The password for the 
GeneMapperTM ID software on all instruments and computers is “sdpdfb”.  The password is case 
sensitive.  Upon successful log-in the Project Window will open.  The project window is the primary 
window for the user interface. 

 
2. Open the Panel Manager by selecting Tools>Panel Manager.  
  
3. In the navigation pane select Panel Manager.  From the File menu select Import Panels.  This will 

open the Import Panels dialog box. 
 
4. In the Import Panels dialog box select AmpFlSTR_Panels_v2.txt for Identifiler analysis, 

AmpFlSTR_Yfiler_Panel_v2.txt for Yfiler analysis, or 
AmpFlSTR_Minifiler_GS500_Panels_v1.txt  for Minifiler analysis and click Import. 

 
5. In the navigation pane select the AmpFlSTR_Panels_v2 folder for Identifiler analysis, 

AmpFlSTR_Yfiler_Panel_v2 folder for Yfiler analysis, or 
AmpFlSTR_Minifiler_GS500_Panels_v1.txt  for Minifiler analysis.  From the File menu select 
Import Bin Set.  The will open the Import Bin Set dialog box. 

 
6. In the Import Bin Set dialog box select AmpFlSTR_Bins_v2.txt for Identifiler analysis, 

AmpFlSTR_Yfiler_Bin_v2.txt for Yfiler analysis, or AmpFlSTR_Minifiler_GS500_Bins_v1.txt 
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for Minifiler analysis and click Import.  To complete this process click OK or Apply. 
 
Note:  The panel and bin definitions can be viewed while in the Panel Manager by selecting the desired 
panel (e.g. Identifiler_v1) in the navigation pane and expanding it so that the individual loci can be viewed.  
Once a locus is selected, the bin definitions are visible in the right pane. 
 
REFERENCES: 
AmpFlSTR IdentifilerTM PCR Amplification Kit User’s Manual 
AmpFlSTR YfilerTM PCR Amplification Kit User’s Manual 
AmpFlSTR MinifilerTM PCR Amplification Kit User’s Manual 
GeneMapperTM ID Software version 3.1 User Manual. 
GeneMapperTM ID Software Tutorial. 
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Method:    AmpFlSTR Identifiler Interpretation Thresholds  

Date:   06/01/2004     Revision Date:   08/14/2009  Approved by: SAM  
            _____ 
 
• A peak detection threshold of 75rfu will be used for analysis of AmpFlSTR Identifiler data.  Peaks 

below 75rfu are not reported. 
• Homozygous allele peaks are often approximately twice the height of heterozygous allele peaks as a 

direct result of allele dosage. 
• At heterozygous loci, the ratio of the height of the shorter peak to the height of the higher peak is 

generally above 60% (see Peak Height Ratio validation study).  Occasionally, however, heterozygous 
allele peak pairs may be outside this range. 

• n-4bp stutter peaks will be filtered by the software when they are below the percent cutoff value for a 
locus.  The stutter cutoff values used by the software are presented below:   

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
• The homozygote peak height threshold is the level of detection of a DNA peak where an analysts may 

have confidence that the detected allele is a true homozygote and does not have an undetected peak that 
it is paired with.  Our validation efforts determined that both alleles of a heterozygote pair will be 
detected when one of the alleles reaches at least 200rfu (>99% of the time).  When evaluating an 
apparent single source evidence profile, care should be taken when interpreting a single DNA peak 
below 200rfu as allelic drop-out may have occurred.   
 

Mixtures 
• A mixed DNA profile will have more than two alleles present at a locus, and/or a significant imbalance 

in peak height between peaks at a locus.  Generally, evidence of a mixed DNA sample exists at multiple 

Marker Stutter Cut-off Value 
D8S1179 8.2% 
D21S11 9.4% 
D7S820 8.2% 
CSF1PO 9.2% 
D3S1358 10.7% 

TH01 5.1% 
D13S317 8.0% 
D16S539 10.4% 
D2S1338 11.1% 
D19S433 13.3% 

vWA 12.6% 
TPOX 4.8% 

D18S51 17.0% 
D5S818 6.8% 

FGA 14.7% ARCHIV
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loci. 
• In most cases involving DNA mixtures in which biological fluids have been identified, caution is 

warranted in attributing a particular biological fluid to one of the DNA contributors in the mixture, as 
either source could be the origin of that body fluid in question (sperm fractions involving male:female 
mixtures may be an exception).  Instead, the presence of the body fluid will be noted in the report and 
a statement given as to whether the subject is included or excluded as one of the potential sources of the 
DNA mixture. 

• Please refer to the “Autosomal STR Interpretation Guidelines” for additional information with regards 
to mixtures. 

 
Probability of Identity using the Applied Biosystems Identifiler kit. 
 
The Probability of Identity (PI) [Sensabaugh 1982] is the probability that two individuals selected at random 
will have an identical Identifiler kit genotype.  For the Identifiler kit the PI are as follows: 
    

1 in 200 quadrillion in the U.S. Caucasian population, 
   1 in 760 quadrillion in the African American population, 
   1 in 130 quadrillion in the Hispanic population. 
 
The PI expresses the average 15 locus DNA profile frequencies using the Applied Biosystems Identifiler kit.  
This data was taken from the Identifiler user’s manual page 4-55. 
 
REFERENCES: 
SDPD Identifiler Validation studies 
AmpFlSTR® IdentifilerTM User’s Manual 
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Method:    AmpFlSTR Identifiler Plus Interpretation Thresholds  

Date:   04/01/2011           Approved by: SAM  
            _____ 
 
• A peak detection threshold of 50rfu will be used for analysis of AmpFlSTR Identifiler Plus data.  Peaks 

below 50rfu are not reported, but can be used qualitatively to determine the possible presence of a 
mixture. 

• Homozygous allele peaks are often approximately twice the height of heterozygous allele peaks as a 
direct result of allele dosage. 

• At heterozygous loci, the ratio of the height of the shorter peak to the height of the higher peak is 
generally above 60% (see Table below), however, peak height ratios tend towards larger imbalances as 
the height of the tallest peak decreases toward the stochastic threshold. 
 

Max. 
PH 

Min. 
Ratio 

Avg. 
Ratio 

Std. 
Dev. 

0-100 33.33 71.94 16.81 
100-200 22.16 66.97 18.92 
200-300 21.29 68.89 20.64 
300-400 21.50 73.93 20.11 
400-500 49.21 83.61 12.41 
500-600 52.88 87.15 10.83 
600-700 57.72 88.25 8.25 
700-800 62.91 89.35 8.52 
800-900 48.30 86.52 9.12 

900-1000 66.73 86.91 8.04 
1000+ 63.32 88.10 7.40 

 
• n-4bp stutter peaks will be filtered by the software when they are below the percent cutoff value for a 

locus.  The stutter cutoff values used by the software are presented below:   
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Marker Stutter Cut-off Value 
D8S1179 10.32% 
D21S11 10.67% 
D7S820 9.69% 
CSF1PO 9.2% 
D3S1358 12.27% 

TH01 4.08% 
D13S317 9.93% 
D16S539 10.39% 
D2S1338 12.44% 
D19S433 11.21% 

vWA 12.45% 
TPOX 6.38% 

D18S51 13.68% 
D5S818 10.06% 

FGA 13.03% 
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• Validation efforts have established the stochastic thresholds (or homozygote peak height threshold) 

above which both alleles of a heterozygote pair will most likely be detected.  When evaluating an 
evidence profile, care should be taken when interpreting DNA peaks less than the designated rfu values 
as allelic drop-out may have occurred. 
 
 
 

 
 
 
Probability of Identity using the Applied Biosystems Identifiler Plus kit. 
 
The Probability of Identity (PI) [Sensabaugh 1982] is the probability that two individuals selected at random 
will have an identical Identifiler kit genotype.  For the Identifiler kit the PI are as follows: 
    

1 in 200 quadrillion in the U.S. Caucasian population, 
   1 in 760 quadrillion in the African American population, 
   1 in 130 quadrillion in the Hispanic population. 
 
The PI expresses the average 15 locus DNA profile frequencies using the Applied Biosystems Identifiler kit.  
This data was taken from the Identifiler user’s manual page 4-55. 
 
REFERENCES: 
SDPD Identifiler Validation studies 
AmpFlSTR® IdentifilerTM Plus User’s Manual 
  

≤5 second injection 200rfu 
7 second injection 280rfu 

10 second injection 400rfu 
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Method:    AmpFlSTR Minifiler Interpretation Thresholds  

Date:   07/25/2007   Revision Date: 08/14/2009   Approved by: 
SAM  

            _____ 
 
• A peak detection threshold of 75rfu will be used for AmpFlSTR Minifiler data.  Peaks below 75rfu are 

not reported. 
• Homozygous allele peaks are often approximately twice the height of heterozygous allele peaks as a 

direct result of allele dosage. 
• At heterozygous loci, the ratio of the height of the shorter peak to the height of the higher peak is 

generally above 78% (see Peak Height Ratio validation study).  Occasionally, however, heterozygous 
allele peak pairs have been observed with an imbalance as low as 35%. 

• n-4bp stutter peaks will be filtered by the software when they are below the percent cutoff value for a 
locus.  The stutter cutoff values used by the software are presented below:   
 

 
 
 
 
 
 
 
 
 
 
 
Apparent Single Source Samples 
• An apparent single source profile consists of no more than two relatively balanced alleles at each locus.  

(Single source samples with three allele peaks at a single locus have been reported, though are 
extremely rare.) 

• Allelic dropout is a phenomenon observed commonly when amplifying low levels of DNA, and is 
defined as having only one allele of a heterozygote pair (or possibly no alleles) detected above the peak 
detection threshold at a given locus.  Our validation efforts determined that both alleles of a 
heterozygote pair will be detected when one of the alleles reaches at least 450rfu (>99% of the time, 
however allelic drop-out was observed when the larger peak was approximately 680rfu).  When 
evaluating an apparent single source evidence profile, care should be taken when interpreting a single 
DNA peak below 450rfu as allelic drop-out may have occurred.  As a conservative measure of 
interpreting inclusions, when single allele peaks are detected below 450rfu at any locus, that locus 
(those loci) will be excluded from the calculation.  In an apparent single source sample, when two 
alleles are present at a locus below 450rfu, those alleles may be used in a statistical calculation, as allelic 
drop-out is not a concern. 

Marker Stutter Cut-off Value 
D13S317 14.0% 
D7S820 11.0% 

D2S1338 18.0% 
D21S11 16.0% 

D16S539 15.0% 
D18S51 18.0% 
CSF1PO 14.0% 

FGA 15.0% 
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Mixtures 
• A mixed DNA profile will have more than two alleles present at a locus, and/or a significant imbalance 

in peak height between peaks at a locus.  Generally, evidence of a mixed DNA sample exists at multiple 
loci. 

• In most cases involving DNA mixtures in which biological fluids have been identified, caution is 
warranted in attributing a particular biological fluid to one of the DNA contributors in the mixture, as 
either source could be the origin of that body fluid in question (sperm fractions involving male:female 
mixtures may be an exception).  Instead, the presence of the body fluid will be noted in the report and 
a statement given as to whether the subject is included or excluded as one of the potential sources of the 
DNA mixture. 

• Please refer to the “Interpreting DNA Mixtures” protocol for additional information with regards to 
mixtures.  In general, due to the increased imbalance observed in single source samples with the 
Minifiler kit, analysts should use a more conservative approach when interpreting mixed DNA samples 
generated with the Minifiler amplification kit. 

 
Probability of Identity using the Applied Biosystems Minifiler kit. 
 
The Probability of Identity (PI) [Sensabaugh 1982] is the probability that two individuals selected at random 
will have an identical Identifiler kit genotype.  For the Identifiler kit the PI are as follows: 
    

1 in 12 billion in the U.S. Caucasian population, 
   1 in 15 billion in the African American population, 
   1 in 4.8 billion in the Hispanic population. 
 
The PI expresses the average 8 locus DNA profile frequencies using the Applied Biosystems Minifiler kit.  
This data was taken from the Identifiler user’s manual page 5-46. 
 
REFERENCES: 
SDPD Minifiler Validation studies 
AmpFlSTR® MinifilerTM User’s Manual 
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Method:    AmpFlSTR Yfiler Interpretation Guidelines  

Date:   07/25/2007          Approved by: SAM   
            _____ 
 
• A peak detection threshold of 100rfu will be used for AmpFlSTR Yfiler amplification kit.  Peaks below 

100rfu are not reported. 
• n+3bp stutter products have been observed in the DYS392 locus and n-2/n+2bp stutter at DYS19 in 

the AmpFlSTR Yfiler system.  The GeneMapperID software product does not currently have the 
capacity to filter such stutter products, but data for these artifacts is contained within the validation 
studies.  The stutter cutoff values used by the software are presented below: 
  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Apparent single source profiles 
• An apparent single source Y-STR DNA profile (or haplotype) consists usually of one allele at each Y-

STR locus, except for DYS385 where gene duplication results in two alleles.  (Note: single source 
samples with additional allele peaks have been reported.) 

• In a Y-STR DNA profile that consists of peaks heights 100rfu or above, the results at all loci will be 
used to determine the frequency of that haplotype in a given database (see Y-STR Haplotype Frequency 
Calculations).  

 

Marker Stutter Cut-off Value 
DYS456 13.21% 
DYS389I 11.79% 
DYS390 10.4% 

DYS389II 13.85% 
DYS458 12.2% 
DYS19 11.4% 

DYS385 13.9% 
DYS393 12.58% 
DYS391 11.62% 
DYS439 11.18% 
DYS635 10.75% 
DYS392 

(note n-3 stutter position) 
16.22% 

Y GATA H4 11.08% 
DYS437 8.59% 
DYS438 

(note n-5 stutter position) 
4.28% 

DYS448 
(note n-6 stutter position) 

4.96% ARCHIV
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Mixed DNA profiles 
• Mixed Y-STR DNA profiles are apparent when more than one allele is present at some or all of the loci 

(in a male DNA mixture, more alleles may be expected at DYS385 than at other loci).  Generally, 
evidence of a mixed DNA sample exists at multiple loci. 

• If a significant difference in allele peak height exists in a male DNA mixture, a predominant Y-STR 
DNA profile may be deduced.  Under these circumstances, allele peaks from secondary donor(s) may 
be reported as “weak” alleles.  Weak is to be used when the height difference is less than 1/3.  The 
frequency of the predominant haplotype in a given database may be determined using the rules for 
apparent single source profiles, above. 

 
REFERENCES: 
SDPD Yfiler Validation studies 
AmpFlSTR® YfilerTM User’s Manual 
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METHOD:  Autosomal STR Interpretation Guidelines (Summary Document) 

Date:   06/01/2004     Revision Date:   04/01/2011  Approved by: SAM  
            _____ 
 
Introduction 
 
The Scientific Working Group on DNA Analysis Methods (SWGDAM) states that: 

 
“The interpretation of DNA typing results for human identification purposes requires professional 
judgment and expertise.  Additionally, laboratories that analyze DNA samples for forensic casework 
purposes are required by the Quality Assurance Standards for Forensic DNA Testing Laboratories 
(effective July 1, 2009) to establish and follow documented procedures for the interpretation of DNA 
typing results and reporting.  Due to the multiplicity of forensic sample types and the potential 
complexity of DNA typing results, it is impractical and infeasible to cover every aspect of DNA 
interpretation by a preset rule.  However, the laboratory should utilize written procedures for 
interpretation of analytical results with the understanding that specificity in the standard operating 
protocols will enable greater consistency and accuracy among analysts within a laboratory.  It is 
recommended that standard operating procedures for the interpretation of DNA typing results be 
sufficiently detailed that other forensic DNA analysts can review, understand in full, and assess the 
laboratory’s policies and practices.  The laboratory's interpretation guidelines should be based upon 
validation studies, scientific literature, and experience.”  

 
Here we present a number of general interpretation guidelines for interpreting samples in forensic DNA 
casework.  The rationale behind these guidelines is to establish a set of standards to ensure that conclusions 
are supported by reliable data, derived using a scientific approach, and that interpretation of results is as 
objective as possible and is consistent from one analyst to another. 
 
The interpretation of DNA results should take into account the DNA results obtained, the nature of the 
sample, the condition of the profile, any forensically valid assumptions made, and should be scientifically 
justifiable and based on the collected experience and knowledge of the laboratory and the scientific 
community. These guidelines are designed to provide a general foundation for interpretation.   
 
Please refer to the complete Autosomal STR Interpretation Guidelines document if more information is 
desired on any section within this summary document. See Appendix A for a glossary of terms. 
 
DNA interpretation should take place in the following order: 
  

Preliminary Evaluation of Data and Allele Designation (section 1) 
Interpretation of DNA Typing Results (section 2) 
Comparison of DNA Typing Results (section 3) 
Statistical Analysis of DNA Typing Results (section 4) 
Reporting of DNA Typing Results and Conclusions (section 5) 
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Section 1 – Preliminary Evaluation of Data and Allele Designation 
 
1.1 Detection of peaks 

 
The detection of peaks in the data is performed by the GeneMapper ID-X software.  The analytical 
thresholds (peak detection thresholds) for the autosomal STR kits are listed within documents specific 
to each individual kit. 
 

1.2 Evaluation of internal standards 
 

The internal size standard should be evaluated to ensure that for each sample it has produced the 
expected pattern of peaks.  These peaks should generally be between 1000 and 2000rfu for a 5 
second injection and not show signs of poor resolution.  If a sample has issues in the size standard that 
prevent proper sizing, or has signs of poor resolution, the sample should be reinjected or reprepared. 

 
For Identifiler Plus and Minifiler analysis, GS500 LIZ peaks from 75-450bp are required.  If no DNA 
peaks larger than 350bp are detected, it is possible to adjust the analysis range to 75-400bp. 

 
1.3 Evaluation of allelic ladders 

 
The GeneMapper ID-X software compares the ladder injections in the run with the expected sizes.  
GeneMapper ID-X analysis of at least one of the injected allelic ladders must produce the known 
allele peaks associated with the ladder in order for the software to type the other samples of the run.  
If a ladder injection passes the evaluation by the software, the ladder can be relied upon without 
further manual evaluation or reinjection.   

 
1.4 Designation of alleles   
 

Allele assignments are made by comparing the base pair size of the peaks in the amplified samples 
with the base pair size of the alleles within the allelic ladder(s).  Allele assignments are performed 
automatically by GeneMapper ID-X. Analysts may on occasion need to manually edit “off-ladder” 
peaks to designate them as true alleles, or to redesignate peaks originally called as alleles by the 
software as artifacts. 

 
1.4.1 If multiple allelic peaks are improperly called as off-ladder alleles, it may be necessary 

to only designate a subset of the allelic ladder injections as ladders, create separate projects 
using only those samples and ladder combinations that eliminate off-ladder alleles, or reinject 
samples and allelic ladders. 
 

1.4.2 Occasionally an allele will be detected that is outside the ladder range for a given locus.  
Alleles that fall above or below the ladder alleles (even those in virtual bins) will be 
designated as greater than (>) or less than (<) the respective ladder allele. 
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Occasionally an allele will fall outside the ladder range between two loci.  An analyst 
should consider the size of the apparent allele and the expected zygosity in an attempt to 
determine to which locus the allele belongs.  A list of variant alleles is maintained by NIST on 
the STRBase website (www.cstl.nist.gov/strbase/var_tab.htm).  This list can be consulted 
to assist in assist in determining to which locus the allele belongs.  The allele will then be 
renamed with the appropriate (>) or (<) allele designation for the appropriate locus.  
Supporting documentation should be included in the administrative documents for the case.   
 

1.4.3 Off ladder alleles that occur within the ladder ranges (i.e. microvariants that contain an 
incomplete repeat motif) should be designated by the number of complete repeats and, 
separated by a decimal point, the number of base pairs in the incomplete repeat (e.g. D21S11 
29.1 allele).  Microvariants will be confirmed through a re-injection of the sample as a 
means of demonstrating the reproducibility of the retention time and sizing of the peak.  If a 
microvariant is observed in multiple samples from the same case, re-injection for 
confirmation purposes is unnecessary.  Tri-allelic patterns should be confirmed through 
reamplification. 

 
1.5 Designation of artifacts 
 

Some data contained within the electropherograms may not represent actual alleles that originate in 
the sample.  Non-allelic peaks such as stutter, non-template dependent nucleotide addition (minus-
A), nonspecific amplification products, spikes, raised baseline, pull-up, or disassociated primer dyes 
should be identified prior to the comparisons of reference samples to the data.  Generally, non-
allelic data such as stutter, non-template dependent nucleotide addition, disassociated dye, and 
incomplete spectral separation are reproducible; spikes and raised baseline are generally non-
reproducible.   

 
1.5.1 Off –scale data is often the result of over-amplification and can cause several other 

interpretational difficulties, such as: “minus-A” products, increased stutter, and pull-up (see 
below).  If off-scale data is present in a sample, the sample may be re-injected with a 
decreased injection time, reamplified using less input DNA, or the amplified product may be 
diluted for reinjection.  
 

1.5.2 Pull-up results from poor spectral separation and is characterized by signal from a peak in 
one fluorescent dye color producing a smaller, artifactual peak in another, often adjacent, 
dye color. Amplification of less sample, injection of a sample for less time, dilution of 
amplified product, or running the samples after creating a new spectral for the instrument 
can reduce pull-up peaks.   
 

1.5.3 Minus-A (-A) is a form of PCR product that does not possess an extra nucleotide at the 3’ 
end.  Over-amplification can result in prominent “minus-A” products.  Re-amplifying using 
less input DNA will likely reduce minus-A peaks.  Incubating amplified products at 60°C for 
an additional time period may also reduce minus A.  
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1.5.4 Stutter peaks are minor peaks appearing one repeat unit smaller (e.g. n-4 in tetranucleotide 

loci) or larger (n+4 in tetranucleotide loci) than a primary STR allele.  If a called peak is 
suspected to be stutter, the validation study should be consulted to determine the expected 
stutter percentage for that allele.  If the observed percentage is within the expected stutter 
percentage range for that allele, but above the filter threshold, and analyst may determine the 
peak to be stutter.  Ultimately, re-amplification can help determine if a peak is truly stutter 
or if it may be DNA from a secondary source.  Unfiltered stutter peaks that are more than 
two standard deviations from the mean observed for an allele during the validation study will 
be listed in the table of results if the sample is not reamplified or if the unfiltered stutter is 
determined to be reproducible through re-amplification. 
 

1.5.5 Spikes are artifacts of electrophoresis, which may resemble DNA peaks.  Often spikes will be 
narrower than true DNA peaks and will be filtered by the GeneMapper ID-X software.  
Multi-color spikes can be identified by the presence of peaks occurring in several colors at the 
same data point location.  Single-color spikes can be identified by the presence of a sharp 
peak occurring in a single color in the raw data, with no spectral overlap into the other 
colors.  Since spikes are generally random, reinjection of a sample should eliminate a 
questioned spike. 

 
1.6 Evaluation of analytical controls 
 

If the analytical controls are properly designated, the GeneMapper ID-X software will flag controls 
that fail to meet expectations.  Controls that have passed GeneMapper ID-X verification can be relied 
upon without further evaluation. 

 
1.6.1 The reagent blank is a check for possible contamination of the sample preparation reagents by 

extraneous DNA.  If DNA types are detected in the reagent blank this is an indication of a 
possible contamination event or that extraneous DNA was introduced into the sample from 
some unintended source.  Based on an evaluation of the DNA types in the reagent blank, the 
results of associated samples may be deemed inconclusive.   

 
Samples extracted in a batch where the reagent blank shows DNA types greater than the 
interpretation threshold may need to be re-extracted.  Not all contamination events will 
necessitate reanalysis and will be judged on a case-by-case basis.   

 
In some cases, re-extraction of samples affected by a reagent blank containing detectable DNA 
may not be possible.  Results for these samples may be reported if any possible concerns 
related to the reagent blank are adequately explained.   

 
1.6.2 The negative amplification control (Amplification Blank, NAC, or No DNA Control)  is a 

check for possible contamination of samples during the amplification process.  The appearance 
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of DNA types in this control indicates that problems similar to those described for the reagent 
blank may have occurred during the amplification.   

 
The interpretation of detectable DNA in the amplification blank should take into account the 
results obtained from any samples and reagent blanks amplified in the same batch.  A batch 
where both the amplification blank and the reagent blank give the same typing result, or where 
only the amplification blank gives a result, may be caused by a problem limited to the 
amplification process.  In this case, re-amplification of the samples may resolve the problem.  A 
batch that shows a typing result for the reagent blank, but not for the amplification blank is 
more likely to be caused by an extraction-related problem.   

 
If the reagent blank and amplification blank give different typing results, both the extraction 
and amplification processes are potentially suspect and should be repeated.   

 
1.6.3 The positive amplification control (PAC) is a check for effectiveness of the amplification and 

the Short Tandem Repeat (STR) analytical processes.  This control should always show 
interpretable results consistent with the known genotype published in the DNA kit literature.  
If the positive amplification control does not produce the expected results, any samples 
associated with this control will be deemed inconclusive.   
 
Samples in the batch associated with the failed positive amplification control that have DNA 
remaining will be re-amplified.   

 
For samples associated with failed positive amplification control that were consumed for the 
original amplification the most appropriate remediation would be to re-examine (re-extract) 
the original evidence.  If no evidence remains then the samples will be reported as inconclusive.   

 
The only time the results from samples associated with a failed positive amplification control 
that were consumed for the original amplification will be reported is when they form the basis 
of an exclusion.  In this instance, troubleshooting of the problem must lead to the 
determination that the amplification for that sample is reliable and full disclosure of the 
unexpected result (failed positive amplification control) as well as the exclusion will be 
documented in the final report.   

 
For samples associated with a reagent blank that was consumed, if the troubleshooting of the 
failed positive amplification control demonstrates that the results for the reagent blank can be 
relied upon, then the results from that control can be used to demonstrate the extraction 
reagents were clean for any re-amplified sample.  If troubleshooting cannot determine that the 
results from the reagent blank are reliable then the most appropriate remediation for any 
sample associated with that reagent blank would be to re-examine (re-extract) the original 
evidence.  If no evidence remains then the samples will be reported as inconclusive.   
 

1.7 Evaluation of samples that have been reinjected, reamplified, and/or reextracted  
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1.7.1 Analysts should evaluate multiple data sets for an item amplified with the same autosomal 

STR kit to determine if there are indications of differences in peak proportions between the 
injections/amplifications for the sample.  Analysts must indicate in the table of results if the 
represented result is a composite of multiple amplifications/or injections (see section 5).  
When generating a composite DNA profile, the analyst must use the highest RFU value of a 
reproducible peak when determinations of contribution level are done.  If significant 
differences exist between the data generated from reamplification of the same DNA extract the 
analyst may choose to consider the data as separate results instead of generating a composite 
profile. 

 
1.7.2 Analsysts should evaluate data for an item amplified with multiple autosomal STR kits to 

verify that no unexplainable discordances exist between loci common to the kits.  Possible 
reasons for discordances include; but are not limited to; degradation or inhibition affecting one 
of the amplifications to a greater degree than the other, variation in primer sequence, stochastic 
effects of low level samples, and the slight differences in peak proportions typically 
encountered during multiple amplifications of mixed samples.  

 
Section 2 – Interpretation of DNA Typing Results 
 
In general, interpretation of DNA samples will be completed prior to comparison of reference samples.  All 
interpretation of samples will be performed using the actual electrophoresis data and not the table of 
results.  DNA interpretation will include the following steps:  

 
Determine whether a sample is a mixture (section 2.1) 
Estimate the number of contributors to a sample (section 2.2) 
Determine whether stochastic effects are likely (section 2.3) 
Identify whether a sample is degraded and/or inhibited (section 2.4) 
Determine contribution level in mixed DNA samples (section 2.5) 
Document relevant assumptions (section 2.6) 
Determine which loci and combinations of DNA types are useful for statistical support of 
inclusions (section 2.7).   

 
These steps will be documented in the analytical record on an interpretation worksheet prior to comparison 
to reference samples. 
 
2.1 Determination of whether a sample is a mixture 
 

A mixed DNA profile possesses certain common attributes that will tend to indicate the presence of 
more than one contributor to the observed results.  The attributes may include:  
 
• Greater than two alleles present at a locus, unattributable to a mutation or a tri-allelic pattern.  
• Significant imbalance in peak height between peaks at a locus (peak height ratios <60%).  
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• Generally, evidence of a mixed DNA sample exists at multiple loci.  
 

To determine whether a mixed DNA profile exists, the DNA profile must be evaluated in its entirety.  
If a DNA mixture exists, a conclusion to that fact should be stated in the Forensic Biology report, and 
may be stated independently of the conclusion(s) surrounding potential individual contributors (see 
section 5). 

 
2.2 Estimation of the number of contributors to a sample 

 
Conclusions with respect to the minimum number of contributors must be included in a report.  
Generally, an estimate of the minimum number of contributors is based on the locus that exhibits the 
greatest number of allelic peaks and the fact that each contributor would contribute at most two alleles 
to the locus (although tri-allelic patterns could be present, but are extremely rare).  Additional 
information such as expected peak height ratios can be used to determine minimum number of 
contributors.  While the minimum number of contributors to a mixture can be established with a high 
probability, an absolute determination of the number of contributors cannot be ascertained.  
Assumptions as to the number of contributors can be made if the data appears consistent with a given 
number of contributors (see section 2.6)  
 

2.3 Determination of whether stochastic effects are likely 
 
Our validation efforts determined that for single source samples amplified with Identifiler Plus injected 
for five seconds, both alleles of a heterozygote pair will be detected when one of the alleles reaches at 
least 200 RFU (greater than 99% of the time).  With Minifiler, the stochastic threshold was determined 
to be 450 RFU. Please refer to the Identifiler Plus Interpretation Thresholds document for the 
stochastic thresholds for altered injection times. 

 
The analyst should consider the possibility that one or more DNA types may have dropped out if data is 
detected below the stochastic threshold. DNA types below the stochastic threshold will be designated 
with an asterisk (e.g. 16*) in the table of results (see section 5).   

 
2.4 Determination of whether inhibition and/or degradation is present 

 
2.4.1 Inhibition of the PCR process can be caused by a variety of substances and is generally 

described as a reduction in efficiency of the PCR process.  Examples of the effects of inhibition 
can be observed in the SDPD Inhibition presentation on the FB network in the presentations 
folder. 
 
Evaluation of the IPC in the Quantifiler assays can be helpful to determine whether inhibitors 
may be present.  Because a larger amount of DNA may be amplified than used for quantitation, 
a sample with an IPC result within expectations may still show evidence of inhibition when 
amplified.   
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Several options exist to reduce inhibition.  Purifying the sample using the QIAGEN BioRobot 
EZ1 reduces some inhibitors as compared to organic purification.  Reducing the amount of 
template DNA amplified can also reduce the amount of copurified inhibitors introduced into 
the PCR process.  The Identifiler Plus and Minifiler kits have been optimized to reduce the 
effects of PCR inhibitors and can be used to improve previous results from kits (Profiler Plus, 
Cofiler, or Identifiler) more susceptible to inhibition. 

 
2.4.2 DNA is generally stable if stored properly; however, degradation of DNA can occur over 

time, through exposure to the elements, or through the action of bacteria.  Degradation can be 
identified by a classic pattern in samples where rather robust results are obtained at the smaller 
(base pair) loci while little to no results are obtained at the larger (base pair) loci.  The overall 
results have been described as being in a ski slope pattern. 

 
In general, inhibition will affect all contributors to a DNA mixture equally and could raise the 
concern of actually detecting all alleles that should be present in the mixture.  Degradation, 
however, may not affect all contributors equally (differential degradation) and mixtures 
containing degraded DNA can pose a challenge to the analyst attempting to interpret them.  
Analysts are encouraged to exercise caution when interpreting a mixture that is thought to 
contain, or is known to contain, degraded DNA. 
 
Amplification of single source samples with Minifiler may provide better results than Identifiler 
or Identifiler Plus if degradation is suspected. 

 
2.5 Determination of contribution levels in mixed DNA samples 

 
The individual peak heights of alleles within a mixture can provide information regarding the relative 
contribution level (major/minor) to the overall mixture for people possessing those types.  This 
assessment begins by determining whether balance appears between significant contributors (section 
2.5.1).  Once balance has been evaluated, the mechanism for identifying DNA types more likely from 
minor DNA contributors can be determined.  DNA types identified as more likely from minor DNA 
contributors will be designated by brackets (e.g. [16]) in the table of results (see section 5).   
 
2.5.1 In general, a balanced mixture (at least two significant contributors) in a mixed DNA profile 

can be determined by examining the results using the following criteria:  
 

One locus with at least 5 alleles greater in height than ⅓ the tallest peak at that locus (five 
including the tallest peak) and/or three loci with four alleles within 50% of the tallest allele 
at those loci (four including the tallest peak).   

 
If the overall information at additional loci in the profile indicate that balance is likely, analysts 
should adopt a more conservative approach for the designation of minor contributor alleles.  
Some two person mixtures may not have 3 loci with 4 DNA types and therefore peak 
proportions at the other loci should be evaluated for indications of balance.  Loci with two 
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alleles that have close to 1:1 ratio, or three alleles with some combination close to a 2:1:1 ratio 
is indicative of balance between significant contributors. 
 
Additional factors or phenomena such as inhibition or degradation within the sample may lead 
an analyst to adopt a more conservative interpretation and statistical assessment of any potential 
inclusions.  Analysts should be able to articulate the basis for their interpretation, such as low 
level mixtures that may have peaks below the detection threshold that suggest balance in the 
mixture.   
 

2.5.2 When identifying DNA types in a mixture that are more likely from minor contributors the 
robustness of the DNA profile should be taken into consideration in evaluating and interpreting 
a DNA profile.  As results approach the stochastic range (e.g. 200 RFU for Identifiler Plus), 
peak height ratios of less than 30% may be observed.  Based on the increased imbalance 
expected with lower levels of DNA, loci where the tallest peak is below 350rfu should not be 
used to determine major/minor contributor DNA types.  Evaluation of mixtures of DNA from 
five or more people for types more likely from minor contributors should be performed with 
caution as the SDPD validation studies do not include data on these.   
 
In general, a major DNA contributor is an individual who appears to contribute a significant 
portion of the DNA to a mixture.  A DNA contributor should be contributing more DNA than 
at least one of the other contributors to the mixture to be considered a major contributor.  
Major contributors to a DNA mixture do not possess DNA types that are designated as minor 
alleles unless a significant amount of stacking of alleles is likely.  In general, a minor DNA 
contributor is an individual who appears to contribute a small portion of the DNA to a 
mixture.  Minor contributors possess multiple DNA types that are designated as minor alleles.  
If no alleles from minor contributors are identified in the mixed DNA sample then the mixture 
should be considered unresolvable in terms of determining major and minor DNA 
contributors.   
 
2.5.2.1 Minor contributor types in imbalanced mixtures 

 
In imbalanced mixtures a DNA type is considered to be from a minor contributor if it 
is less than ⅓ the intensity of the tallest peak at a marker. 
 
Validation data has shown in mixtures that have varying contribution levels from the 
DNA donors, individuals that generally contribute greater than 50% of the DNA in a 
sample will not possess any alleles designated as “minor” in the mixture.  In these 
situations “minor” alleles can be used as an interpretational tool for determining major 
vs. minor contributors to a mixture.   
 
In some circumstances the imbalance in a sample will be so extreme, that the genotype 
from a single major contributor (predominant) see 2.7.1.4a can clearly be deduced.   
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2.5.2.2 Minor contributor types in balanced mixtures 
 
In balanced mixtures, minor contributor alleles will generally be less than 10% of the 
total RFU at a locus.  10% is meant as a guideline and phenomena such as stutter and 
baseline artifacts may affect the percentage from locus to locus; however, deviations 
from this should be rare and generally used for more conservative interpretations of 
mixtures.  If the percentage of an allele is such that it is suggestive that it may be from a 
more significant contributor it should not be considered minor.   

 
2.6 Documenting Assumptions 

 
In certain circumstances, assumptions regarding DNA profiles may be made to assist the analyst in 
drawing conclusions and to put the evidence in the proper context.  All assumptions regarding any 
interpretation will be presented in the report and should also be in the notes (see section 5).   
 
2.6.1 While the absolute number of contributors to a DNA mixture cannot be determined in most 

instances.  In certain circumstances, especially fairly robust samples with few contributors, 
factors such as allelic dropout, degradation, inhibition, masking of alleles, partial profiles, etc. 
are believed to play a less significant role and the number of contributors to a mixture or the 
number of major contributors to a mixture can be assumed with confidence and should be 
supported by the data. 
 

2.6.2 In certain circumstances assumptions regarding the presence of a contributor in a DNA 
mixture is permissible (i.e. intimate samples – see complete document for additional instances 
it may be done).  In these circumstances the DNA profile from the assumed contributor(s) can 
be used to assist interpretation of the additional contributor(s) DNA profile/types (section 
2.7).   
 
The assumption of the presence of one or more contributors may require the analyst to change 
the minimum number of contributors to a mixture.  It also may be possible that the assumption 
of the presence of a contributor may change the confidence with which an assumed number of 
contributors can be made. 
 

2.7 Determining the Loci to be used for Statistics/Comparisons 
 
Prior to making comparisons, the profile should be evaluated to determine what loci and/or 
combinations of DNA types are acceptable to support a conclusion statistically.  Much of the 
evaluation to determine what parts of the DNA results can be used for statistical weight takes into 
account the presence of DNA types below the stochastic threshold and whether assumptions regarding 
the number of contributors have been made.  If all DNA types are above the stochastic threshold, all 
DNA types can be used for comparison, but it may useful to further refine the genotypes for 
comparison if a limited number of combinations are likely. 
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If an analyst believes that filtered stutter peaks should be evaluated for comparison, the mean stutter 
percentage observed for the allele during validation and other studies should be used to assess whether 
excess stutter is likely.  Peaks in stutter positions that are more than 2 standard deviations above the 
mean observed stutter indicate the presence of excess stutter and that DNA contribution from a source 
other than stutter is likely.  If a peak in a stutter position is deemed to have originated from a separate 
contributor to the sample, then all stutter peaks in the mixture should be evaluated in the same manner 
and included in the assessment of the mixture.  After the evaluation of stutter peaks in the mixture it 
may be necessary to reassess the minimum number of DNA contributors to the sample. 
 
2.7.1 Samples with an assumed number of contributors. 

 
2.7.1.1 An apparent single source sample consists of no more than two relatively balanced 

alleles at each locus.  Single source samples with three allele peaks at a single locus 
and/or partial null alleles have been reported, though are extremely rare.  For single 
source samples, allele number and peak height ratios should be appropriate for the 
level of the detected DNA. 
 
Alleles used for comparison: 
When two alleles, or one allele detected above the stochastic threshold, are detected at 
a locus, allelic dropout is not a concern.  These alleles are used for comparison.  When 
one allele is detected and the allele is below the stochastic threshold, allelic dropout is 
possible.  The allele is used for comparison, but the analyst should consider that any 
other allele could be paired with the detected allele. 
 

2.7.1.2 When the data supports it, an analyst may make an assumption as to the number of 
DNA contributors in a mixture.  It is not recommended that analysts make 
assumptions on mixtures of four or more individuals as the data in those mixtures 
becomes much harder to interpret. 
 
When the number of contributors to a DNA mixture is assumed to be two or three 
people, there are restrictions on the genotypes that could have contributed to the 
profile. Given the number of assumed contributors, the number of detected alleles, 
and the ratio of the contributors, it is possible to remove certain allele combinations 
from consideration. 
 
Alleles used for comparison: 
All alleles at loci where the analyst is confident that all DNA types are detected will be 
used for comparison for mixtures of two or three people.  

 
Loci with DNA types below the stochastic threshold can be used in some circumstances 
in mixtures of two or three people:   
 

ARCHIV
E



Unit Technical Manual 

Forensic Biology 

 

Implemented: 04/01/2011 Printed Documents are Uncontrolled Page 161 of 185 

 
 

a) If all DNA types from all contributors appear to be present at a locus, all 
alleles at the locus, including those below the stochastic threshold, will be used 
for comparison.   

 
b) If DNA types below the stochastic threshold are observed and at least one 

allele is present from each contributor (three alleles in a two person mixture 
or five alleles in a three person mixture), all alleles can be used for comparison 
if the analyst considers the possibility that the DNA type(s) below the 
stochastic threshold can be paired with an undetected allele.   

 
c) If the analyst does not have confidence that at least one allele has been detected 

from each contributor, the locus should not be used for comparison if DNA 
types below the stochastic threshold are detected unless a predominant 
contributor or major contributors are present (see section 2.7.1.4a).  

 
2.7.1.3 Mixtures of two or three contributors where a forensically valid assumption regarding 

a contributor can be made  
 
In addition to the guidelines in section 2.7.1.2, when the number of contributors is 
assumed and a forensically valid assumption regarding a contributor is made, further 
refinement of the mixture is possible.  In these circumstances, possible combinations 
representing the source(s) of the DNA foreign to the assumed contributor(s) should be 
considered for comparison as described below.  DNA types foreign to the assumed 
contributor(s) are referred to as obligate foreign alleles. 
 
Loci used for comparison: 
Loci where the analyst is confident that all DNA types are detected can be used for 
comparison.  Loci with DNA types below the stochastic threshold can be used if all of 
the types below the stochastic threshold are due to the assumed contributor and/or if 
at least one DNA type from the foreign contributor(s) is present, in a similar fashion to 
2.7.1.2a and 2.7.1.2b. 
 

2.7.1.4 Some samples may not allow for confident assumption as to the number of total 
contributors, but do allow for an assumption as to the number of major 
contributors. 
 
a) Assumption of one major contributor. If the overwhelming contribution to the 

DNA in a mixture appears to originate from a single individual then the term 
predominant DNA contributor will apply.  A predominant DNA profile will be 
one where a single source genotype from the single strongest contributor to the 
mixture is able to be easily deduced from all of the DNA markers tested.  In 
general, all alleles from predominant DNA contributors will not have alleles 
designated as minor.  Factors that will affect deducing a predominant DNA profile 
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such as the genotype of an assumed additional contributor or other issues 
commonly observed in PCR systems (stutter, peak height ratios, preferential 
amplification, etc) should all be considered in the interpretation of a predominant 
genotype.  
 
In some circumstances a single major contributor will be apparent, but some 
ambiguity may exist for the genotype of the major contributor at a few loci due to 
stacking of minor contributor alleles.  Peak height ratio expectations may limit the 
ambiguity, but if uncertainty still exists, an analyst may choose all combinations of 
types that are not designated as minor at the ambiguous loci or all loci (see 
example in the complete document). 
 
Alleles/loci used for comparison: 
The DNA types for a predominant contributor will be considered for comparison 
in a similar fashion as single source samples (section 2.7.1.1). 
 
Minor contributors to a mixture with a single major contributor, but no 
assumption as to the number of total contributors will be evaluated in a similar 
fashion as in section 2.7.2.2 
 

b) Assumption of two major contributors.  In balanced mixtures, it is possible that 
two DNA contributors will contribute significantly more DNA than any other 
contributors.  In this circumstance, an analyst can treat the two major contributors 
in a fashion similar to section 2.7.1.2. 
 
Minor contributors to a mixture with two major contributors, but no assumption 
as to the number of total contributors will be evaluated in a similar fashion as in 
section 2.7.2.2 
 

2.7.2 Even when the number of total contributors and/or the number of major contributors 
cannot be confidently assumed, the sample may be evaluated for the presence of possible 
major contributors (section 2.7.2.1) and minor contributors (section 2.7.2.2).  In some 
circumstances, the mixture cannot be resolved into major and minor components (section 
2.7.2.3) or is not useful for comparison (section 2.7.2.4).  
 
2.7.2.1 Major contributors with no assumption of the number of contributors.  Major 

contributors should not have types that are designated as minor contributor alleles (see 
section 2.5); the subset of alleles in a DNA mixture above the level of minor 
contributor alleles are considered possible major contributor DNA types.  It may be 
possible that the number of major contributors can be assumed even if the number of 
total contributors cannot be confidently determined (see section 2.7.1.4). 
 
Loci used for comparison: 
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Loci with all possible major contributor DNA types above the stochastic threshold will 
be used for comparison to the major contributor DNA types 
 
If possible major contributor DNA types at a locus are detected below the stochastic 
threshold, in a mixture evaluated without assumptions; the locus will not be used for 
comparison purposes to possible major contributors. The locus will be not be used for 
comparison due to the concern that one or more major contributors may have DNA 
types that were not detected. 

 
2.7.2.2 Minor contributors with no assumption of the number of contributors.  Minor 

DNA contributors should show proportional contribution across the DNA mixture.  
There can be more than one minor DNA contributor to a mixture.  In general, minor 
DNA contributors will possess weaker DNA types across several loci (see section 2.5).  
Masking and allelic drop-out are more likely with minor DNA contributors.  Caution 
should be taken when interpreting a mixture with only one or two minor DNA types 
in a complex mixture as allele sharing may have caused the allele designation to be a 
“minor” type(s).  The validation data indicates that it is possible to have alleles less than 
1/3 the height of the tallest in mixtures with relatively equivalent contributors due to 
allele stacking effects. 

 
If no assumptions are made about the number of minor DNA contributors then all 
combinations of alleles at a locus should be considered as possibly originating from a 
minor contributor and not just genotypes containing the designated minor alleles.   
 
Loci used for comparison: 
Loci with minor contributor alleles present and where the analyst is confident that all 
DNA types are detected will be used for comparison to possible minor contributors.  
Loci with DNA types below the stochastic threshold will not be used for comparison 
purposes to possible minor contributors due to concern that one or more minor 
contributors may have DNA types that were not detected.  If fewer than four loci are 
useful for comparison to possible minor contributors, the profile will be considered 
uninterpretable with respect to minor contributors.  

 
2.7.2.3 Mixtures with no major contributors and no assumption of the number of 

contributors. Samples with no DNA types designated as minor contributor alleles (see 
section 2.5) are not resolvable into major or minor contributors.  Mixtures, such as 
those of more than four contributors, may have DNA types designated as minor 
contributor alleles, but ambiguity may still exist as to whether one or more 
contributors is donating more DNA than others in the mixture.  Such samples will be 
evaluated for possible DNA contributors.   
 
Loci used for comparison: 
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Loci where the analyst is confident that all DNA types are detected will use all alleles 
for comparison to possible DNA contributors.  Loci with DNA types below the 
stochastic threshold will not be used for comparison purposes to possible DNA 
contributors due to concern that one or more DNA contributors may have DNA types 
that were not detected.  If fewer than four loci are useful for comparison to possible 
DNA contributors, the profile will be considered uninterpretable.  

 
2.7.2.4 Uninterpretable mixtures are mixtures where no assumptions can be confidently 

made and where all observed alleles are below the stochastic threshold are not useful 
for comparison and are considered uninterpretable.  A mixture may be useful for 
comparison to possible major contributors and may be uninterpretable with respect to 
possible minor contributors. 
 

3. Comparison of DNA Typing Results  
 
3.1 Inclusion.  If a person of interest has no unexplainable differences from the alleles or allele 

combinations determined to be useful for statistical support of inclusions, and thus comparison, 
they are included as a source of the DNA or possible contributor to the DNA mixture.   

 
3.2 Exclusion.  If a person of interest has unexplainable differences from the alleles or allele 

combinations determined to be useful for comparisons, they are excluded as a source of the DNA 
or possible contributor to the DNA mixture.   

 
3.3 Inconclusive.  Some mixtures such as those with five or more contributors may not be suitable for 

comparison, unless a minimal number of major contributors exist.  Comparisons to these mixtures 
will be considered inconclusive. 
 
An analyst may determine that due to a combination of variables including (but not limited to) the 
number of DNA contributors as well as a lack of information in the results that no comparisons 
can be made to the profile (or comparison for possible minor contributors). 
 

3.4 Uninterpretable. Mixtures with no assumptions made to the number of contributors, that have 
less than 4 loci available for comparison, will be deemed uninterpretable 
 
If the positive amplification control does not provide the expected results, or if DNA types are 
detected in the negative amplification control or the relevant reagent blank, the sample may not be 
useful for comparison (see section 1.6) and would thus be uninterpretable.   
 

4. Statistical Analysis of DNA Typing Results 
 

When a comparison leads to a conclusion that an individual is included as a possible source of the DNA or a 
possible contributor to a DNA mixture, an assessment of the significance of that inclusion should be 
performed by calculating the rarity of such an inclusion.  If the inclusion has little probative value a 
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calculation may not be necessary.  If an individual is included as a possible contributor to the DNA from 
multiple items in a case, calculations may only be necessary for the most probative item(s) and/or the 
item(s) with the highest discrimination potential.   
 
Calculations will only be performed on loci and/or allele combinations that have been deemed acceptable 
for comparison purposes (section 2.7). 
 
All calculations will be generated for the Caucasian, African American and Southwestern Hispanic 
populations using the DNA allele frequency data taken from J Forensic Sci 1999, 44(6): 1277-1286 and for 
the D2S1338 and D19S433 loci from Forensic Science Communications 2001, 3(3) unless noted.  If a 
different database is used for calculations, it should be included in the administrative documents with the 
case file and noted in the report. 
 
The product rule will be used for calculations by determining the probability at each locus and multiplying 
the results for each locus together. 
 
In general, Popstats is used for statistical calculations.  In some circumstances the SDPD 2p calculator can 
be used for low level samples.  There is also the SDPD RMP calculator, which can be used for mixtures, 
that allows for the exclusion of certain genotypes from the calculation.   

 
4.1 For single source samples and samples with a predominant DNA profile the significance of a 

match should use the random match probability (RMP) formulae for single source samples.  Loci 
with two alleles (heterozygotes) or with a single allele above the stochastic threshold 
(homozygotes) can be calculated using Popstats.  For loci with a single allele below the stochastic 
threshold the analyst can use the SDPD 2p calculator in combination with the Popstats results or 
can decide not to use the locus for statistical weight if the added value would be insignificant to the 
overall conclusion.  The formulae for the Random Match Probability for single source samples are 
shown below:  

 
    f = 2pq    (heterozygote)                                            
    f = p2 + p(1 – p)θ   (homozygote)      (θ=0.01 in most instances)                 
    f = 2p - p2  (single peak below stochastic threshold)  

 
4.2 There are two methods used for calculations when an assumption is made regarding the 

number of contributors or the number of major contributors to a mixture: the likelihood ratio 
(section 4.2.1) and the random match probability (section 4.2.2).  Both methods can be restricted 
(taking into account peak height ratios and mixture ratios) or unrestricted.  The RMP can also be 
modified based on an assumed number of contributors to exclude unreasonable genotypes from 
consideration. Both methods can take into account the presence of an assumed contributor.    
 
4.2.1 If the number of contributors can be assumed with confidence, the likelihood ratio takes 

into account all of the information in the sample.  The likelihood ratio is the ratio of two 
probabilities of the same event under two mutually exclusive hypotheses.  Given the same 
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data, it is possible to calculate more than one likelihood ratio under a different set of 
assumptions and hypotheses.   
 

In general, the likelihood ratio formula is:              
 
Typically the calculation in the numerator is the probability of obtaining the evidence 
under the hypothesis that a person of interest is one of the contributors to the DNA 
mixture.  The calculation in the denominator is the probability of obtaining the evidence 
under the hypothesis that randomly selected individuals are contributors to the DNA 
mixture.  If the result of the ratio is a number greater than one, the DNA results are more 
probable if the person of interest is a contributor to the mixture.  If the result of the ratio is 
less than one, the DNA results are more probable if the evidence is a mixture of DNA from 
randomly selected individuals.   

 
In the SDPD lab, the likelihood ratio has been more commonly calculated when a 
contributor is assumed and the number of contributors is also assumed, but it can also be 
calculated without the assumption of a contributor.  Likelihood ratios are also used in 
parentage and kinship calculations, but these will be dealt with later (sections 4.4 and 4.5). 

 
Please see the complete document for additional scenarios where likelihood ratios could be 
useful.  Popstats can calculate likelihood ratios; however it does not employ formulas to 
deal with restricted likelihood ratios or scenarios where allelic dropout is possible. 

 
4.2.2 Although commonly used for single source samples, random match probabilities (RMP) 

calculations can also be performed for mixtures with an assumed number of contributors 
or for major contributors to a mixture with an assumed number of major contributors.  
The RMP calculates the probability of each genotype that could reasonably represent a 
contributor.  The RMP differs from a combined probability of inclusion (see section 4.3) in 
that fewer possible genotypes exist due to the assumption regarding the number of 
contributors. 
 
When a mixture is encountered that appears to have a single major contributor, but where 
some ambiguity exists in the genotype at one or more loci (see section 2.7.1.4a for an 
example), an RMP incorporating multiple genotypes at the ambiguous loci can be 
performed. 
 
In balanced mixtures of DNA from two people, the RMP could be calculated by using only 
the possible combinations that could have contributed to the mixture (e.g. heterozygote 
combinations where four alleles are detected).   
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In circumstances where DNA types below the stochastic threshold are detected and where 
dropout has possibly occurred, a modified version of the 2p - p2 calculation in section 4.1 
can be performed using the following formula for the alleles below the stochastic threshold 
(p, q, r, etc): 

 
2(p + q + r + …) – (p + q + r + …)2 

 

In mixtures of DNA where the presence of a specific contributor is assumed, an RMP could 
be calculated for the combinations of DNA types foreign to the assumed contributor.  Such 
calculations focus on the obligate alleles in the mixture. 
 

4.3 Combined Probability of Inclusion 
 
When no assumptions regarding the number of contributors can be made with confidence, the 
combined probability of inclusion (CPI) is used to express the significance of an inclusion.  The 
probabilities of all possible combinations at each locus are calculated and summed to generate a 
probability of inclusion or PI.  The PI for each of the loci acceptable for comparison are multiplied 
together to generate the CPI.  The PI for each marker and the CPI are calculated as: 
 

     PI = (p + q + r + …)2     

  CPI = PI1 * PI2* PI3 * …   
 
A CPI using the possible major contributor DNA types (e.g. types above minor) can be calculated 
to express the significance of an inclusion as a major contributor.  A separate CPI calculation using 
all DNA types can be performed to express the weight of an inclusion of a minor contributor.  For 
samples without major and minor contributors, a CPI using all alleles can be performed to express 
the significance of an inclusion as a possible DNA contributor. 
 

4.4 Parentage  
 
In cases involving disputed parentage, a parentage calculation will be provided using the formulae 
integral in the Popstats software.  If manual calculations are necessary because the parents and child 
are from a racial group for which Popstats does not have relevant population data, the formulae can 
be found in the “Help” section of Popstats.  Calculations for three parentage scenarios are 
performed: when one parent is alleged and the other is known (section 4.4.1), when one parent is 
alleged and the other is unknown (section 4.4.2), and when both parents are known and the child is 
alleged (section 4.4.3).  
 
4.4.1 The scenario when an allegation of parentage exists and DNA types from the child, the 

known parent, and the alleged parent exist is referred to as a parentage trio.  In this 
circumstance, a Parentage Index (PI) is calculated.  The PI is the Likelihood Ratio of the 
probability of the genetic evidence given that the alleged parent is the biological parent of 
the child versus the probability of the genetic evidence given that a randomly selected, 
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unrelated individual is the biological parent of the child.  See the complete document for 
information on considering mutations. 
 

4.4.2 In cases where one parent is alleged and the other parent is either unknown or for which 
DNA results are unavailable, a single parent case exists.  These are often referred to as a 
“motherless paternity” or “fatherless maternity” cases.  These calculations are performed by 
Popstats within its kinship tools. 
 

4.4.3 When the child of two parents is disputed, a Reverse Parentage Index (RPI) will be 
calculated.  This is the Likelihood Ratio of the probability of the genetic evidence given that 
the alleged child is the biological child of the parents versus the probability of the genetic 
evidence given that the alleged child is not the biological child of the parents.  

 
4.5 When the biological relationship, or kinship, of two individuals is disputed, a Kinship Index (KI) 

will be calculated.  This is the Likelihood Ratio of the probability that the two individuals’ 
genotypes are associated by kinship, versus the probability that the two individuals’ genotypes are 
associated by chance.  In cases involving disputed kinship, a kinship calculation will be provided 
using the formulae integral in the Popstats software.   

 
5. Reporting of DNA Typing Results and Conclusions  

 
The following are meant as guidelines for reporting conclusions for DNA testing in Forensic Biology Unit 
reports.  There are many ways to state a conclusion in a DNA report and the suggestions listed below do 
not cover every possible scenario.  Alternative wording may be used to express a conclusion so long as the 
conclusion is correct, supported by the data, and is appropriate based on the statistical probability limits 
employed by the Unit.   

 
5.1 Reporting of DNA typing results 

 
If all samples tested gave no DNA typing results, an analyst may convey these results with a written 
statement to that effect in the results section of the report.  
 
If DNA typing results were obtained for one or more samples, the DNA typing results for all 
samples will be reported in tabular form.  If a low number of samples were tested, the table may be 
placed in the results section of the report.  If a larger number of samples were tested, or if the 
analyst desires, the table should be placed at the end of the report with a statement in the results 
section directing the reader to the location of the table.  If multiple items are tested, the table 
should include the item numbers.  A brief description of each item is desired.  An example of a 
table of results is shown below: 
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Description D8S1179 D21S11 D7S820 CSF1PO D3S1358 TH01 D13S317 D16S539 D2S1338 D19S433 vWA TPOX D18S51 Amel D5S818 FGA 

Item 1 
Stain from pants 

13, 14 30 9, 10* ND 14, 15 9 8, 11 13*, 14 24* 13 14, 15 8*, 11 ND X, Y 10, 12 21* 

Item 21 
Baseball cap 

13, 14, 15, 
16 

[10] 

28, 30 
[32.2*] 

8, 9, 10 
 

11, 12 
[13*] 

14, 15, 17 
[18] 

 

6, 9 
[9.3] 

 

8, 11 
[13] 

11, 12, 13, 
14 

[10*] 

19, 24, 26 
[22] 

13, 14, 
14.2 

[15.2] 

14, 
15, 16 

8, 11 15, 17, 
18, 20 
[12*] 

X, Y 10, 11, 
12 

 

20, 
21, 24 
[19*], 
[27*] 

Item JS2 

John Smith 
13, 14 30 9, 10 NT 14, 15 NT 8, 11 NT NT NT 14, 15 NT 15, 17 X, Y 10, 12 20, 21 

1 = DNA results are a composite of two injections 
2 = DNA results taken from Criminalist Joe Blow’s report for case #XX-XXXXXX dated April 7, 2002 
[ ]  = DNA type(s) from minor contributor(s). 
* = DNA type detected below the stochastic threshold 
ND = No DNA types detected 
NT = Not tested 

 
If results from previous analyses are reported with results from current analysis, a reference to the 
report from which the previously obtained results are taken should be included in the table. 
 
The table of results will indicate which types are minor contributors alleles and which types were 
detected below the stochastic threshold.  If a composite profile is used, a note to that effect should 
be placed in the table.  The table should specify if no results were obtained or if testing was not 
performed at a locus.  If abbreviations or symbols are used in the table, a key to the symbols should 
be provided with the table. 

 
5.2 Reporting of conclusions 

 
Conclusions for each item should be present in the conclusions section of the report.  It is 
acceptable to group similar conclusions for multiple items together.  
 
5.2.1 In general, conclusions should state whether a mixture of DNA was obtained, and if a 

mixture was obtained, the minimum number of contributors should be stated.  The 
conclusion should indicate if the sample is not suitable for comparison purposes.  A brief 
description of the reason that it is not suitable should be included.  In the case of a mixture 
that is only suitable for comparison to possible major contributors, an indication should be 
included that the sample is not suitable for comparison to possible minor contributors.  It 
may in some circumstances be relevant to indicate whether male or female DNA is present 
in the sample. 
 
If the sample is suitable for comparison and if comparisons are made, the conclusion should 
indicate whether the persons of interest are included or excluded.  If the comparison is 
determined to be inconclusive, a statement giving reasons leading to the inconclusive 
determination. 

 
If an inclusion is made, and if the inclusion warrants a probability calculation (see section 
4), the applicable probabilities should be listed.  
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Any assumptions made regarding the comparisons and/or the probability calculations will 
be listed in the conclusion. 
 
If the inclusion of an individual requires a larger number of contributors than the minimum 
based on allele number and peak height ratios, a statement to that effect should be 
included. 
 
A statement as to whether DNA types or a subset of the DNA types from an item will be 
uploaded into CODIS should be included, if applicable. 
 

5.2.2 Examples of inclusions in common scenarios 
 
5.2.2.1 Examples of inclusions as a possible source of a single source or predominant 

sample 
 
If the profile frequency is rarer than 1 in 300 million, the terms “match” or “very 
likely the source” may be used to describe the inclusion: 
 

The (predominant) DNA profile from the evidence (Item 1) matches the DNA 
profile obtained from John Doe.  The approximate probabilities that a person 
selected at random would possess the same (predominant) DNA profile as the 
evidence are:  

 
If the profile frequency is more common than 1 in 300 million, a term such as “is 
included as a possible source” may be used: 

 
John Doe is included (or could not be excluded) as being the source of the 
DNA from the evidence (Item 1).  The approximate probabilities that a person 
selected at random would possess the same DNA types as the evidence are: 

 
5.2.2.2 Example of an inclusion as a contributor to a mixture with no assumption as to the 

number of contributors 
 

A mixture DNA from at least two (or however many) people was recovered 
from the evidence (Item 1).  John Doe is included as being a possible DNA (or 
major or minor) contributor to the DNA mixture from the evidence.  The 
approximate probabilities that a person selected at random would be included 
as a possible DNA (or major or minor) contributor to the mixture are: 

 
5.2.2.3 Example of an inclusion as a contributor to a mixture when the number of 

contributors is assumed (likelihood ratio scenario) 
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A mixture of DNA was recovered from the evidence (Item 1).  The DNA 
results are consistent with a mixture of two people.  John Doe is included as a 
possible DNA contributor to this mixture.  Assuming two contributors to the 
DNA mixture, the DNA results suggest (see verbal wording below) support 
that this represents a mixture of DNA from John Doe and one unknown 
individual rather than if it is a mixture of DNA from two unknown individuals 
as expressed in the following table: 

 
The following represents suggested wording to convey the strength of the 
likelihood ratio calculation  
 
Likelihood Ratio Results Verbal wording Support for 

Hx 
1,000,000+ Extremely strong 

100,000 Very strong 
10,000 Strong 

1000 Moderately strong 
100 Moderate 

10 Limited 
1 Inconclusive 

0.1 Limited Support for 
Hy 0.01 Moderate 

0.001 Moderately strong 
0.0001 Strong 

0.00001 Very strong 
0.000001 Extremely strong  

Verbal wording suggestions obtained from Dr. Chris Maguire – Northumbria University Center for Forensic Science 

 
5.2.2.4 Example of an inclusion as a contributor to a mixture when an assumption is made 

regarding the number of contributors and with one or more assumed contributors 
 

A mixture of DNA from at least two people was recovered from the evidence 
(Item 1).  John Doe and Jane Victim are both included as possible DNA 
contributors to this mixture.  Assuming that Jane Victim is a DNA contributor 
to the mixture and there is only one additional DNA contributor, then John 
Doe is (included as/very likely) the source of the DNA foreign to Jane Victim.  
The probabilities that a person selected at random would be included as a 
contributor to the DNA foreign to Jane Victim are:  

 
5.2.2.5 Example of an inclusion in a paternity case 

 
John Doe cannot be excluded as being the biological father of Baby Doe based 
on the DNA evidence.  It is (X/Y) more likely to observe these DNA results if 
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John Doe was the true biological father than if a random (ethnicity) man was 
the father.  The probability of John Doe being the biological father is greater 
than 99.9999%.   

 
5.2.2.6 Inclusions to single source profiles on non-probative samples 

 
As a general rule, inclusions on samples that have no apparent probative value do 
not require the significance of the inclusion to be supported with a probability of 
inclusion statement, as long as the wording chosen for the conclusion is 
appropriate based on the statistical probability limits employed by the Unit.   

 
The words “match” and “very likely the source” may be used for inclusions to single 
source or predominant profiles on non-probative samples if a 15 locus match is 
obtained, given the minimum 15 locus profile frequencies using the Applied 
Biosystems Identifiler Plus kit (see below).  The term “consistent with originating 
from” is also acceptable but is not subject to statistical limitations so long as the 
data supports its use.   
 
If less than a 15 locus inclusion to a single source sample is obtained and an analyst 
still wishes to use “match” or “very likely the source” it may be necessary to have a 
profile frequency calculation in the analytical record to support the application of 
those terms, but that does not have to appear in the report.   
 
Given the minimum 8 locus profile frequencies using the Applied Biosystems 
Minifiler kit (see below), the words “match” and “very likely the source” may only 
be used for conclusions on non-probative samples if their use is supported by a 
profile frequency calculation in the analytical record, which does not have to 
appear in the report.   
 

5.2.2.7 Non-probative inclusions to mixtures  
 

A mixture of at least two (or however many) people was recovered from the 
evidence.  John Doe is included as being a possible DNA contributor to the 
mixture from the evidence.  There is at least one unknown DNA contributor 
to the mixture.  DNA from the evidence will be searched against the databases 
of the Combined DNA Index System (CODIS).   

 
5.2.3 Examples of wording when a comparison is inconclusive  

 
A mixture of DNA from at least five people was obtained from the evidence 
(Item 1).  Due to the complexity of the mixture, it is inconclusive whether 
John Doe can be included as a possible contributor to the DNA mixture. 
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During DNA testing of the evidence (Item 1), the positive amplification 
control did not provide the expected results.  Therefore no conclusions will be 
drawn from this item. 

 
Results obtained from the evidence (Item 1) do not meet the laboratory 
requirements for comparison and are thus inconclusive. 

 
5.2.4 Examples of exclusions in common scenarios 

  
 
5.2.4.1 Example of an exclusion to a single source or predominant DNA profile 

 
The (predominant) DNA recovered from the evidence is from an unknown 
male/female.  John Doe is excluded as the source of the (predominant) DNA 
from the evidence.   
 

If minor DNA types are present in a mixture scenario where a predominant profile 
is deduced, it may be required to state John Doe’s possible inclusion as a possible 
minor contributor. 

 
5.2.4.2 Example of an exclusion to a DNA mixture 

 
A mixture of at least two (or however many) people was recovered from the 
evidence.  John Doe is excluded as a possible DNA contributor to the mixture.  
DNA types from the mixture will be searched against the databases of the 
Combined DNA Index System (CODIS). 

 
5.2.5 Reporting Staff Matches 

 
When an evidence DNA profile is found to match a staff member of the laboratory the 
analyst should refer to the “Reporting DNA results matching laboratory staff” 
portion of the CODIS section of the Forensic Biology Unit Policy Manual. 
 

5.2.5.1 Example of wording for staff matches 
 

The DNA profile from Evidence Item X was found to match my DNA profile.  No 
other item in this case contains this profile and therefore interpretations of these  
items  were not affected. 
  
The DNA profile from Evidence Item X was found to match DNA from a 
laboratory analyst from Unit X.  No other item in this case contains this profile and 
therefore interpretations of these items were not affected. 
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Minor contributor scenario 
 
…also detected in this sample was DNA that is consistent with my DNA profile.  
The presence of this DNA in the sample did not affect the overall interpretation for 
this item.  No other item in this case contains this profile and the interpretations of 
these items  were not affected. 
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METHOD:  Y-STR Interpretation Guidelines 

Date:   06/01/2004     Revision Date:   04/01/2011  Approved by: SAM  
            _____ 
 
Introduction 
 
The Scientific Working Group on DNA Analysis Methods (SWGDAM) states that: 

 
“The interpretation of DNA typing results for human identification purposes requires professional 
judgment and expertise.  Additionally, laboratories that analyze DNA samples for forensic casework 
purposes are required by the Quality Assurance Standards for Forensic DNA Testing Laboratories 
(effective July 1, 2009) to establish and follow documented procedures for the interpretation of DNA 
typing results and reporting.  Due to the multiplicity of forensic sample types and the potential 
complexity of DNA typing results, it is impractical and infeasible to cover every aspect of DNA 
interpretation by a preset rule.  However, the laboratory should utilize written procedures for 
interpretation of analytical results with the understanding that specificity in the standard operating 
protocols will enable greater consistency and accuracy among analysts within a laboratory.  It is 
recommended that standard operating procedures for the interpretation of DNA typing results be 
sufficiently detailed that other forensic DNA analysts can review, understand in full, and assess the 
laboratory’s policies and practices.  The laboratory's interpretation guidelines should be based upon 
validation studies, scientific literature, and experience.”  

 
Here we present a number of general interpretation guidelines for interpreting samples in forensic Y-STR 
casework.  The rationale behind these guidelines is to establish a set of standards to ensure that conclusions 
are supported by reliable data, derived using a scientific approach, and that interpretation of results is as 
objective as possible and is consistent from one analyst to another. 
 
The interpretation of Y-STR results should take into account the DNA results obtained, the nature of the 
sample, the condition of the profile, any forensically valid assumptions made, and should be scientifically 
justifiable and based on the collected experience and knowledge of the laboratory and the scientific 
community. These guidelines are designed to provide a general foundation for interpretation.   
 
DNA interpretation should take place in the following order: 
  

Preliminary Evaluation of Data and Allele Designation (section 1) 
Interpretation of DNA Typing Results (section 2) 
Comparison of DNA Typing Results (section 3) 
Statistical Analysis of DNA Typing Results (section 4) 
Reporting of DNA Typing Results and Conclusions (section 5) 

 
This document will reference the Autosomal STR Interpretation Guidelines document where information 
applicable to Y-STR interpretation is available. 
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Section 1 – Preliminary Evaluation of Data and Allele Designation 
 
Please refer to section 1 of the Autosomal STR Interpretation Guidelines document as all the information 
therein is relevant to Y-STR interpretation. 
 
 
Section 2 – Interpretation of DNA Typing Results 
 
In general, interpretation of Y-STR data will be completed prior to comparison of reference samples.  All 
interpretation of samples will be performed using the actual electrophoresis data and not the table of 
results.  DNA interpretation will include the following steps:  

 
Determine whether a sample is a mixture (section 2.1) 
Estimate the number of contributors to a sample (section 2.2) 
Identify whether a sample is degraded and/or inhibited (section 2.3) 
Determine contribution level in mixed DNA samples (section 2.4) 
Document relevant assumptions (section 2.5) 
Determine which loci and combinations of DNA types are useful for statistical support of 
inclusions (section 2.6). 

 

2.1 Determination of whether a sample is a mixture 
 

A mixed Y-STR profile possesses certain common attributes that will tend to indicate the presence of 
more than one contributor to the observed results.  The attributes may include:  

 
 Greater than one allele present at a locus other than DYS385 where a gene duplication results 

in a bi-allelic pattern.  
 Significant imbalance in peak height between peaks at a DYS385.  
 Generally, evidence of a mixed DNA sample exists at multiple loci.  

 
To determine whether a mixed Y-STR profile exists, the DNA profile must be evaluated in its entirety.  
If a DNA mixture exists, a conclusion to that fact should be stated in the Forensic Biology report, and 
may be stated independently of the conclusion(s) surrounding potential individual contributors (see 
section 5). 

 
2.2 Estimation of the number of contributors to a sample 

 
Conclusions with respect to the minimum number of contributors must be included in a report.  
Generally, an estimate of the minimum number of contributors is based on the locus that exhibits the 
greatest number of allelic peaks and the fact that each contributor would contribute at most one allele 
to the locus (except DYS385).  While the minimum number of contributors to a mixture can be 
established with a high probability, an absolute determination of the number of contributors cannot be 
ascertained. 
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2.3 Determination of whether inhibition and/or degradation is present 

 
Please refer to section 2.4 of the Autosomal STR Interpretation Guidelines document for more 
information on inhibition and degradation.  The SDPD does not currently have good examples of 
degraded or inhibited Y-STR profiles, however, the same basic tenets apply to both autosomal and Y-
chromosome analysis. 

 
2.4 Determination of contribution levels in mixed DNA samples 

 
The relative peak intensity differences between detected alleles can be used to identify differences in 
contribution levels between contributors to relatively simple (i.e. 2-person) mixtures.  In general a 3:1 
difference in peak intensity will be used to identify major vs. minor alleles.  In more complex mixtures 
it may be difficult to determine major vs. minor alleles and analysts are encouraged to exercise caution 
when interpreting Y-STR mixtures of more than two individuals. 
 
Alleles designated as likely coming  from a minor DNA contributor to a Y-STr mixture will be denoted 
with brackets (e.g. [16]) in the table of results. 
 

2.5 Documentation of Assumptions 
 

In certain circumstances, assumptions regarding DNA profiles may be made to assist the analyst in 
drawing conclusions and to put the evidence in the proper context.  All assumptions regarding any 
interpretation will be presented in the report and should also be in the notes (see section 5). 
 
In certain circumstances assumptions regarding the presence of a contributor in a DNA mixture is 
permissible (i.e. intimate samples ).  In these circumstances the DNA profile from the assumed 
contributor(s) can be used to assist interpretation of the additional contributor(s) DNA profile/types 
(section 2.7). 
 
Prior to making comparisons, the profile should be evaluated to determine what loci and/or 
combinations of DNA types are acceptable to support a conclusion statistically.  Since there is 
technically no stochastic threshold to be concerned with (with the exception of DYS385) much of the 
evaluation to determine what parts of the DNA results can be used for statistical weight takes into 
account the possible presence of DNA types below the analytical (or detection).  If, based on the 
totality of the information in the Y-STR result, it is reasonable to assume that all information is 
accounted for in the results, all DNA types can be used for comparison, but it may useful to further 
refine the genotypes for comparison if a limited number of combinations are likely. 
 
If an analyst believes that filtered stutter peaks should be evaluated for comparison, the mean stutter 
percentage observed for the allele during validation and other studies should be used to assess whether excess 
stutter is likely.  Peaks in stutter positions that are more than 2 standard deviations above the mean observed 
stutter indicate the presence of excess stutter and that DNA contribution from a source other than stutter is 
likely.  If a peak in a stutter position is deemed to have originated from a separate contributor to the sample, then 
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all stutter peaks in the mixture should be evaluated in the same manner and included in the assessment of the 
mixture.  After the evaluation of stutter peaks in the mixture it may be necessary to reassess the minimum 
number of DNA contributors to the sample. 

 
 
Section 3 - Comparison of DNA Typing Results  
 
3.1 Inclusion.  If a person of interest has no unexplainable differences from the alleles or allele 

combinations determined to be useful for statistical support of inclusions, and thus comparison, they 
are included as a source of the DNA or possible contributor to the DNA mixture.   

 
3.2 Exclusion.  If a person of interest has unexplainable differences from the alleles or allele combinations 

determined to be useful for comparisons, they are excluded as a source of the DNA or possible 
contributor to the DNA mixture.   

 
3.3 Inconclusive.  Some mixtures such as those with five or more contributors may not be suitable for 

comparison, unless a minimal number of major contributors exist.  Comparisons to these mixtures will 
be considered inconclusive. 

 
An analyst may determine that due to a combination of variables including (but not limited to) the 
number of DNA contributors as well as a lack of information in the results that no comparisons can be 
made to the profile (or comparison for possible minor contributors). 

 
Section 4 - Statistical Analysis of DNA Typing Results 
 
Y-STR loci are linked on the Y-chromosome and do not undergo linkage disequilibrium.  Therefore neither 
Recommendation 4.1 (NRC 1996) nor the Product Rule can be applied to Y-STR haplotypes.  The 
significance of a haplotype match in casework must be expressed in terms of the observed frequency of the 
particular haplotype in the population (the counting method).  Numerous Y-STR haplotype databases are 
available on-line. 
 
4.1 Apparent Single Source profiles 

For the purposes of expressing the significance of a Y-STR haplotype match all alleles for loci deemed 
acceptable for comparison will be searched in the database.  More DNA profiles in the US YSTR 
database have a subset of the Yfiler loci than have the full complement of the Yfiler loci.  As a result, an 
analyst may elect to search a subset of the Y-STR results in the database for the purposes of obtaining a 
more discriminating search. 
  

4.2 Mixed Y-STR DNA profiles 
 

4.2.1 If a significant difference in allele peak height exists in a male DNA mixture, a predominant 
Y-STR DNA haplotype may be deduced.  If a predominant haplotype is deduced, all 
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applicable alleles from the predominant haplotype will be searched in the database (as in 
section 4.1).  For the purposes of expressing the significance of a Y-STR haplotype match all 
applicable alleles will be searched in the database. 
  

4.2.2 If a predominant Y-STR DNA profile cannot be deduced, the frequencies in a given database 
may be determined for each possible haplotype and the sum of all combinations of possible 
haplotypes may be reported. 

 
  
4.3 Y-STR haplotype frequencies can be calculated from a number of established databases.  Applied 

Biosystems generated a database of searchable haplotypes incorporating all of the Yfiler loci at: 
 

www.appliedbiosystems.com/yfilerdatabase  
 
The website displays each of the Yfiler loci next to drop down lists and text boxes.  Common alleles 
should be selected from the drop down list.  Microvariant alleles and loci with multiple alleles should 
be inputted into the text boxes.  Upon searching the questioned haplotype, the website will indicate 
how many haplotypes in the database match.  The number of matching haplotypes is listed for eight 
different population groups and for all samples in the database.  The number listed on the website for 
each group in the database is a link that will display the full haplotypes for all matches.  This can be 
helpful when searching partial profiles or a subset of alleles in a mixture.  The results page can be 
printed for the case notes, and the haplotype frequencies can be expressed as the number of matches 
divided by the number of samples in the database.   
 
Numerous other Y-STR haplotype databases are available on-line and their use is at the discretion of the 
analyst.  The Promega Corporation has a haplotype database at: 

www.promega.com/techserv/tools/pplexy/ 
Upon visiting this website, launch the PowerPlex®Y Haplotype Database and enter the alleles from the 
questioned haplotype.  Choose the sample population of interest (e.g. Caucasian, Asian, Hispanic, 
African-American or Native American), or select “All Populations”.  Upon submitting the questioned 
haplotype, the website will indicate how many haplotypes in the selected population database match 
and the percentage of matching samples in the selected population.  The results page can be printed for 
the case notes, and the haplotype frequency can be expressed as the number of matches divided by the 
number of samples in the database.   

Other Y-STR haplotype databases are available at: 
www.usystrdatabase.org 

www.ystr.org/index_usa_gr.htmL 
www.reliagene.com 
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Section 5 - Reporting of DNA Typing Results and Conclusions 
 
The following are meant as guidelines for reporting conclusions for DNA testing in Forensic Biology Unit 
reports.  There are many ways to state a conclusion in a DNA report and the suggestions listed below do 
not cover every possible scenario.  Alternative wording may be used to express a conclusion so long as the 
conclusion is correct, supported by the data, and is appropriate based on the statistical probability limits 
employed by the Unit.   

 
5.1 Reporting of DNA typing results 

Please refer to the Autosomal STR Interpretation Guidelines document for additional information. 
  

5.2 Reporting of Conclusions 
Conclusions for each item should be present in the conclusions section of the report.  It is 
acceptable to group similar conclusions for multiple items together. 

 
5.2.1 In general, conclusions should state whether a mixture of DNA was obtained, and if a mixture 

was obtained, the minimum number of contributors should be stated.  The conclusion should 
indicate if the sample is not suitable for comparison purposes.  A brief description of the reason 
that it is not suitable should be included.  In the case of a mixture that is only suitable for 
comparison to possible major contributors, an indication should be included that the sample is 
not suitable for comparison to possible minor contributors.  It may in some circumstances be 
relevant to indicate whether male or female DNA is present in the sample. 

 
If the sample is suitable for comparison and if comparisons are made, the conclusion should 
indicate whether the persons of interest are included or excluded.  If the comparison is 
determined to be inconclusive, a statement giving reasons leading to the inconclusive 
determination. 
 
If an inclusion is made, and if the inclusion warrants a probability calculation (see section 4), 
the applicable probabilities should be listed.  
 
Any assumptions made regarding the comparisons and/or the probability calculations will be 
listed in the conclusion. 
 
If the inclusion of an individual requires a larger number of contributors than the minimum 
based on allele number and peak height ratios, a statement to that effect should be included. 

 
5.2.2 Example of an inclusion to an apparent single source or predominant Y-STR haplotype 

 
Male specific Y-STR testing of the evidence indicated the presence of DNA from a single male 
or male lineage.  John Doe is included as a possible source of the male DNA from this sample.  
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The number of times the Y-STR DNA types from the evidence were observed in the … 
Database (website of appropriate database) is: 
  

5.2.3 Example of an inclusion to a Y-STR mixture 
 

During male specific Y-STR analysis of the evidence, a mixture of DNA from at least two males 
was detected.  John Doe is included as a possible contributor to the mixture of male DNA from 
this sample.  The approximate number of times the possible combinations of Y-STR haplotypes 
from this mixture were observed in the … Database (website of appropriate database) is: 

 
REFERENCES: 
1. AmpFlSTR Yfiler™ PCR Amplification Kit User’s Manual  
2. SDPD AmpFlSTR Yfiler™ validation studies. 
3. www.usystrdatabase.org 
4. www.ystr.org/index_usa_gr.htmL. 
5. www.reliagene.com. 
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Appendix A: Glossary of terms taken from SWGDAM 
 
Allelic dropout: failure to detect an allele within a sample or failure to amplify an allele during PCR.  
 
Analytical threshold: the minimum height requirement at and above which detected peaks can be 
reliably distinguished from background noise; peaks above this threshold are generally not considered noise 
and are either artifacts or true alleles.  
 
Artifact: a non-allelic product of the amplification process (e.g., stutter, non-templated nucleotide 
addition, or other non-specific product), an anomaly of the detection process (e.g., pull-up or spike), or a 
by-product of primer synthesis (e.g., “dye blob”).  
 
Composite profile: a DNA profile generated by combining typing results from different loci obtained 
from multiple injections of the same amplified sample and/or multiple amplifications of the same DNA 
extract. When separate extracts from different locations on a given evidentiary item are combined prior to 
amplification, the resultant DNA profile is not considered a composite profile.  
 
Conditional: an interpretation category that incorporates assumption(s) as to the number of contributors.  
 
CPI: combined probability of inclusion; produced by multiplying the probabilities of inclusion from each 
locus.  
 
Deconvolution: separation of contributors to a mixed DNA profile based on quantitative peak height 
information and any underlying assumptions.  
 
Deduced: inference of an unknown contributor’s DNA profile after taking into consideration the 
contribution of a known/assumed contributor’s DNA profile based on quantitative peak height 
information.  
 
Differential Degradation: a DNA typing result in which contributors to a DNA mixture are subject to 
different levels of degradation (e.g., due to time of deposition), thereby impacting the mixture ratios across 
the entire profile.  
 
Distinguishable Mixture: a DNA mixture in which relative peak height ratios allow deconvolution of 
the profiles of major/minor contributor(s).  
 
Evidence sample: also known as Questioned sample.  
 
Exclusion: a conclusion that eliminates an individual as a potential contributor of DNA obtained from an 
evidentiary item based on the comparison of known and questioned DNA profiles (or multiple questioned 
DNA profiles to each other).  
 
Guidelines: a set of general principles used to provide directions and parameters for decision making.  
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Heterozygote: an individual having different alleles at a particular locus; usually manifested as two 
distinct peaks for a locus in an electropherogram.  
 
Homozygote: an individual having the same (or indistinguishable) alleles at a particular locus; manifested 
as a single peak for a locus in an electropherogram.  
 
Inclusion: a conclusion for which an individual cannot be excluded as a potential contributor of DNA 
obtained from an evidentiary item based on the comparison of known and questioned DNA profiles (or 
multiple questioned DNA profiles to each other).  
 
Inconclusive/uninterpretable: an interpretation or conclusion in which the DNA typing results are 
insufficient, as defined by the laboratory, for comparison purposes.  
 
Indistinguishable mixture: a DNA mixture in which relative peak height ratios are insufficient to 
attribute alleles to individual contributor(s).  
 
Intimate sample: a biological sample from an evidence item that is obtained directly from an individual’s 
body; it is not unexpected to detect that individual’s allele(s) in the DNA typing results.  
 
Known sample: biological material for which the identity of the donor is established and used for 
comparison purposes (referred to as a “K”).  
 
Likelihood ratio (LR): the ratio of two probabilities of the same event under different hypotheses; 
typically the numerator contains the prosecution’s hypothesis and the denominator the defense’s 
hypothesis.  
 
Major contributor(s): an individual(s) who can account for the predominance of the DNA in a mixed 
profile.  
 
Masked allele: an allele of the minor contributor that may not be readily distinguishable from the alleles 
of the major contributor or an artifact.  
 
Minor contributor(s): an individual(s) who can account for the lesser portion of the DNA in a mixed 
profile.  
 
Mixture: a DNA typing result originating from two or more individuals.  
 
Mixture ratio: the relative ratio of the DNA contributions of multiple individuals to a mixed DNA typing 
result, as determined by the use of quantitative peak height information; may also be expressed as a 
percentage.  
 
Noise: background signal detected by a data collection instrument.  
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No results: no allelic peaks detected above the analytical threshold.  
 
Obligate allele: an allele in a mixed DNA typing result that is (a) foreign to an assumed contributor, or 
(b) based on quantitative peak height information, determined to be shared with the assumed contributor.  
 
Partial profile: a DNA profile for which typing results are not obtained at all tested loci due, for example, 
to DNA degradation, inhibition of amplification and/or low- quantity template.  
 
Peak height ratio (PHR): the relative ratio of two alleles at a given locus, as determined by dividing the 
peak height of an allele with a lower relative fluorescence unit (RFU) value by the peak height of an allele 
with a higher RFU value, and then multiplying this value by 100 to express the PHR as a percentage; used 
as an indication of which alleles may be heterozygous pairs and also in mixture deconvolution.  
 
Probability of inclusion (PI): the percentage of the population that can be included as potential 
contributors to a DNA mixture; also known as Random Man Not Excluded. .  
 
Questioned sample: biological sample recovered from a crime scene or collected from persons or 
objects associated with a crime (referred to as a “Q”).  
 
Random Match Probability (RMP): the probability of randomly selecting an unrelated individual from 
the population who could be a potential contributor to an evidentiary profile.  
 
Reference sample: also known as Known sample.  
 
Restricted: referring to a statistical approach conditioned on the number of contributors and with 
consideration of quantitative peak height information and inference of contributor mixture ratios; used to 
limit the genotypic combinations of possible contributors.  
 
Signal-to-noise ratio: an assessment used to establish an analytical threshold to distinguish allelic peaks 
(signal) from background/instrumental noise.  
 
Single-source profile: DNA typing results determined to originate from one individual based on peak 
height ratio assessments and the number of alleles at given loci.  
 
Stochastic effects: the observation of intra-locus peak imbalance and/or allele drop-out resulting from 
random, disproportionate amplification of alleles in low-quantity template samples.  
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Stochastic threshold: the peak height value above which it is reasonable to assume that, at a given locus, 
allelic dropout of a sister allele has not occurred.  
 
Stutter: a minor peak typically observed one repeat unit smaller than a primary STR allele resulting from 
strand slippage during amplification.  
 
Unrestricted: referring to a statistical approach performed without consideration of quantitative peak 
height information and inference of contributor mixture ratios; for CPE/CPI this may or may not be 
conditioned on the number of contributors. 
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